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License Agreement
IMPORTANT:  PLEASE READ CAREFULLY

LICENSE AGREEMENT
THIS LICENSE AGREEMENT ("AGREEMENT") IS BETWEEN YOU, THE END USER, AND MEDIA CYBERNETICS, INC. ("MEDIA").  IT
GOVERNSTHEUSEOF THE SOFTWARE, PROGRAM MEDIA AND DOCUMENTATION KNOWN AS Image-Pro Image-Pro (THE
"PRODUCT").  IF YOU USE THE PRODUCT, THEN YOU AGREE TO THE TERMSOF THIS AGREEMENT.  IF YOU ARENOTWILLING
TO BE BOUND BY THE TERMSOF THIS AGREEMENT, PROMPTLY RETURN THIS PACKAGE TO THE PLACEOF PURCHASEWITH A
COPY OF THERECEIPT, AND YOUR LICENSE FEEWILL BE REFUNDED.

Media licenses use of the PRODUCT, whichmay be manufactured and distributed by Media or by a third party (either, the "Manufacturer").
You, the end-user, assume responsibility for the selection of the PRODUCT to achieve your intended results, and for its installation and subsequent
use.

GRANTOF LICENSE
Media hereby grants you a non-exclusive license to use the PRODUCT in object code form only, upon the terms and conditions contained in this
Agreement.
Youmay:
1. Use the PRODUCT on the number of workstations for which you have purchased PRODUCT licenses.  The workstations must be owned, leased
or otherwise controlled by you, whether in a network or other configuration.
2. Create a quantity of backup copies of the PRODUCT, in any machine-readable or printed form, equal to the number of PRODUCT licenses you
have purchased.
3. Transfer the PRODUCT and your rights under this Agreement to another party if the other party agrees to accept the terms and conditions of
this Agreement.  If you transfer the PRODUCT, youmust, at the same time, either transfer all copies of PRODUCT to the same party, or des-
troy any copies not transferred.  Youmust immediately notify Media of the transfer.
4. Print out one copy of the Product documentation from the program media for each license purchased.  If you print out any part of the Product
documentation from the program media, youmust reproduce and include all the copyright notices that appear in the documentation on any such
copy of the documentation.

Youmay not:
1. Use or copy the PRODUCT, in whole or in part, except as expressly provided in this Agreement,
2. Use the PRODUCT concurrently onmore than the number of workstations for which you have purchased licenses,
3. Copy, rent, distribute, sell, license or sublicense, or otherwise transfer the PRODUCT or this license, in whole or in part, to another party,
except as specifically set forth above.
4. Incorporate the PRODUCT or any portion of the PRODUCT into, or use the PRODUCT, or any portion of the PRODUCT to develop, other
software without a license from Media, or otherwise modify or create a derivative work from the PRODUCTwithout a license from Media.
5. Re-distribute any of the Microsoft(R) VisualBasic(R) components, including but not limited to VBA, APC, Microsoft Forms, Core Technology,
OLE Automation, VBA Installation Program, or the End User documentation for such components.
6. Reverse engineer, decompile or disassemble the PRODUCT.

To use the PRODUCT as described in Sections 2 or 4 above, or for any other use not specifically set forth above, additional licensing from Media is
required.  For further information, please contact Media at:
Media Cybernetics, Inc.
401 NorthWashington St., Suite 350
Rockville, MD 20850
U.S.A.
Phone:  (301) 495-3305
Fax:  (301) 495-5964
WorldwideWeb:http://www.mediacy.com
E-Mail:  customerservice@mediacy.com

PROPRIETARY RIGHTS
This Agreement gives you ownership only of the physical program media on which the PRODUCT is stored, but not of the PRODUCT itself.  You
acknowledge that Media owns all right, title and interest in the PRODUCT, and that you will acquire no rights in the PRODUCT through your use
of it.  You agree that you will take no action that interferes withMedia's rights in the PRODUCT.

TERM
This Agreement is effective until terminated.  Youmay terminate it at any time by destroying the PRODUCT together with all copies and doc-
umentation in any form.  This Agreement will also terminate automatically and without notice from Media if you fail to comply with any term or
condition of this Agreement.  You agree upon such termination to destroy the PRODUCT and all copies of the PRODUCT.



DISCLAIMER; LIMITED WARRANTY
EXCEPT AS PROVIDED BELOW, THE PRODUCT IS PROVIDED "AS IS"WITHOUTWARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIESOF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THEQUALITY AND PERFORMANCEOF THE PRODUCT ISWITH YOU.  SOME
JURISDICTIONSDO NOTALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THEABOVE EXCLUSION MAY NOTAPPLY TO
YOU.

NEITHER MEDIA NOR MANUFACTURER WARRANT THAT THE FUNCTIONSCONTAINED IN THE PRODUCTWILLMEETYOUR
REQUIREMENTSOR THAT THEOPERATION OF THE PRODUCTWILL BE UNINTERRUPTED OR ERROR-FREE.  However, where
Media is the Manufacturer, Media warrants that the program media on which the software is furnished will be free from defects in materials and
workmanship under normal use for a period of ninety (90) days from the date of delivery as evidenced by a copy of your receipt.

LIMITATION OF REMEDIES
Where Media is the Manufacturer, Manufacturer’s entire liability and your exclusive remedy shall be:
1.the replacement of the program media not meeting the LimitedWarranty, which is returned to Manufacturer with a copy of your receipt;
2.if Manufacturer is unable to deliver replacement program media which is free of defects in materials or workmanship, youmay terminate this
Agreement by returning the PRODUCT and a copy of your receipt to the place of purchase, and your money will be refunded.
Where Media is not the Manufacturer, Media shall have no liability to replace or refund, and you agree to look to Manufacturer to meet the oblig-
ations described above.

LIMITATION OF LIABILITY
IN NO EVENTWILLMEDIA OR MANUFACTURER BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING, BUT NOT LIMITED TO,
ANY LOST PROFITS, LOST SAVINGS, OR OTHER INDIRECT, SPECIAL, EXEMPLARY, INCIDENTALOR CONSEQUENTIAL DAMAGES,
ARISING OUTOF THEUSEOR INABILITY TO USE THIS PRODUCT, EVEN IF MEDIA OR MANUFACTURER HASBEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.  FURTHER, IN NO EVENTWILLMEDIA OR MANUFACTURER BE LIABLE FOR ANY CLAIM
BY ANY OTHER PARTY ARISING OUTOF YOUR USEOF THE PRODUCT.  SOME JURISDICTIONSDO NOTALLOW THE LIMITATION
OR EXCLUSION OF LIABILITY FOR INCIDENTALOR CONSEQUENTIAL DAMAGES, SO THEABOVE LIMITATION OR EXCLUSION
MAY NOTAPPLY TO YOU.

TRADEMARKS
Image-Pro™ is a trademark of Media Cybernetics Inc., andMedia Cybernetics™ is a trademark of Media Cybernetics Inc. No right, license, or
interest in such trademarks is granted hereunder.
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Preface
Before You Begin

Welcome to the Image-Pro® User’s Guide.  This product is designed to run under the
Microsoft® Windows® 7.0 Professional or Ultimate  (service pack 1) (32- and 64-bit), Win-
dows® 8.0 or 8.1 Enterprise or Professional (32- and 64-bit), and Windows® 10 Enterprise
or Professional (32- and 64-bit).
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Product Features

Image-Pro 9.3 is a comprehensive application for image acquisition and measurement for
industrial and physical scientists. It has been designed to automate and simplify routine
image capture, inspection, and measurement tasks.

With Image-Pro, you can.....

Acquire and Open Images

l See when Live Preview is running with the new Live Preview Pane.

l Capture HDR images.

l Easily acquire single frame images and time-lapse experiments.

l Acquire and analyze high dynamic range (HDR) images.

l Stream multi-gigabyte movies directly to your hard drive.

l Use Live Tiling and Live Extended Depth of Field (EDF) to acquire large, beau-
tifully focused images without an automated stage or z motor.

l Use the crosshair grid to align images while capturing.

l Compare live images with previously acquired images using the Image Compare
workspace.

Automate and Customize

l Show and hide tabs or groups to display only the tools you need.

l Create and display mini-programs (Apps) and macros to automate procedures that
you use frequently on the new Apps tab.

l Save and load your preferred workspace layout, and share your layout with others.

l Review your macros in an intuitive graphical macro editor or use the more
advanced code-based editing tools to test, edit and debug your scripts.

l Download Image-Pro macros and Apps from the App Center website.

l Customize the user interface, so that you can set up Image-Pro in the most effi-
cient way for your work, including dockable tool bars and the ability to show or
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Product Features

hide different toolbars and buttons. You can also reset your interface to “factory”
or “default” settings if you don’t like what you’ve set up and want to start over.

l Never lose your work with Image-Pro’s AutoSave and AutoRecover.

Read andWrite Image Data

l Read and write image data in all the standard image file formats including, TIFF,
JPEG, AVI, and many others. 

l Open and view multi-resolution image files, including Leica .scn, Aperio .svs and
BigTiff, and extract out images to analyze.

Process and Analyze

l Use Extended Depth of Field (EDF) test strips to preview EDF settings options to
save time and ensure best results when creating in-focus images from a z-stack.

l Analyze colocalized channels.  Perform parent/child analysis, analyze within spe-
cific regions and more.

l Perform image enhancement using powerful color and contrast filters, including
morphology, field flattening, background subtraction, Fast Fourier Transforms
(FFT), and other spatial and geometric operations.

l Align, tile, or stitch multiple images together.

l Extract features with spatial tools that isolate a Region of Interest (ROI) from the
rest of the image, or with segmentation tools that extract features by color or
intensity value. 

l Use 1-2-3 Batch Processing to apply your image processing steps to multiple
opened images or folders of images.

l View and analyze very large images (64-bit systems only).

Measure and Count

l Adjust the size and shape of irregular ROIs and Measurements with the Polygon
Nudge Tool.

l Use the Grow and Shrink tools to adjust the size of your counted objects .

l Use the Close and Merge tools to combine neighboring objects manually when
using automatic segmentation and counting tools.

xv



Preface 1

l Automatically measure incremental distances between two irregular edges to
quantify changes in surface size and shape.

l Trace and count objects manually or automatically.  Measure object attributes
such as: area, angle, perimeter, diameter, roundness and aspect ratio.  Calibrate
your spatial scale to any unit of measure.

l Use Smart Segmentation to easily identify and segment challenging images with
faintly-colored objects, textured objects and uneven backgrounds.

l View collected data numerically, statistically or in graphic form (histogram and
scattergram).  Save the measurement data to disk.  

l Sort and classify your measurement data according to your predefined criteria.
Color code your objects by class.

l Manually or automatically follow objects as they move over time using Object
Tracking.

l Track changes in intensity over time.

3D Image Viewing and Rendering

l View 3D images from a variety of angles and views.

Report and Share

l Save images with all measurement overlays intact for future analysis.

l Apply annotations, labels, and overlays to your images. 

l Export measurements and data graphs to Microsoft Excel™.

l Export all opened images into Microsoft PowerPoint™.

l Generate Adobe PDF™ reports that can include images, measurement data, text,
and pictures.
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 Conventions Used in this Guide

Conventions Used in this Guide

The Image-Pro User’s Guide uses the following documentation conventions:

A Note about this User Guide

This guide was designed to be a comprehensive overview ofImage-Pro and Image-Pro
with 3D Module. For that reason, some of the tab names, colors, screens, and images fea-
tured in this manual may be slightly different from those in your product.

For example, if you are using the versions of this product that do not include the ability to
capture images, you will see the Home tab instead of the Capture tab. Also, if you are
using Image-Pro with 3D Module 9.3, you will some of the tabs labeled as
2D Measure or 2D Count/Size to distinguish them from similar features in the
Image-Pro with 3D Module toolset.
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Contacting Technical Support

Media Cybernetics provides technical support to registered users. We can be reached by
phone, fax, or e-mail, as follows:

Telephone: 301- 495-3305, 800-263-2088 (North America only)
FAX: 301- 495-5964
E-mail: techsupport@mediacy.com
Web Page: http://support.mediacy.com

Operating Hours (Eastern Time)
Mon-Fri: 9:00 am - 5:00 pm
Sat-Sun: Closed
Holidays: Closed

Support for all registered users includes access to the latest information and downloads
regarding updates, hot-fixes, and service packs. Technical support for all users is free for
the first 30 days.

Support for users who have a valid Image-Pro maintenance agreement includes the fol-
lowing:

l Continuing access to the latest updates and fixes.

l Access to the Image Analysis Forum Discussion Group.  Image-Pro Support Spe-
cialists and users from around the world participate and grow this Knowledge Base.  It
includes valuable information concerning the use and support of Image-Pro. To access
this forum, click on the Image Analysis link on the Help menu:
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 Contacting Technical Support

l Access to Image-Pro Support Specialists.  If you cannot find a solution in the Forum
you can submit your problem to our Image-Pro Support Specialists.  They will attempt
to answer you as quickly as possible.

Before you contact Media Cybernetics’ Technical Support for assistance, please be pre-
pared to provide the following information:

l Your registration information: the product serial number, your name, phone number,
organization name, mailing address, and e-mail address. The serial numbers are dis-
played on the About Image-Pro screen (open from the Help menu):

l The software version number and system information.

l A description of the problem, and any relevant information regarding prior technical
support assistance.

xix





Chapter 1 : Installing Image-Pro

Installing Image-Pro

This chapter provides an overview of installation requirements and step-by-step instruc-
tions for installing and activating Image-Pro/Image-Pro with 3D Module.
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Package Contents

Before installing Image-Pro, please check that you have received everything in your
Image-Pro package:

l Image-Pro USB Installation Drive

l Image-Pro USB Licensing Dongle (if applicable)

2



 System Requirements for Image-Pro 10

System Requirements for Image-Pro 10

To install and work with Image-Pro you will need the following equipment and software:

Supported Operating Systems:

l Windows® 7 Professional and Ultimate (SP 1) – 32-bit and 64-bit

l Windows® 8.0 or 8.1 Enterprise and Professional – 32-bit and  64-bit

l Windows® 10 Enterprise and Professional – 32-bit and  64-bit

Minimum Requirements

l Dual core processor

l 4 GB of RAM or more

l 5 GB or more of available hard-disk space

l 1024 x 768 display with a 32-bit video card

l DVD/CD-ROM drive 

l Microsoft .NET 4.0 Framework (automatically installed by application)

l USB port required for hard licenses and offline license activation

l Internet connection required for online services.

Note that Image-Pro will not install on computers running Windows® XP or Win-
dows® Vista™. Nor will it run under Windows® N.

Recommended Requirements

l OS: Windows 7, 8.1 or 10, 32-bit or 64-bit

l Processor: 2.8 GHz Intel quad-core 64-bit processor (Core i7 Series) or better

l RAM: 16 GB memory or higher

l Free Disk Space: Multiple High Speed SATA Hard Disks or SSDs; 8 GB free on
installation drive + free space for images (500+GB)
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l Graphics Card: nVIDIA GeForce GTX  Cards with 4GB graphics memory & Open
GL 4.2 or higher

l DVD-ROM drive 

l USB port required for hard licenses and offline license activation

l Internet Explorer version 9 or higher

l Internet connection required for online services*

High Performance Requirements

l OS: Windows 7, 8.1 or 10, 64-bit

l Processor: 3.0 GHz Intel quad-core 64-bit processor (Core i7 Series) or better

l RAM: 48 GB memory or higher

l Free Disk Space: Multiple High Speed SATA Hard Disks or SSDs configured in
RAID 5; 16 GB free on installation drive + free space for images (1 TB+)

l Graphics Card: nVIDIA GeForce GTX Cards with 4GB graphics memory & Open
GL 4.2 or higher

l DVD-ROM drive 

l USB port required for hard licenses and offline license activation

l Internet Explorer version 9 or higher

l Internet connection required for online services*
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 System Requirements for Image-Pro with 3D Module

System Requirements for Image-Pro with 3D Module

Manufacturers change system specifications regularly so it is difficult to describe the exact
configuration that is requiredowever there are some important guidelines to consider before
purchasing or upgrading your computer hardware for use with Image-Pro with 3D Module.

Rule of Thumb:

In short… More S Better. More GPU (Graphics Processing Unit) cores, more system RAM,
more graphics RAM, more CPU cores, more speed for 3D viewing rates.

Image-Pro with 3D Module has no limits on the number of objects, the size of images, the
number of images, or the number of frames. Everything depends on memory and speed. For
users the best possible experience and product performance review the requirements below
and follow-up with a review of the hardware priorities to understand how the whole sys-
tem plays a part in the application’s performance.

To install and work with Image-Pro with 3D Module you will need the following equip-
ment and software:

Minimum Requirements (for small datasets only, performance will be low)

l OS: Windows 7, 8.1 or 10, 32-bit or 64-bit

l Processor: 2.4 GHz CPU Intel dual-core processor or better

l RAM: 4 GB memory

l Free Disk Space: 4 GB  on installation drive + free space for images (20+GB)

l Graphics Card: nVIDIA GeForce GTX 560 (1GB & Open GL 4.2 or higher)

l DVD-ROM drive 

l USB port required for hard licenses and offline license activation

l Internet Explorer version 9 or higher

l Internet connection required for online services*.

Recommended Requirements

l OS: Windows 7, 8.1 or 10, 64-bit
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l Processor: 2.8 GHz CPU Intel quad-core processor or better

l RAM: 16 GB memory or higher

l Free Disk Space: Multiple High Speed SATA Hard Disks or SSDs; 8 GB free  on
installation drive + free space for images (20+GB)

l Graphics Card: nVIDIA GeForce GTX 580, 760 ( 2GB & Open GL 4.2 or higher)
or AMD Radeon R9 290 (4.0 GB & Open GL 4.3 or higher)

l DVD-ROM drive 

l USB port required for hard licenses and offline license activation

l Internet Explorer version 9 or higher

l Internet connection required for online services*.

High Performance Requirements

l OS: Windows 7, 8.1 or 10, 64-bit

l Processor: 3.0 GHz Intel quad-core processor or better

l RAM: 48 GB memory or higher

l Free Disk Space: Multiple High Speed SATA Hard Disks or SSDs configured in
RAID 5; 16 GB free on installation drive + free space for images (1 TB+)

l Graphics Card: nVIDIA GeForce GTX 680 (4GB & Open GL 4.2 or higher) or
AMD Radeon R9 290X (4GB and Open GL 4.3)

l DVD-ROM drive 

l USB port required for hard licenses and offline license activation

l Internet Explorer version 9 or higher

l Internet connection required for online services*.

*This product may allow you to access certain features that are hosted online ("online ser-
vices"), provided you have a high-speed Internet connection. The online services include
but are not limited to, automatic updates, support links, access to video tutorials, and more.
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Hardware Priorities

Graphics Card

Image-Pro with 3D Module is a 3D graphics-intensive product that requires a very capable
graphics adapter. For this reason, purchase the most powerful graphics card possible
because the single most important determinant of 3D viewing performance is the graphics
card.

When choosing a graphics card for optimal visualization performance Open GL 4.2 is
recommended along with at least 1GB of graphics memory, but ideally 2GBpreferable.
Securing the best possible graphics card is not buying the most expensive one, as many of
these cards are designed for unique rendering applications, such as the nVidia Quadro
series. These cards will not necessarily provide an Image-Pro with 3D Module user with
the best price to performance ratio. NVidia GeForce GTX and AMD Radeon HD and ATI
Radeon X cards typically are designed for video gaming, but deliver excellent performance
for 3D image analysis as well. When looking into nVidia cards, be aware of their series of
cards such as the 500, 600, and 700 have high and low endsmean a GTX 650 could be
potentially worse than a GTX 580 because the first number denotes a series and not the
level of performance. In this case the second number of the model explains how they
match up.

If you are working with very large images or sets, then it is important to focus on the
second priority, as much as you do the graphics card for visualization. Our suggestions
regarding memory are in the next section.

l Users are discouraged from multi-video card (Crossfire and SLI) solutions for now,
as this technology is known to decrease performance compared to single graphics
card solutions.

System Memory

System memory is the second most important factor for users who need to inspect large
data sets in particular, large volume data with direct volume rendering. This is why Image-
Pro with 3D Module is a 64-bit ONLY software product (32-bit operating systems are lim-
ited to a maximum amount of about 3.2 GB of system memory. It is important to note that
you may need much more memory than the actual size of the data you want to work with
since some processing may require several times the memory required by the original data
set.
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For instance, if you want to load a 4GB data set in memory, you may need up to 16 or
20GB of additional memory for the intermediate results of your processing. More com-
monly you will need 2 or 3 times the memory footprint for data being processed.

Hard Drives

When working with large files that contain either a long sequence or many dimensions of
data, reading from the disk can slow down your productivity.
Option 1 is a standard hard drive (e.g. 7200rpm SATA disk) that can only send data to
your application at a continuous rate of about 60MB/second. That is the theoretical limit;
your actual experience is likely to be closer to 40MB/second.

Option 2 is to configure multiple hard drives (3 or more) in a RAID5 configuration but
please note that RAID configurations may require substantially more system admin-
istration.

Option 3 is to use solid state drives (SSD) instead of standard hard drives (HDD) in either
a single-drive or RAID configuration. SSD’s are becoming more popular as the prices con-
tinue to drop. The SSD can perform better than a HDD, generally having file read-
ing/writing at speeds of 200-550 MB/second. The price of solid state drives is still higher
and the capacity is not typically equivalent, but the performance can certainly be worth
the investment.

CPU

The Image-Pro with 3D Module platform is designed to support multiple cores/processors
using state-of-the-art background processing. This feature is on by default and enables the
software to execute tasks in parallel. Since Image-Pro with 3D Module combines the best
of 3D and 2D processing and analysis, additional CPU cores and/or processor speed will
enhance the responsiveness of the Graphical User Interface (GUI), data tables, 2D outlines,
and large image filters. If you are using the 3D rendering and measurements, they will be
mostly exploiting GPU power, and little of Image-Pro’s visualization processes are strongly
affected by CPU performance. Some image processing routines are CPU-limited, so a better
CPU can benefit performance on those routines.
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Installing Image-Pro

To install Image-Pro, follow the steps below. Please close any other applications before
starting the installation process. The setup screen will indicate which version of Image-Pro
you are installing.

1. Insert the Image-Pro product into the correct drive.

If the program does not start automatically, you can install Image-Pro using the Start
button on your desktop. Choose Run and then use the Browse button to find the
autorun.exe file on the CD. Double-click autorun.exe to begin the installation process.

Image-Pro requires the Microsoft *.NET framework. If this is not installed on your
computer, the application will install it automatically.

If you have restricted user access control, you may see a warning asking if you want
the program to make changes to your system. Click Yes.

You will see the Installation Start screen. This screen has the following buttons:

l Install Image-Pro

l Documentation

l Install Demo Images

l Capture Support.

2. Click Install Image-Pro.

You will see a dialog extracting the Image-Pro *.MSI file. If you have restricted
user access control, you may see a warning message asking if you want the *.MSI
file to make changes to your system. Click Yes.

Image-Pro requires the Microsoft *.NET framework. If this is not installed on your
computer, the application will install it automatically.

Please wait.

In a few moments, you will see the Image-Pro Setup screen. 

3. Click Next.

You will see the Image-Pro License Agreement.
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4. Check the Accept box, and click Next.

The Select Destination Folder location dialog box appears. This screen asks you for
the destination for the Image-Pro program files and folders, and for who can access
this installation.
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5. Click Change if you want to use a different location.

6. When the path is correct, click Next to continue.

The next screen verifies the destination folder for the Image-Pro data files:
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7. Confirm that the destination is correct. Click Change if you want to use a different loc-
ation.

8. When the path is correct, click Next to continue.

The next screen indicates that your computer is ready to install
Image-Pro/Image-Pro with 3D Module.
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9. Click the Install button to begin the installation. This screen gives you a chance to
verify your Image-Pro location and settings.

The Installing dialog box appears. The setup program will begin copying and
installing files.
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The final installation screen indicates that Image-Pro is now installed.
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10. Click Finish to conclude the installation process.

Note: During the installation process, you may see the following warning message:

This warning can be ignored safely, and installation of your product will complete suc-
cessfully.
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Activating Your Image-Pro License

USB license holders must activate their licenses after installing the software and plugging
in the hardware key.

Activating the Image-Pro Program

Before you can use Image-Pro, a valid license file must be obtained from the Media
Cybernetics Web site. A 14-day trial license is included for evaluation purposes.

1. If you have an Image-Pro hardware key, attach it to a USB port now.

2. When you first startImage-Pro, you will see the following dialog:

3. Click Activate Now to activate your license.

This will load the License Activation Wizard which will guide you through the steps
of activating your software.
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If your PC has Internet access

1. Confirm your license type and USB dongle.

2. Enter the Unlocking Code(s) that was sent with the product.

3. Provide standard registration information.

4. Once your information is received, all your licenses will be installed on
your machine.

If your PC does not have Internet access

1. If you choose Activate Now, and your PC is not connected to the internet,
the License Activation Wizard will bring you to the following prompt after
the dongle selection:
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2. Get your license file(s).
a. If your dongle is not activated or you don’t have access to the original

computer, you can download your license(s) by visiting http://www.-
mediacy.com/activate using the provided shortcut with your unlocking
code(s).

b. If you have an already activated dongle you can obtain the license(s)
using the License Activation Wizard to export them from the original
computer.

3. In both cases, you can import the license(s) on the second page of the

License Activation Wizard.

18



Verifying your Registration

Verifying your Registration

1. (Optional) Verify your registration by going to the Help menu and choosing About
Image-Pro:

The About page should show your (non-evaluation) license key:
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This page will indicate if and when your license expires. It also provides information
about your maintenance package, if any
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Windows Security Alert

Depending on your Windows Firewall settings, you may see an alert when you start
Image-Pro for the first time. This alert indicates that Windows may have blocked some
aspects of the application.

Your software is checking on whether updates are available, and no personal information
is being sent to Media Cybernetics. You will want to check the "Domain networks, such
as a workplace network" option, and then click Allow access.
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Product Versions and Updates

Most of the time, updates to Image-Pro happen automatically. If you have an Internet con-
nection, you can set your application software to check for updates when you start
the product. You must have an internet connection to update your product automatically.

For information about upgrading your product and license to Image-Pro 9.3, please see the
information about upgrading later in this chapter.
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Updating Your Product

Image-Pro uses the Auto-Update feature to ensure that you are running the most current ver-
sion of the software. Auto-Update is a small, unobtrusive feature that does not collect any
personal information from you.

In order for the process to work, you must have an Internet connection available.

Select the Automatic Update Check option in the Application page of the Options dialog
box, as shown here:

Checking this box ensures that software update checks will happen automatically.
When an update is available, your application will offer to download the available
updates. The downloads run in the background, and you may continue to use Image-
Pro while they run. You can decide later when you want to install the downloaded
updates. More information about Application Options appears in Chapter 2.
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If Automatic Update Check is not selected, follow the steps below to look for updates
to your software installation.

1. Click the small drop-down arrow at the upper right-hand corner of your application.

2. Click Check For Updates.  If your product is current, you will see a message saying
that you are running the most current version and no update is necessary.

3. If an update is found, you will see the Update Available dialog:

4. To install the update now, click Yes. To install the update later, click No.

If you click Yes the application closes (and prompts to save documents as appro-
priate), and the update is applied once the application has exited. If you click No, the
update is installed after the end of the current session.

When the update process is complete, you may see a message, or a page of release
notes pertaining to this upgrade.
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You may see a message reminding you to restart your computer before using
Image-Pro. If you do, please restart you computer before using Image-Pro.

If you do not have an Internet connection, please contact Media Cybernetics’ technical
support for assistance.
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Verifying Updates

You can find out which updates of the application software have been applied by visiting
the Windows Control Panel:

1. Go to  Programs:

2. Select View Installed Updates:
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You will see which programs and updates have been installed on your machine.

3. Once you have verified the update and version number, close the Window Control
Panel dialog.

You can view the About box to verify the current software version and see additional
information about your Image-Pro system.
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Help and About Image-Pro

The Help menu, User Guide, Support Center, About Image-Pro, Check for Updates, and
other useful features of Image-Pro can be accessed by clicking the drop-down arrow next

to the question mark in the upper right-hand corner of the application :

Once the drop-down menu appears, clicking anywhere on the menu item or its icon in the
Help menu items will take you to that feature of Image-Pro.

Clicking the Help question mark icon or H will open the first page of the in-product help
file:
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The Table of Contents, Index, and Search tabs in the left-side panel will help you navigate
through the Help files.

l Clicking the Image-Pro Users Guide link or G opens the first page of the Users Guide
in PDF. There are links and bookmarks to help you find the information you need in
the User’s Guide.

l Click the Image Analysis Forum or F sends you to the image analysis forum dis-
cussion group. This group includes links for you to send feedback, report a problem,
or make a feature request.

l Clicking Welcome to Image-Pro or W opens the Welcome screen. Note that if you do
not have an internet connection, the Welcome screen will display only offline content.
Tutorials, news, and forum posts will be available only if you have an internet con-
nection.

l Click Look for Updates or U to see if a new version of Image-Pro is available, as
described earlier in this chapter.

l Click SupportCenter or S to open a support session with a Technical Support spe-
cialist:

l Click About Image-Proor A to see important information about your Image-Prosystem.

The About page displays the version, copyright, license, and maintenance information:
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The License page displays the current license agreement.
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The Credits page contains credits and acknowledgements:

The System Information page displays information about your system:
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You can expand the system information folders to see the details of your installation. You
may need this information when working with Technical Support.

The next screen shows the system information for a rental software license.

Finally, a Licenses tab is included in the About dialog to help some users configure their
license use, see Configuring License Use.
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Upgrading Image-Pro

There are two aspects to any upgrade:

l Upgrading the installed software from the previous product or version to the Image-
Pro 10 software, and

l Upgrading the license that authorizes Image-Pro to run.

You will want to review the next section, "Upgrading the Installed Software" on the next
page, regardless of what type of upgrade you are doing.

If you are upgrading from a previous version of Image-Pro, then you will want to review
the section "Upgrading your License" on page 39.

l If you are running a licensed and registered copy of Image-Pro 9, this will be a
paid upgrade to version 10, and it will not be available via Auto-Update.
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Upgrading the Installed Software

There are several ways that you can upgrade the software installed on your computer to
Image-Pro 10:

l You may download the Image-Pro 10 evaluation software and install it from the
Media Cybernetics’ website.

l If you have ordered an upgrade from Image-Pro Plusor Image-Pro, you will receive
a USB stick that will install the software.

Regardless of how you obtain the Image-Pro 10 installer, and regardless of which product
and version you are upgrading from, Image-Pro 10 can be installed alongside your other
software. This allows you to evaluate Image-Pro 10 for your purposes. When you are done
with the older software and completely migrated to Image-Pro 10, then you can uninstall
the older software from the Control Panel.

Upgrading Your Software
If you are running a licensed and registered copy of Image-Pro you will be offered free
upgrades via Auto-Update. If you have Auto-Update enabled, you will be notified of the
version upgrade when you start Image-Pro, and can download and install it as convenient.
If you do not have Auto-Update enabled, you can follow the steps below.

1. Click the small drop-down arrow at the upper right-hand corner of your application

.

2. Choose  Look For Updates.  You will see the Update Available dialog:

3. Click Yes to continue.

Note that if you are upgrading to Image-Pro 10 from Image-Pro 9,  you are required
to update your product license as well as the software. The new version includes a
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14-day temporary license. Follow the instructions regarding the License Upgrade Wiz-
ard later in this chapter to obtain a permanent license.
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How to Return your Original Image-Pro Plus License

In order to receive a new Image-Pro license, you MUST return your original Image-Pro
license dongle. If you do not return your dongle, you will be invoiced for the difference.
Please contact Media Cybernetics’ Customer Service for information about receiving a
Return Materials Authorization (RMA) number and instructions on how to return this ori-
ginal Image-Pro license. 

Here is a sample RMA packing slip:

If you don’t have your original packing slip, please contact customerservice@mediacy.com
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Upgrading your License

If you are upgrading from a previous version of Image-Pro, you may need to upgrade your
license to authorize the new version you are trying to install. When you purchase your
upgrade, you will receive an unlocking code. You will need to have this unlocking code
handy during the upgrade process. Image-Pro includes a Licensing Wizard to step you
through the process of upgrading your Image-Pro license to the latest version. Note that
after the upgrade, the prior version license will still allow you to run previous versions.

In the Image-Proapplication, open the Help menu by clicking the down arrow next to the
Help icon, select Licensing Wizard.
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Configuring License Use

Image-Prouses a powerful licensing scheme allowing to provide the maximum flexibility
when deploying the product. Although the user usually doesn’t need to be involved with
configuring its license use, there are a few cases where it may be convenient to do so.
These include network configurations with shared licenses that may have to be assigned to
specific workstations as well as demonstration or evaluation licenses which may be con-
figured to select the adequate level of functionality. In order to help those users, a license
management tab is included in the About dialog.

l Each available product tier and module is displayed in a hierarchical view with its
contained tiers and features listed as child nodes.
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l Product tiers and modules can be excluded or left as available. Each selection gives
visual feedback based on the tier hierarchy and dependencies so that selecting a tier
will show exactly what features will be included or excluded. The three possible
licensing states are as follows:

l In Use: This tier or module is currently in use on this machine.

l Available: This tier or module is currently available on this machine
without being in use.

l Excluded: This tier or module will not be used on this machine, leaving
the license available for others to use.

l Once changes are made, the configuration can be saved using the Save Con-
figuration button and will take effect in the next session. The information is saved
in the identity so that different identities can use different licenses.
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Sending Feedback

Media Cybernetics welcomes your feedback about our products. If you have a suggestion,
question, or concern, please let us know. To send feedback, follow these steps:

1. Click the drop-down arrow in the upper right-hand corner of the application :

You will see this menu:

2. Choose Report a Problem or Send a Feature Request under the Image Analysis For-
ums.

You will see a form similar to the following according to your choice:
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3. Choose a general comment, feature suggestion, or issue from the dropdown list.

4. Enter your comments, and remember to include your email address.

5. Press Submit.

Your feedback is always appreciated. You should hear from us shortly.
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Getting Started

This chapter introduces you to the Image-Pro and Image-Pro with 3D Module systems,
including an overview of the interface components and features. 
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The Image-Pro Application Window

When Image-Pro is loaded, its application window becomes active. 

The in-product Help contains detailed information about all the features and functions of

Image-Pro. Click on the question mark at the right side of the application window
to open the help file. More information about using the Help appears at the end of this
chapter.

The center of the window contains a set of panels or panes. The far-left panel is the Over-
view panel, which contains the image strip and tools that provide an overview of the work-
space contents. The center panel contains the active content, which can be an image,
histogram, or other rendering. The far-right panel contains the image histogram as well as
additional dialogs that enable you to modify the contents of the workspace.

The following sections explain these features of the Image-Pro application window in
greater detail.

Floating Panels

One of the unique features of Image-Pro is the “floating” or “dockable” panels. The image
strip, details panel, mini-histogram panel, or other workspace areas can be moved inde-
pendently from the main image workspace. This may be particularly useful when working
with a dual-monitor system, as you may want to display the image on one monitor and the
details on the other.  An example of floating or “undocked” panels appears below:

45



The Image-Pro Application Window

Workspace Tabs

Image-Pro and Image-Pro with 3D Module display your images in tabbed workspaces, as
shown here:

The name of the active image in the workspace is highlighted. You can switch back and
forth among multiple images by clicking the image’s tab.

The small icons next to the name of the image indicate what type of image is open. Some
examples of common types are shown here:

Viewing Tooltips

Tooltips show the basic image information:
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l To view an image tooltip, move your mouse cursor over the image thumbnail
in the image strip.

The zoom and pan controls allow you to resize the image or a portion of the image.

When the active image is zoomed and doesn’t fit in the viewer, the viewing area is shown
on the image strip thumbnail as a semitransparent orange overlay.

l Click and drag the center of the viewing area on the thumbnail to control pan
and scroll of the image.

Tools and Layouts

The View tab contains specialized tools and graphs to display information about the act-
ive image or image set. Some of these tools allow you to see different aspects of the active
image also.
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Using the Multiple Document Interface (MDI)

The Switch to MDI button will toggle the workspace windows to MDI windows or back
to tabbed windows. This feature allows you to view more than one image at a time, and
move the images and panels to different locations in the application.

This feature is located in the Workspace group on the View tab’s ribbon:

Normally, when the workspace windows are set to Docking, the image appears like this:

When you switch to the MDI view, several images can be viewed at once, as shown here.
This example shows image windows tiled horizontally.
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The pull-down MDI menu allows you to select a window display:

This example shows image windows in the Cascade layout:
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Align Views lets you organize your images in rows and columns, as shown here:

The Tools in the Workspace group allows you to load and save custom tool sets and lay-
outs for your specific situation.
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Close All Views closes all the images and windows in the workspace.

Close All Tools closes all open dialogs and panels.

Tools redocks or resets any tools/ Click the drop-down arrow to see these features

Redock All Tools: Resets any open moveable panels that are undocked to their default
docked position.

Reset Tools Layout: Resets the application to its factory default tools layout.

Load Layout: This tool allows you to load a previously-saved tools layout. When you
click on this tool, the following dialog is displayed:
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This dialog shows all available tool layouts to be loaded. The Recent area shows a list of
the last loaded layouts. The Custom area shows a list of the custom layouts currently
stored in the Configuration Files folder. The Default area shows a list of the available pre-
defined layouts from installation directory \Resources folder.

SaveLayout: Click this tool to save the current layout of tools to a file that can be loaded
at a later time to restore the layouts to its current configuration. When you click this
option, you are prompted to give the layouts configuration file a name. Type a name for
the layout configuration file, then click Save. You can use the Load Layout tool (described
above) to restore the tools layout to its current configuration at a later time.
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The Image Context Menu

Clicking the right mouse button on an image displays the following context menu:

l The Zoom Scale Bar allows you to adjust the size of the image by moving the
slider to the right or left.

l The Undo and Redo buttons let you undo recent actions and reverse the effects of
the Undo.

l The Copy button will copy the part of the image under the ROI to the Win-
dows Clipboard.

l The Histogram button opens the image histogram.

l The Image Information button displays information about the image in a
table below the image.

l Local Zoom opens or closes the Local Zoom feature.

l The Red, Green,Blue, and White tint buttons apply the appro-
priate color to the image.

l The Remove Tint and Remove Tint All buttons remove tints from the active
image or all open images.

l The Toggle Nudge polygon/polyline editing mode button is enabled when the
selection tool is running. Nudge editing mode becomes active only when a polygon
or polyline is the selected object being edited.  Pressing the <N> key has the same
effect.

53



 The Image Context Menu

l The Toggle Extended Vertex polygon/polyline editing mode button is enabled
when the selection tool is running. Extended Vertex editing mode becomes active only
when a polygon or polyline is the selected object being edited.  Pressing the <E> key
has the same effect.

l Clicking the Convert button converts the selected graphic object(s) into poly form
if possible.

l The Toggle limiting graphic object button limits creation and editing to image
bounds on the active overlay.  By default, graphic object creation and editing is lim-
ited by the bounds of the underlying image on all overlays except for the Annotation
overlay, where limiting is disabled by default.

l The Selection tool enables selection and editing of displayed graphic objects.

l The Draggingtool allows you to move the Pan/Scroll position by clicking and
dragging on the image. 

l The Zoom tool allows you to zoom in or out on the image with mouse clicks or
by drawing a box around the area to be zoomed.  Only one tool may be active at
any time, so starting one of these tools will stop any currently active one.

If your active workspace is an image set, you will see a different context menu.

More information about working with image sets appears in Chapter 5.
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Viewing Image Document Information

Click the symbol to see information about your active image. You will see the
DocumentProperties window displayed at the bottom of the Image-Pro workspace, as
shown here:

The image and document property information has been greatly expanded in from pre-
vious versions of Image-Pro. This expanded view allows you to find important inform-
ation more easily. You can also edit the metadata.

The Document Properties feature allows you to view your data in four different lay-
outs:

To compare information for more than one image, click the Lock icon.
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The Welcome Screen

The first thing you see when you start Image-Pro is the Welcome screen. T The updated
and improved Welcome screen introduces a tabbed interface with 4 different tabs.

The Get Started tab displays a link to the Apps Library on the top part of the page. The
bottom part of the page shows the last three posts from the Image Analysis Forum. Click
any link to access the image analysis discussions and knowledge base.

The information on the left side of the screen is always available. From here, you can open
an image, sequence, or set. The list of recentimages displays a list of files that were
recently opened.

Check for Updates: Click this button to see if any upgrades are available from
Media Cybernetics.

Show page at startup: Check this box to see the Welcome screen each time that you start
Image-Pro.

The Training Resources tab displays a copy of the contents of the video tutorials page
on the website.
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The tutorials are in MP4 format. A media player is required to view these files.

The Latest News tab displays the latest news from Media Cybernetics.

A red notification displays the number of new articles and disappears when the tab is
clicked.

The Forums tab displays the most recent discussions from the Media Cybernetics Image
Analysis Forum.
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The Image-Pro Ribbon

The Image-Pro Ribbon contains commands that affect or change the content in the main
workspace. The overwhelming majority of the commands in the Ribbon are buttons which
either perform some command directly or open a dialog panel for setting options and per-
forming related actions. The ribbon displays commands organized into tabs and groups.
The ribbon displaying the Capture tab is shown below:

The different ribbons will be examined in more detail later in this chapter.

Note that if you have not licensed capture, or are running Image-Pro with 3D Module,
some of the tabs and their associated ribbons will be different from this illustration.
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Different Types of Content

Image-Pro is able to open and save a wide variety of files and formats, as shown in the
snapshot here:

In addition to different image file formats, Image-Pro can open different types of image
sets and Media Cybernetics experiment files.

Images, or single frames, come in many different formats and types. Image-Pro can open
and read many different formats. A list of available image formats appears in Appendix A.

Image sets are collections of images containing more than one variable dimension. A time
lapse movie is a simple example of the type of image sets that
Image-Pro is designed to handle. A more complex set may contain time lapse movies at
several different positions on the slide, with a Z-series at each time and spatial position.  It
is possible to create image sets that have multiple channels, stage positions (user defined
or arrayed), Z slices, images per stage position (tiles), and time points. In an image set, we
still have multiple frames, but we know why – there are multiple channels, or the stage
moved, or the focus changed, etc.

Experiments are image files that contain different types of content stored in one, often very
large, file.
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The File Menu

The File button is located in the upper-left corner of the application window. The File but-
ton menu contains commands that operate on the document as a whole, such as Print and
Save, as well as other basic functions.

Clicking the File button displays functions that are always available:

l New

l Open

l Save

l Save As

l Reload

l Print

l Close

Some of the items in this list have small menu arrows next to them. Hover your mouse
over the arrow to make the menu appear, as shown here:
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The Recent Documents panel lists the files that you opened recently:

Click the name of the file to open it.  You can use the push-pin icon to “pin” recently-
opened files to keep them in the list. The drop-down arrow
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Opening an Image

To open a saved image:

1. Click the File button.

The pull-down application menu appears.

2. Choose Open. Click to go directly to the Open Images dialog, or hover your mouse
over the menu arrow to see the menu of choices.
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3. Select the location and type of image file that you want to open.

4. Select the image file that you want to open using the standard file open dialog as illus-
trated below.
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To open more than one image, hold down the <Ctrl> key and use your cursor to
select the images you want to open.

5. Click the Open button.

The selected image is opened in the Image-Pro workspace.

Opening an Image Sequence
Image sequences are like small movies. Image-Pro allows you to open, edit, and play image
sequence files (*.seq).

To open an image sequence:

1. Click the File button.

The pull-down application menu appears.

2. Choose Open. Click to go directly to the Open Images dialog, or hover your mouse
over the menu arrow to see the menu of choices.
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3. Select Open Images as a Sequence. Sequences have the extension *.seq.

4. Select the image sequence that you want to open using the standard file open dialog
as shown here.

6. Click the Open button.

The image sequence is opened in the Image-Pro workspace.
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This example shows one frame of the heart.seq.

Opening an Image Set
An image set is a collection of images taken together to form a time lapse sequence, area
scan, or a Z-stack, or any combination of these. Image sets are often complex groupings
that include more than one dimension, such as both time and Z/focus dimensions, as well
as channel specificity and more. This would mean that a single image member file of a
given image set could, for example, represent a single channel at a single distance/focus
and a single moment in time. The collection of images would therefore need to be organ-
ized and reconstituted to be viewable and analyzable in any meaningful way.  is designed
to work with the metadata and naming conventions found in many sets created by com-
monly used image acquisition tools and to organize the files according to the their sig-
nificant dimensions (or let you organize them) so that they can be saved into a single
image set file (with the extension *.mcs).

Note that there are five possible dimensions that can be used in the organization of files in
a set:

l Channel: Index number for the color channel.

l Slice: Index number for the relative position in the Z stack or series of focal adjust-
ments.
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l Site: Index number for the site. Used for organizing image data per area of interest
in a sample, for example.

l Time: Index number for the relative position in a time lapse sequence.

l XY Scan: Index number for the relative position in an XY scan (a series of images
that are taken across the surface of a sample).

Image-Pro and Image-Pro with 3D Module feature the SetBuilder. You can use this fea-
ture to create an image set from a collection of individual image files. Follow the instruc-
tions below:

1. Click the File button.

2. Choose Open Set from Files.

You will see the following dialog:

68



Chapter 2

3. Select the folder containing your image source files.

Use the Select Source Folder browser in the far-left panel to navigate to the folder
where your image files are located. Your set files should be in numerical order if pos-
sible.

4. Select the method for determining the set. There are three modes of operation avail-
able:

l Automatically detect file sequence. Select this option if the files in the sequence
have matching internal dimensions and naming conventions that make their loc-
ations along each dimension distinctly identifiable. In such a case, Image-Pro can
reconstitute the entire set instantly and automatically. If you select this option,
you should:

a) Select a single file that is a member of the set you are trying to buld. analyzes
its name to tries to discern dimension information in the name. If any dimension
information is detected, it prompts you to confirm the meaning the data in the
name structure, as follows:
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b) Review the assigned dimensions. From the list boxes provided, select the cor-
rect dimension information if  guessed wrongly.

c) For sequences that include numeric and non-numeric dimension information
(such as when a channel name is included in the file name), use “Check to add the
active selection as a partial set” to “lock in” the detected sequence to part of a lar-
ger set.

l Split sequence into dimensions. Select this option if the files in the sequence have
naming conventions that mix location information for multiple dimensions into a
single sequence. For example: a 50-slice, 2-channel set that includes files named
“Image001.tif” through “Image100.tif”In such a case,  can automatically collect the
relevant files into a table, and perhaps organize them according to one dimension,
but it depends on you to specify the specify the allocation of the specified
sequence into the relevant dimensions. If you select this option, you should:

a) Select a single file that is a member of the set you are trying to buld. analyzes
its name to tries to locate sequence information in the name. If any dimension
information is detected, it prompts you to confirm the meaning of the data in the
name structure, as follows:

b) Adjust the dimension allocation as appropriate using the list boxes provided.
Note that additional dimension drop-downs appear as needed.

l Manually add files to a dimension. When you select this option, you are promp-
ted to select a dimension and position within that dimensions to which you want
to add files, and then select the files to be added: Follow the steps below to manu-
ally organize your files:

a) In pull-down list box below the Add selected files to... button, select the
dimension you want to define.

b) In the spin box to its right of the selected dimension, specify the position in
the selected dimension to which you want to add files.
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c) In the file list, select all files belonging to the specified position of the selec-
ted dimension.

d) Click the Add selected files to... button.

e) Repeat steps a) through d) until all relevant dimensions and positions are
defined.

Choosing a new operation mode will change the controls available in the control
panel at the bottom of the center region of the Set Builder dialog.

5. Select a folder to add images to the File Table in the center panel. The file table in the
center will list the supported image files that are present in that folder, whether or not
they belong to a set.

The Location columns of the file table display the location index fields that have been
assigned to that file. If the file has not been assigned to any location within the set,
this column will be blank. Once the file has assigned to a location in the set, the Loca-
tion column will be replaced with columns for each dimension that is currently active
in the set.

Each dimension is represented by an icon: Color Composite Channel, Location in the
Z –stack, and Time position. Each column header has a tool tip to indicate the dimen-
sion that the icon represents.

The dimensions of each set appear in a table on the right hand side of the dialog.
When you've selected a folder, the file table in the center will list the supported image
files that are present in that folder, whether or not they belong to a set are in the panel
on the right. This table indicates the extents of the set as currently constructed. In the
cases of incomplete (jagged) sets, the extents in this table will represent the longest
added set thus far:

6. Add channel information for the set.

The channels table displays one row per channel. You can set the channel name, tint,
or set them both by assigning a dye to the channel, as shown in the illustration below:
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The channel name can be edited in-place.  Use the Color drop-down arrow to see the
standard color picker. Click the “…” button in the Dye column to select a dye from
the favorites list, or from all available dyes:

l When Show all dyes is checked, all the dyes in the Dye Library will be included in
the list. If this option is not checked, you will see only the dyes in the Favorites
list. If the current channel name matches a dye in the list, that dye will be selected
in the drop-down list.

l Click Apply to set both the Channel Name and the Color for the selected dye. In
addition, the dye will be associated with the channel and will later be associated
with the image set channel when the set is imported.

7. Set the Z-spacing.

The Z- spacing panel on the dialog allows you to set the spacing between Z planes if
the selected set has Z stacks:

The selected spacing will be applied to both the set’s metadata and to the frames of
the images

8. Open the set.

The Open Set button will be disabled until you have selected at least one file to
define the set.

Here is an example of an image set open in the workspace:
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The slider controls and other features of an image set are discussed in Chapter 5, Work-
ing with Images.
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Saving an Image

When you hover over the Save command in the application button drop-down menu,
Image-Pro displays two options:

l Save

l Save All.

Save

Use the Save command to immediately store the contents of the current window to its file
(the file listed on the window's title bar) while leaving the image active in its window. If
the image is in an untitled window, Image-Pro will display the Save File As dialog box.

The Save command can be used to save your most recent changes to disk. It is often per-
formed as a precautionary measure during lengthy or involved processes to reduce the
amount of reprocessing that might be required in the event of a system failure or oper-
ational error. When you close an image and choose not to save its changes, Image-Pro dis-
cards all changes made since the last Save operation.
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Save All

Use the Save All command to immediately store the contents of all images currently open
in the Image-Pro workspace.

To save an image, follow the steps below:

1. Click the File button. The pull-down application menu appears.

2. Choose Save. You have a choice of saving only the active document (image) or saving
all modified documents or images. Your image is saved automatically.

Using Quick Save
In addition to using the Save to File feature of the image settings,
Image-Pro offers you a quick and easy method of saving your images. Note that Quick
Save does not work with image sets.

1. Go to the Quick Save group on the Capture tab.
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2. Choose Quick Save for Analysis or Quick Save for Publication.

If you are saving a sequence of images, choose Save as Movie.

When you select Analysis, you will see the following drop-down menu:

l Quick Save for Analysis stores your images in *.TIF format so that they can be
retrieved for analysis at another time.

l Open Saved Images goes to the Open dialog and lets you select a previously stored
image.

l Options takes you to the File Options page where you can change your pref-
erences.

When you select Publication, you will see the following drop-down menu:

l Publication stores your image in a *.JPG format that can be easily incorporated
into a report or spreadsheet. It also burns-in any annotations, ROIs, or measurements
and resizes your image.

l Auto Open will automatically open your saved image in the workspace.

l Open Saved Images goes to the Open dialog and lets you select a previously stored
image.
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l Options takes you to the File Options page where you can change your pref-
erences.

Save As
Use the Save As command to store the contents of the current window, the current
ROI, or the active part of a sequence, to a file that you specify, in the format that you
specify. The Save As command serves several important uses beyond simply storing an
image to a new file name. It is also used to:

l Convert a single image from one format to another. For example, if you needed a
TIFF file converted to PNG format, you would simply open the TIFF image, and
then use Save As with the PNG format option to save it to a new file.

l Save an image with different compression or quality options from those it was ori-
ginally created with. For example, if your original TIFF file was uncompressed, you
can use Save As with the LZW compression option to store it in compressed form.

l Save an image to another disk or folder.

Note: Files containing multiple frames, or sequences, are supported only in the TIF,
SEQ, IPW, and AVI formats. All other formats will save only the active frame.

The Save As dialog is shown here:
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Save in: Find the folder into which you want to save the file. You may create a new
folder using the New Folder button.

File name: Enter the name of the file you want the image saved to. To specify the
file's location, you can either enter its entire path (disk and folder), or specify its loc-
ation using the Save in list box.

Save as type: In this list box, select the format in which you want the image saved.

Compression: In this list box, select the form of compression you would like the file
stored in. The available compression methods will vary from one file format to
another. For example, LZW (Lempel-Zif encoding) compression is an option with TIFF
files, but it is not available in JPG. Moreover, some formats have no compression
options (None is the only choice).

Note: If you plan to use the image with another program, be sure it is compatible
with the selected compression method. Not all programs support compressed and
uncompressed format variants.
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Reload

Use the Reload command to fill the active window with a new copy of the file it is linked
to (the file listed on the window's title bar).

You might want to use this command if, after considerable editing, you wanted to restart
with an untouched copy of the image. Reload is also very useful in automated procedures
where a routine needs an image free from any effects of a preceding routine.

Note: Image-Pro loads the active window from the current copy of the file associated
with it. If you have made changes to the stored file (whether from this window or another)
after the image was opened, the changes will be reflected in the reloaded image.

Performing a Reload on an untitled image window has no effect.

Performing a Reload has no effect on the Lookup Table. If you have modified the Bright-
ness, Contrast, Gamma settings, they will remain as you set them. If you want to return the
LUT to the original settings, use the Reset button on the BCG tool bar.
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Printing an Image

Use the Print command to print one or more copies of the current image, or the current
ROI, to the selected output device. When you hover over the Print command in the File
menu, you are shown the following print options:

Quick Print: Click on this option to print the report to the default printer using the current
printer settings.

Print: Click this option to display the Print dialog box prior to sending the report to the
printer:
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Through the Print dialog box, you can select the printer you want to print to, define any
other print settings, such as number of copies. Click the OK button to send the page to the
printer.

Print Preview: Click this option to display the report in a preview screen prior to printing.
When you select this option, the preview is shown in a new image window with the fol-
lowing ribbon bar options:

Print: This is the same as clicking Print from the File menu (as described above).

Options: Click this tool to open the Page Setup dialog box:

Use the controls on this dialog box to specify the desired page layout options. Through
this dialog box, you can specify the paper size, page orientation, and margins for the page
containing the image you want to print. Click OK to apply your selections and return to
the print preview.

Close Print Preview: Click this tool to exit the print preview window without printing.
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Quick Access Toolbar

Quick Access Tool-
bardrop-down
arrows

This toolbar, located just above the ribbon bar tabs, contains controls which are usable
regardless of which tab is active.   You may add a copy of any almost ribbon bar button or
menu item to the quick access toolbar.  Added buttons will be retained from application
session to application session.

Clicking the drop-down arrows displays a drop-down menu that allows you to customize
the selections that appear. A copy of the drop-down menu appears here:

Use More Commands to add items to the Quick Access Toolbar. You can find information
about adding commands in Chapter 9.

In addition, right-clicking on any of the buttons in a ribbon displays a menu that allows
you to add that button to the quick access toolbar, as shown here:

l Note that there may be some functions that cannot be mapped to the Quick Access
Toolbar.
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Options Buttons

Image-Pro includes Options buttons throughout the workspace. Click on these gear but-
tons to adjust colors, font sizes, and other feature settings.

Close or Hide Dialogs for Extra Space

Open up your workspace by hiding open dialog boxes. If you are not using a panel to
close the dialog, or may need it again later, collapse it by clicking thumbtack button on
the top of each dialog. Hover over the dialog to expand and view it temporarily. When the
dialog is expanded, you can click the thumbtack again to “pin” it open for future use.
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The Image-Pro Status Bar

The Image-Pro status bar provides context-sensitive information about the status of your
activities.

l Status area. This is where the progress bar and other indicators will appear.

l Frame number of the image in the workspace.

l Date and time that the image was captured.

l Pixel location of the cursor.

l Pixel value.

l Spatial calibration if known.

The image view icons allow you to view your image or sequence in different present-
ations:

l Resource monitor. Clicking this icon opens the resource monitor to display import-
ant metrics about the management of images, and control over the application's
use of image memory.

l Single image viewer. This icon changes depending upon if the image in the work-
space is displayed as a single image or in a 3D view.

l Surface plot viewer. Click this icon to display the image as a surface plot.

l Gallery viewer. Click this icon to display an image sequence in gallery view.
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l Slice viewer. Click this icon to display your image in slicer view.

l 3D viewer. Click this icon to display a 3D view of the image in the workspace.
This will be different if you are using Image-Pro with 3D Module.

l Image bitmap. Click this icon to display an image bitmap of the image in the
workspace.

l Zoom factor. Click this icon to adjust the size and scale of the image in the work-
space. You will see the following dialog.

l Scale to best fit automatically adjusts the image display to show the best fit

l Scale to width automatically adjusts the image to the width of the workspace

l Scale to height automatically adjusts the image to the height of the Image-Pro
allows you to enable or disable the status bar fields.  Right-clicking on the status
bar displays a menu that allows you to select what type of data you want to dis-
play in the status bar.

A zoom slider and a fixed-zoom control list allow you to control the size of the image in
the workspace. The zoom slider is shown here:

When the magnification is known and the option active, the current zoom will be dis-
played as the effective magnification, as shown here:
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Image-Pro allows you to enable or disable the status bar fields.  Right-clicking on the
status bar displays a menu that allows you to select what type of data you want to display
in the status bar.

Click the cursor next to the name of the field you wish to enable or disable. Enabled fields
are checked. You can also enable or disable fields in the status bar using the options
described earlier in this chapter.
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Tabs and Ribbons

Tabs are used to display different groups of functions.  The tabs are arranged in a pro-
gressive left to right order following a common workflow where a person using the applic-
ation acquires an image from a source, adjusts it in some fashion, selects objects in the
image for study, measures properties of those objects, visualizes those objects in multiple
potential contexts, then shares this information with others.  If you have licensed a copy
ofImage-Pro with capture, the default tabs are named Capture, Adjust, Process, Select,
Count/Size, Measure, Share, View, Automate, and Apps. The Image tab is only
available when an image is open in the workspace. The Image tab is only available when
an image is open in the workspace. The Extras and Custom tabs are available only when
certain features are enabled. Each tab opens a specific ribbon displaying groups of related
tools.

If capture is not available with your application, the Capture tab is replaced by the Home
tab. If you are using Image-Pro with 3D Module (with or without capture) there are addi-
tional tabs: 3D View, 3D Measure, and 3D Animation. More information about the 3D
features appears in Chapter 12.

Some of the Image-Pro tabs are context-sensitive, which means that they are available only
when you are using certain features, like Line Profile, or opening certain types of images,
image sets, or Very Large Images (VLI).

Capture tab

The Capture tab contains groups for selecting dyes and lenses, calibration, and saving
your images.

Note that this tab does not appear if you are using the non-acquisition versions of
Image-Pro or Image-Pro with 3D Module. In this case, you will see the Home tab instead.

87



 Tabs and Ribbons

This tab contains groups for selecting dyes and lenses, calibration, and saving your images.

Adjust Tab

The Adjust tab contains all the functions that allows you to manipulate the image for best
viewing and interpretation. Some functions may require making new or composite images
from other images or changing the pixel values within an image.

Process Tab

The Process tab contains the image processing tools that allow you to change an image
or extract information from it.

Select Tab

The Select tab contains the Clipboard, Annotation, ROI, and Mask features that enable
you to examine and annotate an image or part of an image.

If you are using Image-Pro with 3D Module, this tab appears as 2D Selection.
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Count/Size Tab

The Count/Size tab contains tools that allow you to view, count, and measure objects in
a two-dimensional image. It also contains the tools to display the resulting data in a vari-
ety of formats. If you are using Image-Pro with 3D Module, this tab appears as 2D Coun-
t/Size.

Measure Tab

The Measure tab contains features that enable you to measure and analyze features in all
or part of your two-dimensional image. If you are using Image-Pro with 3D Module, this
tab appears as 2D Measure.

Share Tab

The Share tab contains features that allow you to share your images and data with others.
You can also create an audit trail of all the recordable events during your image processing
session. The features on the Share tab allow you to create reports and export your files.

View Tab

The View tab contains specialized tools and graphs to display information about the act-
ive image or image set. Some of these tools allow you to see different aspects of the active
image also.
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Image Tab

The Image tab is only visible when there is an image or image set open in the workspace.
You can adjust the image display, show it in a gallery, or zoom/pan on a particular portion
of the image.

Optional Tabs
These tabs appear when you enable certain features using the Options described at the end
of this chapter.

Automate Tab

The Automate tab contains the macro scripting features. This tab is visible by default, but
you can turn it off by un-checking Show Automate Tab on the Display options page.

Apps Tab

The Apps tab contains any apps that you have loaded into your copy of Image-Pro. It
contains a link to the App Center, where you can find and download the newest apps. It is
empty until you have created or downloaded some apps.
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Custom Tab

The Custom tab creates a ribbon for you to store the features that you use most fre-
quently. The first time you open it, the Custom tab’s ribbon will be empty. You can add
any group or tool to it.

This tab does not appear until you check Show Custom Tab on the Display options page.

Extras Tab

The Extras tab contains advanced features, such as Find Shapes. This tab does not appear
until you check Show Extras Tab on the Display options page

Context-Sensitive Tabs
These tabs are available when you have opened certain features.

3D View Tab

3D View lets you load, save, and examine your 3D image in a variety of ways:
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This tab is available when you have a 3D image open in the Image-Pro with 3D Module
workspace.

3D Measure Tab

3D Measure contains the tools and features you will need to make volume measurements
in a 3D image:

This tab is available when you have a 3D image open in the Image-Pro with 3D Module
workspace.

3D Animation Tab

3D Animation lets you create animated images and movies from 3D images.

This tab is available when you have a 3D image open in the Image-Pro with 3D Module
workspace.
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Chapter 4: Viewing Intensity Measurements

Viewing Intensity Measurements

This chapter explains how to:

n View an Image Histogram

n View a Line Profile

n View a Data Table

n Use the Saturation Warning
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Image Histogram, Line Profile, and Saturation Warning

If you have a license for the Capture module, the Image Histogram, Line Profile, and Sat-
uration features appear in the Intensity group on the Capture ribbon. If you do not have a
Capture license, this group appears on the Home tab’s ribbon.

Image histograms measure, and illustrate in graph form, the distribution of pixel intens-
ities in an image.  Histogram data can be created and viewed for data gathering and ana-
lytical purposes or can be manipulated for image enhancement purposes.

Line profile analysis allows you to collect the actual pixel intensities of the pixel values
under the profile line. A profile plot shows the pixel positions of the line along the X-axis,
and, along the Y-axis, indicates the pixel intensity for each position along the line. Either
or both axes may use calibrated units if the image has a spatial calibration (for the X-axis)
or intensity calibration (for the Y-axis). You can display a line profile on any type of
image, whether it’s the live image, a captured image, or an image opened from a file.

Saturation is used to show overexposed and underexposed areas with a given color. It can
be used with the live preview to set proper exposure time and avoid over or under- sat-
urated areas, so that intensity measurements on the image will be correct.
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Viewing an Image Histogram

Image histograms measure, and illustrate in graph form, the distribution of pixel intens-
ities in an image.  Histogram data can be created and viewed for data gathering and ana-
lytical purposes or can be manipulated for image enhancement purposes. To create an
Image Histogram:

1. Open the image that you want to measure if it is not already opened.

2. Select Image Histogram from the Intensity group.

A histogram window appears in the Image-Pro workspace:

The histogram area is displayed with a gradient tint that ranges from  from black to
white for mono images, and from black to the color of the channel for color images.

Histogram & Profile options control the display of an image histogram or line profile.
More information about these options appears in Chapter 2.

The Reset button automatically resets the histogram display.

Best Fit applies the best fit display to the image .
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If you click the drop-down arrow, you will see the available best-fit options:

Auto-Range automatically adjusts the black and white levels on the image. This fea-
ture is available only if the current camera supports Auto-Range.

The Data Collector feature lets you accumulate data to display in the data
collector. Click the drop-down arrow to see these options:

Check the appropriate box to add or clear information for the data collector.

Right-click in the Histogram window to display the drop-down menu:

This menu lets you select a variety of options.

You can copy your graph, or export it to Microsoft Word, Excel, or Powerpoint. Other
options let you show or hide the different features of the image histogram.

Note that you can zoom in on a part of the histogram  by using your mouse to draw
a region on the histogram graph.

The View sub-menu allows you to display the graph legend and statistics.
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You can adjust the black and white levels by using the right and left sliders.As you
move the sliders, you will see the changes in the black and white levels reflected in
the image.

The Options sub-menu contains additional controls for displaying the graph.

n Ignore ROI: indicates that the histogram should reflect the  entire image

n Active Frame:  use only active frame for histogram data

n Mono interpretation:  interpret color images as monochrome images

n Spatial Calibration: use spatial calibration to calculate histogram and statistics val-
ues

n Range Statistics: calculate statistics based on selected range only (selected range
displayed on the chart as yellow bar – you can move or adjust left and right edges
of the selected range with a mouse),

n Exclude Bins: exclude the number of bins to the left or right.

The Statistics option lets you hide or show the following information about the image
histogram:

n Mean: the calibrated Mean of all the bin counts (or selected Range)

n St. Dev.: the calibrated standard deviation of all the bin counts (or selected Range)

n Min: the calibrated minimum of all bin x values (or selected Range) (calibrated
intensity)
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n Max:  the calibrated maximum of all the bin x values (or selected Range) (cal-
ibrated intensity)

n Sum: the calibrated Sum of all the bin counts (or selected Range) where calibrated
bin counts (Values) are multiplied by their x value (calibrated intensity), and accu-
mulated

n Area (…): the calibrated area of the pixels with intensity between Black and White
Levels (or selected Range),

n Area (%):  the percentage of the pixels with intensity between Black and White
Levels (or selected Range) to the total image area.

Advanced Display
Additional histogram options are available when you select the Advanced button from the
Display group on the Adjust tab:

The Advanced context ribbon appears, with additional controls over image display and
brightness/contrast adjustment.

When the Histogram button is activated, the Advanced Display panel opens to show a lar-
ger version of the image histogram appears in the bottom panel of the application work-
space:

The drop-down menu of the Histogram group lets you control the appearance of the his-
togram display:
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The example above shows an area histogram. The Dynamic button adds a display of the
resulting or effective histogram after all of the current display adjustments (such as Bright-
ness, Contrast, or changes in the Black/White levels) are applied.

The Look-Up Table (LUT) is also displayed on the graph. The LUT determines how pixel
intensities are displayed on your monitor. Changes to Brightness, Contrast, or the freeform
LUT, will change the display of the image, but will not affect the underlying pixel values.
You can turn it on or off using the LUT button in the Look Up Tables group.

The LUT is indicated by a diagonal line on the histogram and by additional information in
the right-hand panel:

Clicking the Freeform button displays additional information on the histogram. Choose a
display option from the drop-down list:
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Here is a sample histogram with freeform and line information:

The Options group has the following features:

Ignore ROI creates a histogram using the entire image, even if an ROI is present.

Active Frame creates a histogram using only the active frame in a sequence.

The Log X, Y group uses logarithms to create the graph:
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Log X button is used to generate the graph’s horizontal axis using a logarithmic scale.

Log Y button is used to generate the graph’s vertical axis using a logarithmic scale.
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Viewing a Line Profile

Line profile analysis allows you to collect the actual pixel intensities of the pixel values
under the profile line. A profile plot shows the pixel positions of the line along the X-axis,
and, along the Y-axis, indicates the pixel intensity for each position along the line. Either
or both axes may use calibrated units if the image has a spatial calibration (for the X-axis)
or intensity calibration (for the Y-axis). You can display a line profile on any type of
image, whether it’s the live image, a captured image, or an image opened from a file.

To view a line profile:

1. Open the image that you want to measure, if it isn’t open already.

2. Select Line Profile from the Capture tab’s ribbon.

You will see the Line Profile ribbon:

There are many different drawing tools in the Line Profile ribbon. They can be used
to  draw the sampling lines for the Line Profile..

3. When you select the Line Profile, Image-Pro will automatically draw an initial line
profile on your image.
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4. This profile is labeled “Line 1”. This is to help you get started with the Line Profile
tools. You can adjust the Initial Profile in the Histogram and Profile panel in the
Application Options. The Line Profile graph appears in a pane below the image:

As you draw more lines on the image, they will also appear in the profile pane. The
plot scale along the X-axis will be adjusted to display the longest line profile that
you’ve drawn. The currently selected Line Profile will appear on the plot and in the
legend as a thicker trace. Under the line profile plot is an image display of the intens-
ities of the pixels under the line profile at each position along the selected Line Pro-
file. The image display will be as long as the selected profile, which may be shorter
than the longest one that you’ve drawn.

Line Profile Tools
When the active image has one or more line profiles applied to it, the Line Profile context
ribbon is displayed. It contains many useful tools for working with your line profiles.
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There are many different drawing tools in the Line Profile ribbon that can be used
to draw the sampling lines for the Line Profile. The table below describes each
tool:

Select

The plot scale along the X axis will be adjusted to display the longest
line profile that you’ve drawn. The currently selected Line Profile will
appear on the plot and in the legend as a thicker trace. Under the line
profile plot is an image display of the intensities of the pixels under the
line profile at each position along the selected Line Profile. The image
display will be as long as the selected profile, which may be shorter than
the longest one that you’ve drawnUse this tool to select a line profile fea-
ture or group of features.

Line

The Line button will display the currently selected line. This tool
defaults to a simple line, but when you click the drop-down arrow on
the line tool, you will see additional selections. Use the default Line
tool to draw a sampling line on your image. Click on the first point and
drag to the last point of the desired line.

Polyline

This tool allows you draw poly-vertices lines and polygons, or freehand
lines and shapes.

To draw freeform lines and shapes

Use this technique to create lines and shapes that have smooth edges. 
Hold the left mouse down while you draw with the cursor to create the
desired freeform shape.  Double-click to complete the shape.
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To draw polyvertices lines and polygons

Use this technique to create lines and shapes that are made up of straight
line segments.  Click the left mouse button at each vertex (including the
beginning point) of the polygon.  Double-click to complete the polygon.

The auto-trace option for ploylines also appears when you click the drop-
down arrow.

Rectangle

Click the left mouse button and hold it down to drag the rectangle to
your desired size. Clicking the drop-down arrow will also display the
Polygon tool.

Polygon

This tool allows you draw polygons, or freehand shapes. Click the left
mouse button at each vertex (including the beginning point) of the
polygon.  Double-click to complete the polygon.

Auto-Trace Polygon. Use this tool to trace polyshapes automatically.

Circle or Ellipse

Position the crosshair cursor anywhere in the image.  Click and drag the
mouse from the insertion point to the desired destination.  Hold down the
<Shift> key while dragging the cursor to create a circle.
Delete Selected

Use this button to remove the selected  profile feature  from your image.
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Delete All

Use this button to remove all the line profile features from your image.
Note that if you delete all line profiles, the Line Profile pane will be
empty until you draw another one.

Auto-Trace

Use this tool to trace the outline of an irregular object in the image auto-
matically. Place your cursor on the object and click two points. Image-Pro
automatically traces the object.

Width
Use the spin buttons to indicate the with of the profile line in pixel

Features Manager
Use this button to manage feature collections.You will find more inform-
ation about features and feature collections in Chapter 8 of this manual
and in the in-product Help.

Line Profile Options

Use this button to display the options that control the appearance of the
line profile labels in the line profile pane. You can control the size, opa-
city, direction, and color of the lines.

Line profile lines have a start and end point. Check the Flip Profile Dir-
ection box to reverse the direction of the profile lines.

Use the right and left arrow buttons to move the profile points in either
direction.

As noted above, each line profile has a beginning and an end. For example, lines
start at the first point at the left, and end at the last point, on the right. The last
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point gets an arrowhead by default. Closed figures are drawn in the clockwise dir-
ection, and an outline arrow indicates the direction, as shown here:

Checking the Flip Profile Direction box reverses the direction:

Background Tools

The Background combo box is used to select a background profile (values of back-
ground profile will be subtracted from all other profiles values). Background
smoothing is used to select the type of smoothing for background profile values.
The Points box indicates the number of points visible on the graph.

To Add a Line Profile to the Current Collection

Line Profile collections are created by adding defined Line Profiles (that is, Line Pro-
filess defined in the active image) to the list of ‘remembered’ items through the
Features Manager dialog box.  You can add a single Line Profile definition, or you
can add a group of :Line Profile definitions under a single name.

1. Open the Features Manager dialog.

2. Draw the Line Profilen the active image.
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3. Click on the Add button.

The collection definition is added to the list box.  Listed names represent the mem-
bers of the current collection.

When a single Line Profile is defined, a default name appears in the Name text
box of the Features Manager dialog box.

If you define more than one Line Profile on the image, the features  manager gives
the entire group the default name, “Multiple.”  Note that if multiple features  are
defined in the image, they will be added to the list as a group regardless of which
feature among them is currently selected. 

More information about the Features Manager appears in Chapter 8.
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Edge Detection Tools

The Edge Detection tools find peaks, valleys, and patterns in the line profiles. The
Edge detection tools are described below:

Peaks

Use this tool to find peaks on the profile.

Valleys

Use this tool to find valleys on the profile.

Rising Edges

Use this tool to determine rising edges in the profile

Falling Edges

Use this tool to detect falling edges in the profile. 

Manual

Click this button to activate the manual edit edge tool (used to add/re-
move edges on the image)
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Edge Setting

Use the pull-down arrow next to the tools to open the Settings dialog.

Label lets you select the label style and color.

The Color Selector lets you change the color of the ticks and label
text.

Checking the Show Ticks and/or Show Labels boxes will display the
tick marks and labels on the image.

Smoothing: Use the spin buttons to apply the Gaussian smoothing fil-
ter to the luminance profile. The numbers indicate the degree of
smoothing that the filter uses. Smoothing of 1 means no smoothing. 
If smoothing value is more than 1, a Gaussian smoothing kernel will
be applied to the luminance profile.

Offset: Use the spin buttons to indicate how many pixels to offset the
markers from the detected features.
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Threshold defines threshold level for marking an “edge” on a
weighted profile.
It uses the minimum difference between an extreme point and neigh-
boring opposite extremes. If the difference between the extremes is
smaller than the sensitivity threshold, the marker is ignored. The
Threshold is defined in percentage from 0 to 100 from the dynamic
range. The default value is 0, so that all peaks and valleys are detec-
ted, even when deviations of intensities are very small.

Min Edge indicates the minimum number of expected “edges” on
each profile.

Max Edges indicates the maximum number of expected “edges” on
each profile.

The pattern matching feature lets you select a pattern template or create your own pattern:

Pattern A

Use this button to select pattern template A

Pattern B

Use this button to select pattern template B.

Pattern Settings

Use the pull-down arrow next to the tools to open the Label Settings dia-
log.
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Match length indicates the number of profile samples over which
averaging or pattern matching is performed, i.e. this is the length
of the segment where edge finding method is performed.

Hotspots (%) indicates the point in a weighted peak to mark as
an edge, given as a percentage of the match length. This is an off-
set for the exact edge position as a percentage of the match
length. 0% - beginning if Match length segment, 100% - end of
the segment.

Threshold defines threshold level for marking an “edge” on a
weighted profile.
It uses the minimum difference between an extreme point and
neighboring opposite extremes. If the difference between the
extremes is smaller than the sensitivity threshold, the marker is
ignored. The Threshold is defined in percentage from 0 to 100
from the dynamic range. The default value is 0, so that all peaks
and valleys are detected, even when deviations of intensities are
very small.

Min Edge indicates the  minimum number of expected “edges”
on each profile.

Max Edges indicates the maximum number of expected “edges”
on each profile.

Match Offset is an additional setting to creata a user- defined pat-
tern. This edge finding method is based on the same mean lumin-
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ance of a user defined pattern. You might use this option if you
were looking for a “W” shaped pattern on top of bright sections
of the profile, but you wanted to exclude such profile patterns
where the image was dark.

Size Weighting (%) is an additional setting for creating a user-
defined pattern. It defines the strength of the Match Size option.

Match Size is an additional setting for creating a user-defined pat-
tern. This edge finding method is based on matching amplitudes
in the  user-defined pattern. The strength of the effect depends on
the Size Weighting property (stronger with greater Size Weight-
ing). You might use this option if you were looking for medium-
sized luminance peaks, but you wanted to exclude very bright
spots.

Lock Settings . If this setting is on, then edge detection set-
tings will be applied to the all profiles. This option could be
used for profiles imported from Feature Manager and edge detec-
tion should be done on all imported profiles.

Manual. This setting activates the  manual edit edge tool
(used to add/remove edges on the image)

n Peaks – activates peaks manual tool,

n Valley – activates valleys manual tool,

n Rising – activates rising manual tool,

n Falling – activates falling manual tool,

n Pattern A/B – activates pattern A/B manual tool,

n Reference – activates reference manual tool

To use Edge Detection, follow these steps:

1. Open the image that you want to measure, if it isn’t open already.
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2. Select the Edges group from the Line Profile ribbon:

3. Draw a line or two on the image, as shown here. Line 1 is red and Line 2 is green.

4. Select the Peaks tool from the Edges group.
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Make sure that the tick marks option is turned on. The edges will be marked on the
image, as shown in the previous image.

A line profile displaying the variations in the edges will appear in the line profile win-
dow at the bottom of the Image-Pro workspace.

The Line Profile window contains additional graphic display tools:

The Graph button displays the line profile as a graph, shown above.

The Table button displays the line profile information in a table, as shown
here:

The Measurements button displays the line profile information with a picture
strip below:

5. Click the Plus button to add measurements to the table.

The Line Profile ribbon has other options available, which are described here:

The Classes group lets you apply labels to different features within the image.

You can select the color for each class label, and have the labels appear on the image,
graph, or data table.

The Measurements group in the Line Profile ribbon contains features that allow
you to add measurements to the Line Profile shown above.
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The Options group contains controls for displaying the image.

The Log group displays the X- and Y-axes in a logarithmic scale.

The Font group lets you select the font style, size and color for the class labels.

The File group allows you to save or load the current state of the line profile tools.

The Collect group allows you to accumulate data to display in the data collector.
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Click the drop-down arrow to see these options:

Check the appropriate box to add or clear information for the data collector.

To exit the Line Profile ribbon, click the Close button.
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Using the Saturation Warning

Use Saturation Warning to show overexposed and underexposed areas with a given color.
It can be used with the live preview to set proper exposure time and avoid saturated areas,
so that intensity measurements on the image will be correct.

Click the Saturation button to see the drop-down menu:

The colors are set using High level and Low level color pickers. Intensities that are greater
than or equal to the High Level threshold will be colored with the designated high color.

Intensities that are less than or equal to Low Level threshold will be colored with the des-
ignated low color.

The channels used for saturation test can be selected using Red/Green/Blue checkboxes or
by clicking the Channels button.

This is a sample of a partial image with the high saturation areas visible:
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The Reset button sets the controls back to their default values.
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Working with Images

This chapter introduces you to image processing in Image-Pro.  It provides instructions for
opening, saving, and enhancing images through Image-Pro. 
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Viewing Optical Characteristics

The Characteristics group on the Capture tab’s ribbon lets you choose a dye, lens, and/or
calibration to use while acquiring images.

Clicking the drop-down arrow next to the dye displays a list of available dyes:

Clicking the drop-down arrow next to the lens displays a list of available lenses:

The Lens is particularly important, as you can associate a spatial calibration with each
lens; in addition to the lens characteristics (such as Magnification) , a spatial calibration
will be applied to each captured image, assuring accurate measurements. Please  refer to
the Using Spatial Calibrations section for more information.

This group can also display the magnification zoom level. You can select which char-
acteristics to display in the Display area on the Applications page of the Image-Pro
options dialog.
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The Mag. * Zoom display option controls display of the zoom magnification level (which
will always be at the top of the group, if displayed). As illustrated above, the group can
only hold 3 sets of controls, so when three options are checked, the fourth will be dis-
abled. To hide the Characteristics group, do not check any of the options.

Your selections will appear in the Characteristics group on the Capture tab’s ribbon:

1. To  select optical characteristics, click on the drop-down arrow and select an item from
the drop-down list.

2. To edit one of the characteristics, click the edit button at the far right.

You will see an editing panel at the right side of the workspace.

The Lenses panel is shown here as  an example:
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3. From this panel, you can edit or change the lens used to capture your images.

The Lens Library displays a list of available lenses with their calibrations.

You can search for a specific lens by manufacturer or magnification.
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Using Spatial Calibrations

Using a spatial calibration, Image-Pro's pixel-level measurements can be converted to any
unit of measurement.  Spatial calibrations can also correct for irregularities in the image’s
vertical and horizontal spacing.

If you are working with an uncalibrated image, you will see this warning:

There are two primary components to a spatial calibration:

n Pixels per Unit

n Aspect Ratio

Pixels per Unit

A spatial calibration tells Image-Pro the size to which a given image is scaled, just as the
key of a roadmap tells us how many millimeters of image length represent one mile.  Like-
wise, the spatial calibration tells Image-Pro how many pixels of image length represent
some more meaningful unit of length in the image, for example, one micron, millimeter, or
inch.  To create a new spatial calibration, you must either know the number of pixels per
unit to specify for the image, or there must be a feature pictured in the image that has a
known length value in terms of the units of interest.  If a feature of known length is pic-
tured, Image-Pro can calculate the number of pixels per unit by determining the number of
pixels it takes to represent the known length.  (Companies often ‘plant’ an object of
known length into images for this purpose.)

Aspect Ratio

Aspect ratio refers to the ratio of vertical to horizontal lengths.  For example, when a tele-
vision screen’s image appears flattened or squeezed, the ratio of horizontal length to ver-
tical length is out of proportion.  Similarly, cameras often inadvertantly skew images in the
process of capturing them and translating them to digital format. 

125



Chapter 4

Such skewing results in inaccurate lengths being ascribed to features that are measured in
the image.  When a skewed aspect ratio has a flattening effect, vertical lengths will be
recorded as shorter than they actually are; when it has a squeezing effect, horizontal
lengths will be recorded as shorter than they actually are. 

If an image has a known aspect ratio problem, Image-Pro can compensate for the flattening
or squeezing of vertical and horizontal lengths, and calculate the actual number of units
that measurements of its features represent.  To do this, you must be able to supply it with
the value l/h (length divided by height) for a perfect square as represented in the image, or
there must be a feature pictured in the image that represents a perfect square.  If a square
feature is pictured, Image-Pro can calculate the aspect ratio from that feature.  (Companies
often ‘plant’ a perfectly-square object into images for this purpose.) The selected image
must have a reference feature of known size, which you will measure in step 5.

System and Reference Calibration

Image-Pro maintains a list of Reference Calibrations that will persist from session to ses-
sion and can be applied to multiple images.Image-Pro also maintains a list of all of the cal-
ibrations that have been used in your current session, which will include all the reference
calibrations, as well as any calibrations that have been loaded from any calibrated images
that you have opened. One of the Reference Calibrations can be selected the System Cal-
ibration. The System Calibration is automatically attached to images that you Capture or
Record using your camera, and may also be used as the default spatial calibration when
loading a 3D volume from uncalibrated images.

If you have configured your system using the Hardware Configuration Wizard (described
in Chapter 3), then you will not need to be concerned with Reference or System cal-
ibrations. A list of Reference Calibrations will be created and associated with your Lenses,
and when you select an active lens, the calibration associated with that lens will be made
the System Calibration.

Creating a Spatial Calibration
To create a new spatial calibration, you must either know the number of pixels per unit to
specify for the image, or there must be a feature pictured in the image that has a known
length value in terms of the units of interest (see “Pixels per Unit” under “About Spatial
Calibrations” above)..
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Quick Calibration Method

1. Open the image you want to calibrate or that you want to use to create the calibration
definition.

2. On the Capture tab’s ribbon, select the Calibration group.

3. Click the Create drop-down arrow.

4. Click the Quick Calibration button

5. Draw a line over a feature in the image.

You will see the Calibrate by Feature dialog:
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6. Select a calibration name in the drop-down list.

7. Select the units in the drop-down list, and indicate the number of units in the selected
feature.

8. Indicate if this is a system or reference calibration.

9. Click OK.

Auto-Calibration

To use Auto-Calibration, follow these steps:

1. Open the image of the Stage Micrometer (included with the Image-Pro Demo Images).

2. On the Capture tab’s ribbon go to the Calibration group.

3. Click the Create drop-down arrow.
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4. Select Auto-Calibration. You will see the Auto-Calibration dialog:

5. Click OK.

If the box is checked, you will see the Spatial Calibration dialog:

From here, you can rename your calibration and make further adjustments.

Calibrating by Aspect Ratio

If your calibration must also correct for aspect ratio, you must either know the value l/h
(length divided by height) for a perfect square as represented in the image, or there must be
a feature pictured in the image that is known to be a perfect square (see “Aspect Ratio”
under “About Spatial Calibrations” above). 

To create a spatial calibration:
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1. On the Capture tab’s ribbon, select the Calibration group.

2. Click the Calibration options icon to open the Spatial Calibration dialog box
in the panel on the right.

The dialog box controls are enabled.  This dialog has two view, Basic and Advanced.

In the list-box in the control window (Calibration Name) select the set of calibration
values you want to apply to the image. If you want to use the default values, select
(none). Any calibration sets that were loaded or created since the application window
was last opened, will be listed in this list box.

You will not be able to enter calibration values until a name other than (none) has
been selected in the Name list box. If (none) is the only set listed, you can create a set

by clicking the New button and specifying its calibration values.

By default, the name "Spatial Cal 0" will be assigned to a new calibration set; how-
ever, you may change this to a more descriptive name if you'd like.
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3. Type over the default name “Spatial Cal 0” with a name that is more meaningful.

4. In the Unit area, pull down the Name list box and select the units to which you want
the pixel-level measurements converted, as shown below:

For example, if the size of objects in the image is best expressed in terms of micro-
meters, select “Micrometer” from the list.

5. In the Abbreviation text box, enter the text you want to use as the abbreviation for
the selected units. 

For example, a typical abbreviation for ‘Millimeter’ is “mm” as shown below. The spe-
cified abbreviation will appear on measurement reports.

6. In the Pixel/Unit group, do one of the following:

If you know the number of pixels per unit to specify:  

1. In the X spin box, type the number of horizontal pixels it takes to rep-
resent one unit of length.  For example, if you are converting to mil-
limeters and 4 pixels equals one millimeter, type “4.”

2. Ignore the Y spin box.

If there is a feature pictured in the image that has a known length value: 

1. Click the From Image button in the Pixel/Unit area.
A dialog box appears in the Image-Pro panel, and a horizontal annota-
tion line appears in the image. 

2. Click and drag the line over the reference object, and then adjust the
line’s control points so that the beginning and ending of the line cor-
respond to the beginning and ending of the reference object.
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TIP: For greatest accuracy, it is often helpful to zoom in on the reference

object.  To zoom in on the reference object, click on the Zoom tool
from the View tab’s ribbon.  With the Zoom tool selected, position the
cursor over the reference object, and click.  Repeat these steps until the
object is large enough to determine its starting and ending pixels.

3. In the Reference length (units) spin box, type the known length of the
pictured object.

4. Click OK.
The Spatial Calibration dialog box is redisplayed and the calculated
pixels/unit value appears in the X and Y spin boxes.

If you  have an image of a micrometer, you can calibrate the image auto-
matically:

1. Click the Auto button in the Pixel/Unit area.

2. A dialog box appears over the image of the micrometer.

3. Draw an ROI around the micrometer image.

4. Click OK., and the calibration will be calculated automatically.

7. Select the Advanced Options on the Calibration dialog.

8. In the Apect Ratio area, do one of the following:

If you know the aspect ratio value to specify, or if there is no aspect ratio
problem to correct for:  
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1. In the Aspect Ratio spin box, type the aspect ratio value to be used. 
For example, if there is no aspect ratio problem to correct for, enter “1.”
Image-Pro automatically adjusts the value for the X spin box to match
the entered Aspect Ratio value.

If there is a feature pictured in the image that represents a perfect square: 

1. Click the From Image button in the Aspect Ratio area.
A dialog box appears in the Image-Pro workspace, and a diagonal
annotation line appears in the image. 

2. Click and drag the line over the reference object, and then adjust the
line’s control points so that the beginning of the line corresponds with
the bottom-left corner of the reference object and the end of the line cor-
responds with the top-right corner of the reference object.

TIP: Again, for greatest accuracy, it is often helpful to zoom in on the ref-
erence object.

3. Click OK.
The Spatial Calibration dialog box is redisplayed and the calculated
aspect ratio value appears in the Aspect Ratio spin box. Additionally,
the X and Y spin box values are automatically adjusted to account for
the aspect ratio.

9. Click Apply to Active Image in the spatial calibration toolbar.

The spatial calibration is applied and saved for the session.  To make it available across ses-
sions, you must save it to a file (see “Saving Calibrations” below). 

Calibrating by Feature

Calibrate by feature option allow you to calibrate an image by a feature with known size.
Any line measurement can be used for image calibration.

Calibration by feature can be done using the following steps:

1. Create a measurement of an object of  known size. For example,  the length of a
bracket can be measured.
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2. Click the Calibrate by feature length button (the same function can be called from
the context menu in the Data Table).

3. Fill the feature size in calibration units and other calibration parameters, such as Units
and Calibration name in the shown Calibrate by feature dialog:

4. (Optional) Use the Show calibration dialog to adjust the calibration measurements.

5. Click Ok to create a new calibration and apply it to the active image.

Predictive Calibration

Predictive calibration lets you create estimated spatial calibrations based on the optical
characteristics of the camera and objectives. To use the predictive calibration feature, fol-
low these steps:

1. From the Calibration group drop-down menu, select Show Predictive Calibration.
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You will see the Create Predictive Calibration dialog:

Each camera is defined by the Manufacturer and Camera Model fields

2. Select your camera manufacturer and model from the drop-down lists. The pixel and
sensor size is determined by the camera make and model. If you want to set the pixel
and sensor size manually for the new calibration, choose Other in the list of cameras.

The Calibration prefix is also defined automatically the camera selection. You may
type in a new prefix in the space provided.

3. Select the lenses from the calibration from the Lenses panel.

All active lenses are selected by default, so if some lenses should not be cal-

ibrated,uncheck them using the  button to select/deselect a lens.

4. Add additional Zoom settings in the Zoom panel. This list is empty by default.

5. Enter the calibration units in Units field under the Calibration parameters .

6. (Optional) Check the Show Calibration Dialog box if you want to edit the cal-
ibration after you’ve created it.

7. Click OK to create the predictive calibration.

Clicking the OK button will generated multiple calibrations for the list of selected
lenses and zooms for the given camera.  If multiple zooms are present, the calibration
with zoom closest to 1 will be used as default lens calibration.
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The list of camera manufacturers and camera models is loaded from "Camera
list.cfg" file in the Resources folder of the application.

Saving Calibrations
Calibration definitions are saved per-session whenever they are applied to an image.  If
you want calibration definitions to be saved between sessions, however, you must mark
them as Reference Calibrations or save them to a file.  Once a calibration definition is
saved to a file, you can load it whenever it is needed in the future.

To save calibration definitions:

1. Click the drop-down arrow next to the Open Calibration button on the calibration set-
tings dialog.

The drop-down list box appears.  If an active image is displayed in the Image-Pro
workspace that has a calibration definition assigned to it, that calibration definition
appears in the Spatial Calibration dialog box.

2. From the list box at the top of the Spatial Calibration dialog box, select the cal-
ibration definition you want to save.

3. Click Save from the Spatial Calibration group.

TIP:  If you want to save all calibrations listed in the Spatial Calibrations list box,
skip Step 2 and click on the Save All from the Spatial Calibration group.

The Save Calibration dialog box appears.
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4. In the File Name text box, type the name you want to give to the current calibration
definition (or set of calibration definitions) being saved.

5. Click on the Save button.

Locking Calibrations

To ensure that your calibration measurements are not deleted or changed accidentally, you
can lock them. To lock a calibration, follow these steps:

1. Create a calibration using one of the methods described in this chapter.

2. Save your calibration.

3. Click the lock icon on the calibration ribbon:

You will see the  Lock calibration dialog:
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4. Fill in your name and create a password.

5. Click OK. This calibration is now locked and protected against accidental changes.
The lock icon changes to an open lock.

6. To unlock the calibration, click the open lock icon. You will see the Unlock cal-
ibration dialog:

7. Enter the owner name and password.

8. Click OK. The calibration is unlocked and may be changed.

Importing and Exporting Calibrations

Import Calibration and Export Calibration have been added to the Calibration Options
drop-down menu, as shown here:

You can use these features to import/export the calibration and calibration/lens linkage as
a package that can be imported into other copies of Image-Pro.
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Applying a Calibration Marker to the Active Image

The calibration marker is like a distance key on a map – it shows a line and expresses
what that line represents in terms of meaningful units.  In Image-Pro, it is composed of
two or three overlays, as shown below:

When you add a calibration marker, Image-Pro adds it to the currently active image based
on the number of pixels in the image. 

To set the calibration marker to appear in the active image:

1. Choose the Auto-Marker button from the Calibration Marker drop-down menu:

A marker will be placed on all open and active images automatically.

2. Otherwise, click the Calibration Marker button [ ] in the Image-Pro toolbar.

A calibration marker will appear in the image.
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The Marker Options dialog box appears.

3. Use the Position buttons to place the marker on the image. You can resize the marker
and the length and the label will be adjusted automatically based on the current size.
The length is rounded to the nearest value from the list of 10 logarithmically
equidistant values (1, 1.2, 1.5, 2, 2.5, 3, 4,…).

4. Set the Control options the way you want them.  The Length (units) spin box controls
how long the marker will be.  Image-Pro renders a marker of the length you specify
here.  Adjust the Length (units) value so that the resulting marker line is long enough
to give an indication of scale, but not so long that it takes up the entire image width. 
Also, use round numbers.  Keys generally use ‘reference’ lengths, such as multiples of
25. The size of the calibration marker can be adjusted manually by resizing the marker
on the image. Note that the minimum marker size is limited by the width of the cal-
ibration label text.

5. Set the Font and Size options the way you want them.  Use the Size spin box to indic-
ate the size, in points, to be used for the text. To hide the text and only display the
marker, set the font size to zero. Use the Color button to change the text color.

6. Set the Background options the way you want them.  Use the Color button to change
the color of the background.  Uncheck the Show button if you want to suppress the
background.

TIP:  You may need to experiment with the Text and Marker settings to get the
desired effect.  Go with your best guess the first time you set the marker.  Once the
marker is added to the image, you can easily delete it and define a new one (see
“Deleting an Annotation” in Chapter 7, “Annotating Images”).  By refining the Text
and Marker settings on subsequent iterations, you can achieve the desired effect.
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The length of the calibration marker can be adjusted manually by resizing the marker
on the image. In this case the minimum marker size is limited by the width of the cal-
ibration label text.

7. Click OK.

The calibration marker is added to the image.

n To add a marker  automatically to all active images, click the Auto Marker

button.

When calibration markers are initially added to images, they are added as annotation
overlays.  This means that they can be moved and deleted the same as any annotation. 
This also means that they will only be saved with the image if that image is saved in a
TIFF format.

Note that Image-Pro does not support calibration of the Z-axis. Where possible, the
location of each Z plane along the Z-axis will be determined from Z stack sequences
or image sets that you open.
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Using Intensity Calibration

The Intensity Calibration selections can be used to measure changes in intensity and
pixel values in an image or set of images. You would use this command if you wanted to
relate intensity to optical density, or relate intensity to temperature or relate intensity to
protein content, for example.

1. To start using the Intensity Calibration feature, click the Int. Cal button in the Cal-
ibration group on the Capture ribbon.

You will see the Intensity Calibration dialog:
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2. To create a new intensity calibration, click the New button on the Intensity
Calibration toolbar.

3. Choose a calibration name from the drop down list, as shown here:

The default is “Intensity Cal 0”. You can rename it if you choose.

A new intensity calibration curve will be displayed in the window.

The main toolbar contains the following buttons:

Apply: Applies the selected calibration to the active image.

New: Click this button to create a new set of calibration values. When this but-
ton is clicked, the Application will place the "Intensity Cal 0" name in the Name list
box (the 0 digit may be incremented to make the set name unique) and show the cal-
ibration curve. You can change this name to something more useful if you like.

Load calibration from file:  Loads one or more saved calibration(s) from  your
files.
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Save: Saves  the current calibration to a file. Clicking thedrop-down arrow
will save all your calibrations.

Delete: Deletes the current calibration. Clicking the drop-down arrow will
delete all your calibrations.

Ref Only: Click this button to display only the reference calibrations.

Reset: Clicking this button resets the list of intensity calibrations.

Units: Type the name of your unit in this field (e.g., gray level, 
density, degrees, disbursement). This name will appear when the application reports
intensity data.

Abbreviation: Enter the short name of the units (as OD, ng etc.).

Log scale X and Y turns the  logarithmic scale along the corresponding axis on the
chart on or off.

Toggle Reference Calibration: Click this button to mark or unmark the current
calibration as a reference calibration.

Toggle System Calibration: Click this button to mark or unmark the current
calibration as a system calibration.

Intensity calibrations are handled in the same way as system calibrations. To learn
more about system and reference calibrations, please refer to the section on page 5-7 of
this manual.

To use the edit  mode, select the Options/Edit calibration button to see the tools for
editing the intensity calibration:

Use these tools to add, delete, or edit points in the image for intensity calibration.
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Step Tablet Wizard

Intensity calibration can be created from a step-tablet image with known optical dens-
ity values using the Step Tablet Wizard .

1. Open the image called Steptab.tif

2. Click the Step Tablet Wizard button to display the following dialog:

3. Draw a line from center of the first to the center of the last step on the steptab image:

When the line is created,  the bands on the step-tablet image are automatically detec-
ted and labeled:

4. Add the correct Output values for every Input value in the table.

Tip: you can create a file with Output values for certain types of step-tablets and use
it with multiple images using the Load and Save buttons.

5. Once you are satisfied with your values, save the calibration.
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The Image Tab

When you have an image active in the workspace, the Image tab appears in the applic-
ation, as shown here:

From the Views group, you can select one of seven different ways to view your image:

n  Image is the default view, with the active frame of the image or sequence dis-
played in the image workspace.

n Surface represents the Surface Plot view, which is an advanced view discussed in
the next section of this chapter.

n Gallery displays all of the frames of the sequence in a grid, and allows you to
quickly and easily change the active frame.

n Slicer displays X/Y, X/Z and Y/Z projections of a sequence in the slicer view.

n 3D displays X/Y/Z sequences as a volume.

n Bitmap represents the Bitmap Analysis feature, which displays the pixel intens-
ities of the active frame of the image, and is discussed in a subsequent section of
this chapter.

n Clone allows you to open another view on the active image in any of the sup-
ported viewers.

The Zoom group lets you focus on specific parts of an image using the Zoom, Pan,
and Local Zoom features.  The Lock button lets you synchronize two images or
frames together.

Viewing a Surface Plot
The Surface Plot (or 3-D Plot) tool creates a three-dimensional representation of the intens-
ity of an image. When using the Surface Plot tool, keep in mind that X = length; Y =
width; and Z = height. Learn more about Surface Plot by following these steps.

1. Open an image in the workspace.
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2. Go to the Views group on the Image tab.

3. Choose the Surface icon.

You will see the Surface Plot context ribbon:

A three-dimensional representation of the image appears in the workspace:
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The lighter and taller areas of the plot represent areas of greater intensity on the image.
Areas of lesser intensity are shorter and darker. You have many choices for adjusting
the appearance and features of the surface plot diagram, as described here:

DrawMode

The options in the Draw Mode group control the appearance and display of the sur-
face plot diagram. One of the three modes can be selected: Texture, Color or Wire.

In Texture mode the surface uses an image for the surface plot texture.
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Viewing a Surface Plot

The Texture drop-down menu allows you to control the degree of transparency for the
surface plot. Transparency set to 0 indicates no transparency.

The Color group lets you select the colors to map to the gray values found in the sur-
face plot, as shown here.
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In Color mode the surface plot is pseudo-colored. The color is assigned according to
the height value. Click the drop-down arrow to see the context menu:

When Smooth palette is on the colors of palette entries are blended.

The Contour option adds black lines separating color bands.

The Zones control defines the maximum number of pseudo-color zones. Type a new
value and press Enter key to change it. Note that zones are created automatically
based on the total range of the height axis (see Auto Range option of Axes). The num-
ber of zones on the image corresponds  to the number of major tick marks on the
height axis and can be smaller then the Zones value.

The Wire mode shows a wire frame version  of the surface plot diagram.
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The number of wires along the longest image direction is defined by the resolution

option in the pull-down menu, shown here:

Resolution

The Resolution group enables you to adjust the display resolution of the surface plot:

Style

This group controls the  visual presentation of the surface plot diagram.
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Clicking the Axes button  toggles visibility of the axes and walls on or off. The drop-
down contains the options:

The Text Color and Transparency of the walls can be set using the pull-down con-
trols.

Tip:To hide the walls but leave the axes visible set transparency to 100.

When Auto Range is on (default) the range of height axis is calculated based on the
image data. When the option is off the height range is defined by the display range of
the topology image (ActiveImage.RangeMin and ActiveImage.RangeMax properties).

The Legend button turns the legend on or off.

The legend’s position can be selected from the drop-down menu

.

The Light button toggles lighting schemes in the order defined in the Scheme list.
When the Light Scheme is set to None, the illumination is switched off. Northern
Lights scheme uses three light sources, the restof the schemes  use only one.

The ambient color can be selected using the Color picker.
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The Background control defines the style and color of the graph’s
background. Start Color and End Color define the colors of any background gradi-
ent.

Geometry

The Geometry group lets you view the surface plot from different angles.

Increase Height
Use this tool to increase the height of your surface plot image.

Decrease Height
Use this tool to decrease the height of your surface plot image.

Reset Height
Use this tool to reset the height of your surface plot image back to its
original size.

Perspective Projection
Use this tool to create a perspective projection of the surface plot
image.
Orthagonal Projection
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Use this tool to create an orthagonal projection of the surface plot
image.

XYZ Perspective
Use this pull-down menu to select the X, Y, or Z perspective

Output

The Output options determine where your surface plot settings and information will be dir-
ected.

Clipboard: Clicking this button sends your surface plot information to the Windows clip-
board, where it can be pasted into other applications that accept data from the clipboard.

Image: Clicking this button creates the surface plot in a new workspace. This function cre-
ates the surface plot in the same size as the original image. It is a good idea to create a
new image when you want to save or print the surface plot, because in this case the surface
plot has maximal resolution.

Animation: Clicking this button displays the Surface Plot animation dialog;
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Rotation direction: Indicate the direction of the animation movement, either horizontal or
vertical.

Number of steps: These spin buttons define the number of frames in the output animation.

Angle range: These controls define the rotation angle of the total animation around X, Y
and Z axes in degrees.

See-saw animation: Checking this box causes the animated image to move up and down,
just as the name implies.

OK: Clicking the Ok button creates an animation sequence in the workspace. The new
sequence then can be saved as a multi-frame *.TIF or *.AVI file.

Using Gallery View
The Image Gallery feature creates a workspace from an active image sequence. The indi-
vidual frames in the sequence are displayed in a gallery format.  To see an image gallery,
follow the steps below:

1. Open an image sequence in the Image-Proworkspace.

2. Go to the Image tab.

3. Click the Gallery button.

Clicking this button creates a image gallery workspace from the active workspace.
This feature is disabled if there are no active images, or if the active image is a single-
frame workspace. Here is a sample image gallery:
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The red square in the gallery workspace indicates the active frame in the larger work-
space. Use your cursor to click on different frames in the gallery, and the red square
will move to the selected frame, and the active image in the workspace will change to
the selected frame as well. You can also use the following keyboard shortcuts:

l <Ctrl> +<Click> will select or deselect more than one frame.
l <Ctrl> + <Mouse Wheel> zooms the view in or out.
l Clicking the right mouse button opens the context menu and also displays
image information:

Gallery Ribbon

The gallery ribbon contains the following tools:

The Extract tools let you work with individual frames.

Extract. Clicking this button extracts selected frames into a new image or set.

Extract Frame By Frame. This button extracts selected frames into new indi-
vidual images  (a new image is created for each frame).

Average. Clicking this button creates a new image  by averaging the selected
frames,
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Difference. This selection creates a new image as the difference between the
selected frames.

l Wrap: Calculate the last frame as the difference between the last and first
frames.

l Diff Only: Returns only the difference frames (the result will be one frame
shorter than the original),

n Pad First - pad the result with first frame of no difference,
n Pad Last - pad the result with a last frame of no difference,

The Options let you specify how you will view the frames:

Show Range will show frames only from the range Start/End,

Show Every Frame will show each frame from the sequence,

Show Frame Number show or hide the frame number in the top-left corner
of the frame,

Show Frame Relative Time shows or hides the frame relative time

Show Frame Time shows or hides he  frame date and time,

The Style tools let you customize the frame display:

Active Frame selects the active frame color

Selected Frame indicates the selected frames color

Active Range selects the active range color

Reset Style resets the colors to their default (Active frame – Red, Selected
frames – green, Active Range – yellow)

Reset Zoom resets the zoom of the frames to the default size

Clicking the Edit button opens an additional ribbon:
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Note: Edit Mode enables “Drag and Drop” operations with frames. This allows you
to (rearrange frames and add frames from the Image Strip.This feature is not usable
with image sets.

The Clipboard group contains the standard set of tools, applied to image frames:

Paste Click this button to paste frames from the clipboard into the image 
next to the active frame.

Paste New exports frames from the clipboard into the new image.

Paste Frame by Frame exports frames from the clipboard into new
images (new image created for each frame).

Cut Click this button to cut selected frames from the image and place them
onto the clipboard.

Copy This selection copies the selected frames onto the clipboard.

Extract. Click this button to extract selected frames into a new image or set.

Extract Frame By Frame. Click this button to extract selected frames to new
images frame by frame (a new image is created for each frame).

The Frames group contains additional frame editing tools:

Add Frames:

Add Active frame only.  When checked, only the active frame will be
added from the source image

Location
l First adds frames to the beginning of the sequence.
l Current adds frames at the current location (active frame).
l Next Current adds frames to the next from the Current location.
l End adds frames at the end of the sequence.

Add All adds all available frames to the sequence.

Add Blank Frame adds a blank frame to the sequence.

Remove is used to remove selected frames from the image.

Left moves the selected frames on one frame to the left.
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Right moves the selected frames on one frame to the right.
Close group:

Close Edit Mode closes the Edit ribbon.

Using the Slicer Viewer
Note: The section documents the simple Slicer Viewer that is included with Image-Pro.
Image-Pro with 3D Module includes a more advanced Slicer view, which is described in
The 3D Slicer Ribbon section in Chapter 12 and in the in-product help.
The Slicer Viewer allows you to view and examine a Z-stack volume using cross sections
of the XY,YZ , and XZ planes.The Slicer is located on the Image ribbon, as shown here.

Clicking the Slicer button will create a slicer view of the current image:
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The top left view is the XY plane. The top right view shows the ZY plane. The bottom
left displays the XZ plane. The bottom-right displays a 3D view of the image.

The Slicer Viewer Ribbon

The Slicer Viewer has the following ribbon bar:

The Composition group defines the parameters of the viewer.

Maximum intensity projection.
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Minimum intensity projection.

Note that the number of slides included in the projection is defined in the Thickness
group.

The Cross checkbox turns the crosshair marker on or off on all the views. The color of the
crosshair marker can be selected using the color-picker drop-down menu.

The Reset button resets the view and resizes the viewers to display the best-fit image.

The Duplicate button duplicates the active view in a new window.

The Voxel Size group defines the size of the voxel. Note that the X- and Y- size are defined
by the spatial calibration of the image. The Z-size is calculated from the distance between
frames in Z direction. Only the Z- size is editable.

Slicer Position defines the X, Y, and Z coordinates of the cross-section.

Slice thickness is defined in the Thickness group. Clicking the All button sets the thick-
ness to the specified volume dimensions. This button can be used to create maximum

intensity projections for the whole volume. Clicking the Thin button sets the thickness
to 1.

Using the 3D Viewer
The 3D Viewer window allows you to examine an image stack in a variety of different
ways: by volume, in thick or thin slices, and as an animated display. In the 3D Viewer, all
geometric objects are shown in 3D space. The 3D Viewer is located on the Image ribbon,
as shown here.

Clicking the 3D button creates a 3D view of the current image with the voxel size cor-
responding to the spatial calibration and the Z-distance between slices. Here is a sample
3D image:
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The image can be rotated by holding down the right mouse button and dragging the image
in the workspace. Pressing <Shift> + <Click> and dragging will pan the view. Pressing
<Ctrl> + <Click> and dragging the image up or down will change the zoom.

Note that if you are running Image-Pro with 3D Module, this feature is replaced by the
features described in Chaper 12 of this manual.

The 3D Viewer Ribbon

The 3D Viewer ribbon contains the following tools:

The Reload button allows you to reload the volume with different sub-sampling.
Clicking the drop-down arrow displays these choices:

l Reload

l Reload when Image changed
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l Reload when LUT changed

Reload when image changed or Reload when LUT changed indicates if the image must
be reloaded if the corresponding parameter changes.

You can also define the voxel size and sub-sampling manually. When the Auto box is
checked, the volume is subsampled automatically.  Clicking the Reset button sets the sub-
sampling to 1x1x1.

The X, Y, and Z voxel size can be edited interactively in the Voxels Size group.

The Style group controls the display of the 3D image:

The Axes button turns the volume axes on or off. Activating the Smooth control enables
sub-pixel approximation of the texture.
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The Transparency slider of defines the volume transparency. The color of the background
can be changed using the Background color picker.

The Composition group defines the options to create the view:

Blended composition

Maximum intensity projection

Sum projection

Minimum intensity projection

The slider defines the number of slices in volume presentation. The larger number may pro-
duce better quality volume rendering, but may slow down the processing.

The Geometry group defines the camera parameters:

Activates the perspective view.

Activates the orthogonal view.

Clicking the Projection button activates following orthogonal views:
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Sets the XY projection .

Sets the ZY projection.

Sets the XZ projection.

The slider controls the Camera view angle in degrees.

The Output group lets you decide how to display the 3D image results:

Clicking the Clipboard button copies the current view to the WindowsClipboard.

Clicking the Image button creates a new image in the workspace.

Clicking the Animation button opens a dialog where you can define parameters for simple
animation.
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Rotation angle controls define the rotation angle of the total animation around X, Y and Z
axes in degrees. (X = horizontal, Y = vertical, and Z = perpendicular to the screen).

Number of steps defines the number of frames in the output animation.

Clicking the Ok button creates an animation as a new sequence in the application work-
space. The new sequence then can be saved as multi-frame a TIF or AVI file.

The Settings group allows you to load or save your 3D viewer selections:

Load 3D viewer options and Save 3D viewer options allow you to load or save your 3D
viewer selections to a file with V3O extension (the file is in XML text format). Loading
saved options allows you to restore a particular view point and composition parameters.

Bitmap Analysis
The Bitmap Analysis command in the View group on the Image tab is used to view the
pixel values of the active window (or a region of interest on that image) in numeric format. 
These values can be saved to an ASCII file for later use with an external program, or
copied to the Clipboard and pasted into another application (a 3D plotting package, for
example).

Pixel values can be displayed as they actually exist in the image or in their calibrated form
. They are not interpreted through the display LUT however.

The Bitmap Analysis window imposes no limit on the number of pixels that can be
processed.  There is, however, a maximum of 30,000 pixels that can be saved, copied to
the Clipboard or transferred to Excel ™.  If you need to save more than this number of
pixels, you can define an AOI that is less than or equal to 30,000 pixels, and process the
image in chunks (i.e., move the AOI systematically across the image and save the data at
each interval).  Or, you can use the sub-sampling option to read the pixel values at larger
intervals.

Note:Consider carefully how much data you actually need to save in ASCII format; a 100
x 100 segment of a Gray Scale image (10K in binary image form) will consume over 60K,
and a True Color segment will take three times that amount. 

To use the Bitmap Analysis feature, follow these steps:
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1. Open an image in the Image-Proworkspace, as shown here:

2. Go to the Image tab.

3. Click the Bitmap button.

The button will be highlighted and you will see the hourglass icon and the Bitmap
context ribbon:

After a few moments, a data table with the intensity values of all the pixels in the
image or ROI will appear in the workspace.
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The Bitmap context  ribbon appears in the ribbon bar above the workspace:

The Copy group allows you to send the table data to the Windows Clipboard, Excel,
Word, or save to disk in *.XLS or *.TXT (tab-delimited) formats for printing.

The Layout group defines the size of cells in the table (Cell Width and Cell Height)
and the color channels layout (if you are workign with a color image). If the image has
more than one channel, the channels can be reported in Rows or  Columns:
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In column fornat, the channel index is displayed with a colon to indicate the pixel pos-
itions. For example, 392:2 indicates the Y coordinate is 392, in channel 2. Switching
to channels by Rows provides a pixel aspect ratio closer to the original image.

Sub-sampling is useful if you are working with a very large image. This feature lets
you analyze pixels at various intervals on the image.

The Options group let you display the pixel values as they actually exist in the image
or in their calibrated form.

Checking Image Background displays the  image as a background for the bitmap data
table. This option can help visually identify the objects of interest.

Image Background on Image Background off

When Intensity Calibration is checked, the table shows intensity calibrated pixel
values. (The number of decimals is defined in the application options described in
Chapter 2).
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Intensity calibration bitmap table

Zooming Images
The Zoom group contains the controls that allow you to resize the image or a portion of
the image.

There are several ways to zoom in and out on an image, that is, to display it at different
levels of magnification.  You can:

l Use the Zoom button in the Zoom group

l Use Local Zoom

l Use the wheel on your mouse (if available)

l Use the scale bar.

Zooming by Using the Zoom Button

This method of zooming allows you to zoom in on specific areas of the image.

1. Click the Image tab from the Image-Pro menu bar.

The Zoom group is displayed.
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2. Click on the Zoom button [ ].

3. Do one of the following:

n Position your mouse over the area of the image you want to magnify, and
click the mouse.

n Click and drag a rectangle around the area of interest on which you want to
zoom.

The image is magnified.  If needed, you can click or drag the mouse again to magnify the
area of interest even further.

Zooming with Local Zoom

The Local Zoom feature provides a tool to show a zoomed area of an image in a separate
window with a given zoom factor. It can be used with manual measurements, the cal-
ibration marker, manual tagging, etc. You can find it on the Image tab, or by clicking the

button on the context menu.

When you select Local Zoom, a new window opens on the right side of the application
area.
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The cross hairs in the Local Zoom window show the current cursor location. This makes
placing accurate manual measurements very easy, even on large images:

Zoom: Choose the required zoom factor from the drop-down list.

Cross hairs: Checking this box turns the cross hairs on; un-checking the box turns the
cross hairs off. The color picker button selects the color of the cross hairs.

Zooming by Using the Mouse Wheel

If your mouse has a wheel on top between the left and right mouse buttons, you can use
this wheel to zoom in and out on the image.  Simply roll the wheel while the image is act-
ive in the Image-Pro workspace.  Roll the wheel toward you to zoom out on the image,
and roll the wheel away from you to zoom in on the image.

Zooming by Using the Scale Bar

This method for zooming allows you to take advantage of zoom presets, or to put the
image in ‘fit to window’ mode so that whenever you resize the image window, the image
is enlarged or reduced to the size of the window.  For example, you can zoom the image to
a specific percentage of its actual size, such as 50% or 200%. 

1. Position the cursor over the image and right-click the mouse.

You will see the scale bar.

2. Move the slider to the right to increase the size of the image, or to the left to decrease 
its size. You may also click the arrow to see the drop-down list of zoom presets. The
scale bar also appears in the status bar at the bottom of the Image-Pro workspace.

Panning Images
The Pan tool is used to position an image that does not fit entirely within the image
window.  You can:

l Use the Pan button in the Zoom group

l Pan in the Image Strip
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Panning Using the Pan Button

1. Click the Image tab from the Image-Pro menu bar.

The Zoom group is displayed.

2. Click on the Pan button [ ].

3. Use your mouse to move the image around in the frame.

Panning in the Image Strip Using Image Navigator

The Image Strip displays a thumbnail of your entire image. When the active image is
zoomed and doesn’t fit in the viewer, the viewing area is shown on the image strip thumb-
nail as a semitransparent overlay.

n Click and drag the center of the viewing area on the thumbnail to control pan and
scroll of the image.

The Image Navigator feature allows you to use your mouse to move the white rectangle
around in the image strip. The zoomed portion of the image in the workspace will move as
you move the thumbnail in the image strip.
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Enhancing an Image

There are several tools available through Image-Pro’s Adjust tab for visually enhancing
objects of interest in your images. The features on the Adjust tab include: 

Resizing an Image
Image transformation allows you to rotate or resize the image in the Image-Pro workspace. 
These options allow you to examine the image in more detail. To resize an image, follow
these instructions.

1. Open the castiron.tif image in the Image-Pro workspace, as described earlier in
this chapter.

2. Select the Geometry group from the Adjust ribbon:

3. From the Resize pull-down menu, select an image size:

4. Click the lock icon and select a measurement unit from the drop-down menu.
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This will maintain the current aspect ratio of the image. To unlock the aspect ratio,
click the icon again. You can find more information about aspect ratios in Chapter 3,
Capturing Images.

5. From the second pull-down menu, select the type of smoothing you require in your res-
ized image:

The resized image will appear in the workspace, with a name derived from the original
image’s name and a suffix indicating that the image has been resized, such as
castiron_100resz*.

Rotating an Image
Rotating an image allows you many different views of the same image. For example, you
can rotate it 90 degrees counterclockwise, or flip it left to right. To try some of the image
rotation features, follow these steps:

1. Open the image in the Image-Pro workspace, if it is not open already:

2. Select Rotate from the Geometry group:

3. Use the pull-down menu to see the Rotate tools:

The tools are:

Rotate image 90° clockwise,
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Rotate image 90° couner-clockwise

Flip image left toright

Flip image top to bottom

Rotate image 180°

Swap corners

Free angle rotation:

l Angle indicates the angle of rotation counterclockwise.

l Preview displays a preview of the rotated ROI.

l Translucent displays the rotated preview in a translucent format.

l Ref. Grid displays a reference grid with the preview on the image at the spe-
cified grid angle.

l Trim will trim the rotated ROI to the same size as the original ROI.

l Rotate with trim into a new image

l Rotate without trim into a new image.

4. Choose the flip left to right tool.

The image will flip automatically, as shown here:

Original image Flipped image
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You may want to experiment with the other Rotate tools.  The Hint windows and tooltips
contain additional information about these tools. A sample hint window is shown here:

Using the Canvas
The drawing Canvas lets you add or remove space around an exisiting image.

1. To use the canvas, click on the Canvas button on the Adjust tab’s ribbon.

You will see the drop-down menu, as shown here:

2. Use the Canvas command from the drop-down arrow to  position the image on the
canvas, as shown here:

177



Chapter 4

From here, you can add annotations and labels to the image on the canvas.You can
also adjust the background and color. You can  crop the image by removing space
around it.
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Converting Images

Use the Convert group commands to transform an image to another color model, to extract
a specific color channel from a color image, or to merge an active, 8-bit gray scale image
into a True Color image.  You might do this to perform editing or analysis upon the image
in another model or to save the image data in a different model for use with an external
program.

The Convert group is shown here:

To convert an image:

1. Select the Destination image type from the drop-down list.

2. Click Apply.

3. Select the type of conversion to perform.
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Your image is automatically converted to the new model. Once you have set the con-
version options the way that you want them, you can click the Apply button in the
Convert group to convert the active image using the current settings without making
furrther changes.
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Using Color Group Commands

Use the Color group commands to transform an image to another color model, to extract a
specific color channel from a color image, or to merge an active, 8-bit gray scale image
into a True Color image.  The Color group is shown here:

Use the Extract selections to extract a specific color channel from a color image, and view
it as an 8-bit Gray Scale image.  You might do this to reduce the saturation values in a
HSI image, or boost just the Blue values in an RGB image.

Use the Merge command to merge an active, Gray Scale image into a True Color image. 
This is usually done to return a channel, extracted with the Extract Channel command, to
an image after the channel data have been manipulated.  However, you might use it to
merge any Gray Scale image to a color channel in a True Color image.

Dye/Tint Images
The Dye/Tint feature lets you apply a color to your image(s) that corresponds to the emis-
sion color of your dye. If you are using color to explore the intensity distribution of your
image, please refer to the Pseudo Color feature later in this manual and in the in-product
Help. Click on the drop-down arrow to see the Dye/Tint dialog:
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Check the Tint Image On/Off box to show or hide the tint on your image.

Check Add to Color Composite to automatically add your tinted image to the color com-
posite image.

The Dye drop-down list displays a list of your current set of favorite dyes. You may select
a different dye from the drop-down list, and all the remaining controls will be updated to
show the characteristics of the new dye. If the dyes you want are not in the current set,

click the settings button to display the Dye Editor dialog, where you can view a com-
plete list of the available dyes. Here you can add select a new favorite dye, add a dye to
the list, or delete old ones.

The Emission Wavelength drop-down displays the emission wavelength for the dye you
have chosen. You can adjust the emission wavelength by clicking on the spectrum or enter-
ing a new value. The default Tint Color will change in response to changes in the emis-
sion wavelength.

The Tint Color box lets you choose a color to indicate a particular dye. Here you can
change the color associated with the selected dye, or define a custom color. The default
color is linked to the emission wavelength. When you change the emission wavelength,
the tint color and hue change. The default Tint Color can be adjusted to a different hue by
using the Hue slider or by entering a new Hue value. A completely custom Tint Color
can be selected by clicking the down-arrow next to the Tint Color box, and selecting a
standard or custom color.

The Emission Wavelength and Hue override a custom Tint Color, so to set a custom
color, you should first set the wavelength, and then set the color using either the Hue con-
trols or the Tint Color.

Click Apply to add your dye or tint color to the active image.

Using Color Composite
Color composite is a common operation for merging individual fluorescent images. For a
variety of reasons it is not always possible to acquire the images simultaneously, so image
processing tools are necessary to present a complete and accurate qualitative picture. The
Color Composite View is used primarily to merge and register fluorescent images acquired
as monochrome single wavelengths into a color composite image.

Use Color Composite to create and configure color composites using black and white
source images. You can access the Color Composite dialog box through the Color group
on the Adjust tab.
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You can combine grayscale images into a color composite. Any group of grayscale images
that are of the same size can be mixed in a color composite. Images of 8-, 12-, 16-bit
integer or floating point format are combined into a 24-bit color composite. Each input
channel will have individual LUT adjustments, as well as a registration offset to line it up
with the rest of the images. You can also combine individual channels from a single
image. Each channel will be listed separately.

To create a color composite, follow the steps below.

1. Open the images that you want to combine. In this example, we are using the Blue_
DAPI_10.tif, Green_FITC_10.tif, and Red_TRITC_ 10.tif.

2. Click the drop-down arrow in the Composite area in the Color Group on the Adjust
tab.

3. Select Add AllImages from the drop-down menu.

The three demo images are combined into a single color image in the
Image-Pro workspace:
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The three original images and the combined image appear as thumbnails in the image
strip on the left side of the workspace.

The color composite dialog on the right side of the workspace contains information
about each image. Each of the original images represents a single channel in the com-
posite image:

Detailed information about each color channels can be displayed by clicking on the +
sign to expand the image information. You can make changes to the image inform-
ation, change the color display, or remove one image/channel entirely.

1. Click the eye button to show, blink, or hide the composite images, as shown here:
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You can save your composite image as a single image or as an image set.

2. To save your composite, click the Apply button:

3. To save the composite as an image set, click the drop-down arrow and select image
set:

You will see the Save Image as Set dialog.

4. Click Save to save the composite as a *.mcs set.
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Pseudo-Coloring an Image

Use the Pseudo-Color command to “colorize” an active monochrome (Gray Scale 8, Gray
Scale 12, Gray Scale 16, or Floating Point) image.  You might do this to highlight cer-
tain features in a gray scale image.  For example, you might want to display all densities
above a certain point in red, or, if your imaging device recorded thermal information, all
temperatures below a certain point in blue. 

You might also use it to visually amplify specific intensities that are very difficult to dis-
tinguish from their surroundings.  For example, features produced by pixels with values of
122 in a field of pixels with similar values would be impossible to see in a gray tone
image, but would jump out if that value were to be rendered in color.

When you pseudo-color a monochrome image, you build a special palette through which
your monochrome image is displayed.  Pseudo-coloring an image does not modify the
pixel values in your image bitmap in any way (it does not convert your image to True
Color or Palette, for example).  It simply associates a pseudo-color palette with the image,
that interprets the gray-level values in the image as color. 

Pseudo-colored images are very similar in structure to Palette class images, but they differ
in a couple of important ways.  First, the pixel values in a pseudo-colored image actually
represent continuous-tone intensity information, whereas a Palette image's pixels carries no
intensity significance.  Secondly, a Palette image includes a palette table that is actually
part of the image file. 

The pseudo-color palette associated with a pseudo-colored image is not a permanent part
of the image.  It is a palette that you assign to the image while you work with it in Image-
Pro.  Pseudo-color palettes can be saved to a disk file, and later loaded for subsequent use
with any monochrome (Gray Scale 8, Gray Scale 12, Gray Scale 16, or Floating Point)
image.

The basic steps involved in pseudo-coloring the active, monochrome image are to:

1. Select the Pseudo button from the Color group on the Adjust ribbon:

2. Click the drop-down arrow to see the Pseudo-color dialog:
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3. Check the Pseudocolor On/Off to show (or hide) the pseudo-coloring on the image.

4. Change the color assignments and refine the intensity division widths.  This is done
using the Spectrum and Type drop-down menus or the color bar.

The Spectrum drop-down list lets you choose which colors will be used for coloring
the images. Choices include Blue to Red, Red to Blue, Cyan, Magenta, and Yellow.
You can also define a custom color spectrum.

Type lets you choose RGB, HSI CW, HSI CWW, or a custom type.

5. Specify the range of intensities you want to pseudo-color.  The intensity range is spe-
cified using the  Start and End spin buttons.  You can load saved pseudo-color set-
tings using the Load button.

6. Specify the number of distinct colors you want to associate with the selected intens-
ity range.  The number of colors is selected using the Divisions spin buttons.

7. Indicate the number of spins. If you want the spectrum to repeat over the intensity
range of the image, you can set the Spins to the number of times to repeat the spec-
trum.

8. Save the settings for future use (with the current image, or with another).  This step is
optional.  You do not need to save the pseudo-color assignments in order for them to
be applied to the active image. If, however, you want to save it for continuing use or
to exchange with a colleague, you need to save it. When you click the Save button,
Image-Pro saves the current pseudo-color palette settings.
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Adjusting Color Channels

To adjust the color channels, or load a saved Look-Up Table (LUT) use the  Display
group on the Adjust ribbon.

This feature contains the following tools:

1. Click the drop-down menu arrow.

2. Select the channel you want to adjust. The default is All channels.

3. Click the Advanced button.

You will see the Advanced tools ribbon:

This tab contains all the features you may need to make and view changes to the
Lookup Table.

As you make changes to the LUT, you will see them reflected in the LUT profile
graph at the bottom of the workspace:
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Note: You will not get a dynamic LUT profile graph for *.AVI and *.SEQ files unless you
select an active frame.

If you are working with a black and white image, you can adjust the black and white
levels by using the BL: and WL: spin buttons, or typing new values in those fields.

Changing the Display Range
The Display Range is the range of image intensities between the low and high values
(inclusive) of the black and white levels.  This feature allows you to improve the visu-
alization of objects of interest in your images by:

l Excluding irrelevant image data

l Boosting the contrast between relevant intensities.

For example, the intensity values of an 8-bit gray scale image can range from zero to 255,
and often the useful data covers only a small portion of that range.

With the Display Range feature, you can set high and low thresholds for intensity values
such that all pixel intensities below the low level display as black and all pixel intensities
above the high level display as white. Image-Pro scales all intensities within the active
image to take advantage of the range of black and white values available on your monitor.

Display range enhancements are implemented through a Lookup Table rather than by
modifying the image bitmap. The original appearance of your image can be restored at
any time.  If you want to make the enhancements permanent, you must write them to the
image with the Apply Display to Image button..
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To change the display range for an image:

1. Select the Display group in the Adjust ribbon.

2. Click the Best Fit button to find the best display range automatically. You can use the
BL and WL spin buttons to make further adjustments to the display range.

Adjusting Brightness, Contrast, and Gamma

The brightness, contrast, and gamma controls provide three ways to adjust pixel intensities
in order to enhance objects of interest in the image.  They allow you to adjust the display
of image intensities between the black and white levels.

To adjust brightness, contrast, or gamma:

1. Click on the Display group in the Adjust tab’s ribbon:

As you move the sliders, the image in the workspace displays the changes in intensity.

2. Use your cursor to select the color channel that you want to adjust.

Brightness:  Increases/decreases all intensity
values uniformly.  In the example below, brightness has been increased from the ori-
ginal.

OriginalAfter Brightness Increased
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Contrast:  Increases/decreases high and low
intensity values reciprocally (that is, as the high values are increased, the cor-
responding low values are decreased, and vice versa).  In the example below, contrast
has been increased from the original.

OriginalAfter Contrast Increased

Gamma:  Adjusts the contrast for the high and
low intensity ranges simultaneously.  In the example below, gamma has been
decreased from the original.

OriginalAfter Gamma Decreased

Resetting the Image

Because the enhancement features (Equalize, Contrast Enhancement, Display Range, and
Invert Contrast) are implemented through a Lookup Table, the changes made to the appear-
ance of your images are not permanent.  You can restore the image to its original appear-
ance at any time.  To do this:

n Click the ResetDisplay button from the Channels group.

The Lookup Table is reset and the image appears as it did before any enhancement options
were defined.

Making Enhancements Permanent

Because the enhancement features (Equalize, Contrast Enhancement, Display Range, and
Invert Contrast) are implemented through a Lookup Table, the changes made to the appear-
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ance of your images are not permanent.  This means they will not be saved with the image. 
To make the enhancements permanent:

n Click the Apply Display to Image button.

All Lookup Table values are permanently applied to the image and the Lookup Table is
reset to its default state.
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Comparing Images

The image comparison feature enables you to compare two images that may have changed
over time. You will find the Image Compare feature in the Compare group on the Cap-
ture ribbon.

To use Image Compare, follow these steps:

1. Open the two images that you want to compare.

2. Go to the Compare group on the Capture or Home tab’s ribbon.

3. Click the Image Compare tool. You will see the Comparison tools ribbon.

4. Click the Add button to add images to the view.

5. Use the tools in the Align group to adjust the position of your images.

6. Use the Parameters and Options groups to make changes to the transparency, back-
group, and other characteristics.

7. Click Apply A new image will be created from the comparison of the two selected
images.

193



Chapter 4

The darker areas  indicate where the image has changed.

The results appear in a combined image.
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Correcting the Background

Use the Background Correction command to make adjustments to the background of your
image.  This tool is used to better distinguish image background from image objects, mak-
ing it easier to extract the objects during a counting or measurement operation.  The Back-
ground Correction command can correct uneven background intensities, and compensate
for irregularities due to uneven lighting, nonuniform camera response or minor optic
imperfections.  It might be used to remove evidence of dust on the lens, or to correct for
bright spots caused by the light beneath the microscope's stage.

Two types of background correction are provided by Image-Pro: 

l Background Subtraction should be used for all images except those of transmitted
light experiments which will be used to measure optical density. 

l Background Correctionshould be used for optical density applications, as it accounts
for the fact that optical density is not a linear function of the gray scale.

Image-Pro provides several tools that allow you to adjust the background of your image.
They appear in the Background group on the Process ribbon:

The Options allow you to create a new image from the background image.

Extract background image displays the background image during black and white Cal-
culation.

To use the Background Subtraction command, follow  these steps:

1. Open the image that you want to correct.

2. Click the Subtract drop-down arrow .

You will see the following dialog:
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3. Choose a dark or light background to subtract.

The subtracted background will appear in the workspace.

You may also use the browse button to choose a saved image to work with; or create
a background image from existing points in the active image.

To use the Background Correction command, follow  these steps:

1. Open the image that you want to correct.

2. Click the Correct drop-down arrow .

You will see the following dialog:

3. Choose a dark or light background for correction, and indicate the feature width or
black level. Your corrected image will appear in the workspace.

You may also use the browse button to choose a saved image to work with; or create
a background image from existing points in the active image.
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Applying Filters

Image-Pro filters are used to emphasize features of an image. The instructions below
demonstrate how to apply the Sharpen filter to accentuate the edges in the castiron.-
tif image. 

1. Open the rice.tif image in the Image-Pro workspace, as described earlier in this
chapter.

2. Select the Filters group on the Process tab’s ribbon:

3. Choose the Sharpen filter from the drop-down list of available 2D filters.

4. Select Sharpen 50% from the pop-out menu:
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The filter is automatically applied to the image.

Advanced Filters
The Sharpen and Blur filters are only two of the 2D filters available in
Image-Pro. To see the complete set of available filters, click the arrow for the drop-down
menu:

1. Click the radio button next to one of the filters.

2. Click Preview to see how it will look on a sample portion of your image.

You may try this with different filters to see the various effects. The sample area
appears in the center of the image.
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You can also preview the filter in a strip. Cleck the box filter strip box in the drop-
down menu:

The filter strip shows how the image will appear after sucessive numbers of passes:

3. Click Apply to apply the filter to the whole image. To save your filtered image as a
new image, check the New Image box.
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Filtering with Fast Fourier Transforms

The FFT command transforms an image into a frequency spectrum.  Image noise appears as
a repetitive pattern which is difficult to remove using standard spatial-filtering tools.  The
FFT tool is especially designed to isolate and filter this noise, then transform and edit the
noise pattern out of the image in easy steps. 

1. Load the Fftprint.tif file from the Fast Founier Transform folder.

The Fftprint.tif image window appears.  Notice the strong diagonal noise pat-
terns.

1. Go to the Process tab.

2. Choose the FFT group.

3. From the drop-down menu, choose Remove Periodic Noise.
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A copy of the original image with the noise removed appears in the workspace.

Image with noise Image with noise removed

Viewing the Image Spectrum
1. To transform the image to its frequency spectrum, click the Forward button in the

FFT drop-down menu.

This process may take a few moments. When the transformation process is complete,
the fftprint-fft.tif containing the spectrum appears in the workspace.
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The spectrum appears as a centered cloud of points, with 4 bright points outside of the
central point.  These 4 points represent the pattern noise you see in the image.

To eliminate the anomalous frequencies (the 4 outside bright points) you can defining
an AOI around them and cutt the frequencies from the spectrum.

1. From the FFT Filter Options dialog, select Spike Cut.

2. Click the Detect Spikes button.

The frequency spikes will be selected in the filtered image:
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3. Click the Apply button.

The frequency spikes will be removed from the image. The majority of the anomalous
frequencies have now been removed from the image.

4. To return the image to spatial form, without the noise, select New Image from the
Inverse drop-down menu:

A copy of the original image, without the noise, appears in the workspace.
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Image Sequences

Image-Pro allows you to open and navigate multi-frame images saved in the
.seq format. The sequence viewer is automatically used for images that have
more than one frame. The image sequence tools appear in the Combine group on
the Process tab’s menu:

To see the image sequence tools, click the drop-down arrow under Subsample:

Merge Frames merges the frames in all selected images into a sequence.

Subsample creates a subsampled sequence of selected images.

n The Interval control defines the sub-sampling frequency. The active frame range of the
sequence is used; the operation always starts from the first frame in the active frame
range. When Interval is less than 1, the input sequence will be oversampled.

n Offset defines the position of the first frame of subsampled sequence.
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Note that all sequence operations work with selected images. Multiple images can be selec-
ted in image strip using <Ctrl> or <Shift> clicks. If no multiple images are selected, the
active image sequence is used for processing.

Difference calculates frame-to-frame difference in selected images. The Options define how
the last or first frames will be processed:

Wrap Around calculates the last frame as the difference between the last and first
frames

Diff only return only difference frames (result will be one frame shorter than the ori-
ginal)

Pad First pad the result with first frame of no difference

Pad Last pad the result with a last frame of no difference

Normalize normalizes frame intensities on the whole sequence. The function uses the act-
ive frame as the reference and scales intensities on all other frames to match the mean
intensity of the reference frame. If the image contains ROIs, the sequence is normalized by
intensities within ROIs. The function can be used to normalize frame intensities on Z
stacks before segmentation (including 3D) and measurements. When the option By Gain
and Offset is active illumination is normalized by Gain and Offset, when the option is off,
only normalization by Gain is used. When the option is On the Gain is calculated based
on standard deviation of the intensity, when off - from the Mean value of histogram.

Average calculates the average of all frames in the selected images.

Sum calculates the sum of all frames in the selected images. Note that the output image
will be a floating point type with the number of channels corresponding to the source
image.

Maximum creates maximum intensity projection of all frames.

Minimum creates minimum intensity projection of all frames.

Motion Detect operation will detect only moving objects and extract them to new image,
then this image can be used with tracking. There are 3 methods: Average Global, Aver-
age Running and Median Running. The operation subtracts filtered image from original,
so all static objects get invisible and only moving objects get detected.

The Size parameter is used with Running algorithms and defines the number of neigh-
boring frames that are used in filtration. When using Median, the size has to be bigger
than the movement of the object through the given number of frames, basically the object
has to cross any point for the given number of frames. For small and fast objects this value
can be small, for big and slow the value should be bigger.
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Flip to XZ: Flips sequence to XZ plane, so the new sequence will have Y axis cor-
responded to Z axis of the original sequence.

Flip to ZY: Flips sequence to ZY plane, so the new sequence will have X axis cor-
responded to Z axis of the original sequence.

The last selected operation will be set as default for Sequence operations button:

The sequence viewer is automatically used for images that have more than one
frame. The sequence viewer has an on-screen toolbar, which appears only when
you move your mouse over the image. The example below shows the sequence
toolbar superimposed on the bottom of the image:

The toolbar becomes less transparent (more opaque) when the mouse is over the
toolbar:

The toolbar has the following buttons:

207



Chapter 4

Go to first frame

Go back one frame

Play sequence backward

Play sequence forward

Go forward one frame

Go to last frame

Use active range applies filters and other Calculation to the active range of
frames (on) or to the individual active frame only (off).

The playback options button opens the following options dialog:

Click Set Start or Set End to set the current frame as start or end of the active
playback range of the sequence. By default the range is set to all frames.

The Rate control defines the playback speed in frames per second.

Loop combo-box determines the action taken during playback when the end or
beginning of the sequence frame range is passed. Choose one of the following
options:

Use this button to click and drag the sequence toolbar
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Click this button to move the toolbar to the area above the status bar.

Clicking the button will move the toolbar back to the image.

This button also displays the Advanced Sequence Control toolbar.

This version of the toolbar contains all the functions of the smaller version and displays
the frame numbers also.

You can also use <Ctrl>+<mouse click> and <Shift>+<mouse click> to select active
frames for processing.

209



Chapter 4

Using the Active Data Overlay

The Active Data Overlay, also known as a heads-up display, is a method of displaying
changing numeric and graphic  information over the active image so that you don’t need
to shift your eyes away from the primary view. The term, “heads-up display” was coined to
describe information displayed on windshields, camera view-finders, medical imaging sys-
tems, video games, and other presentations where it would be inadvisable if not dangerous
to distract the operator from the primary view.

To try out the active data overlay, follow these steps:

1. Open an image sequence in the Image-Proworkspace. Our example will use car-
crash.seq.

2. Go to the Data Overlay group on the View ribbon:

3. Click the drop-down arrow under the Show button:
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When you click Show, the data overlay will appear on the active image. In this
example, the overlay data appear on the upper and lower left sides of the active image.
A calibration marker appears at the lower right.

As you play the sequence, the overlay information updates the frame number and time
information.

4. (Optional) Clicking Marker will turn the calibration marker at the lower right of the
image on or off.

Marker Options let you adjust the position and appearance of the calibration marker:
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5. Click Convert to Annotation to convert the data overlay  to an annotation that can be
saved with the image.

Customizing the Data Overlay
Click the Customize button to see the Data Overlay Options panel. Here you will
find tools to display and adjust their location and style of the overlays.

All of the properties can be expanded by clicking on the + sign at the left.

To show or hide an item in the overlay, click the button  in the Show column. The
button will turn yellow when the item and its sub-items are visible in the overlay.
Hold down the <Ctrl> button when you click to prevent toggling of the sub-items.
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The item location can be adjusted by clicking the Location button.

The Location drop-down menu  contains predefined locations (Top Left, Top Right,

Bottom Left, Bottom Right). You an create new locations using the Add button
and defining a name and  an  icon for the new location.

You can adjust the alignment of the location (Left or Right, Top or Bottom). Note that
alignment of predefined locations cannot be changed and they cannot be deleted. Off-
set defines the space between window border and location anchor. Width of both
columns (Title and Value) are defined in percents of window width.

Display style is adjusted using the Display style button

You can modify font, shadow and opacity in this dialog. Note that all changes are
applied to the current item and all its sub-items,  as with the Show button..

213



Chapter 4

The layout and attributes of the overlays are saved between sessions. These settings 

also can be saved and loaded using the Save and Load buttons.

Clicking the Reset button loads defaults.

The format of numbers and dates can be set on the Display page of the Application
Options, in the Formats group:

A note about measurement overlays: If you are making measurements on a Preview
image, and copying these measurements in an overlay to the captured image, you will see
the Live Preview Measurement Copy Warning if the captured image is a different size or
resolution than the previewed image.
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Using Live Extended Depth of Field

Live Extended Depth of Field(EDF) allows you to create real-time EDF images using a
microscope with a manual focus control. It also supports stereo microscopes, where chan-
ging the focus position shifts the image.

1. To use Live EDF, go to the Capture tab. You will see the Live EDF group:

The Run button will be enabled only when a live preview or image sequence is act-
ive. Clicking the button will start the EDF acquisition on a live image. live EDF pro-
cess is active the button background turns orange and the text changes to Stop.

Clicking the button again will stop live EDF. If the active image is a sequence the
text changes to Run and clicking the button will execute an EDF acquisition on all
frames of the sequence.

2. Clicking the drop-down arrow displays the Live EDF options:

3. Click the Run button to start the Live EDF acquisition

4. Check the Auto Align (Stereo) option to enable auto align for every acquired frame.
Use this option on stereo microscopes where changing the focus position shifts the
image.
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When the Accumulate option is on every new live image is added to the com-
position. This option is preferable for Local contrast composition. In other modes you
can switch this option off and add images to a composite manually by clicking the

Add button.

5. Composition Mode: Make a selection from the pull-down combo box of composition
options:

n Local contrast: Choose this option for real time EDF using the Local Contrast
algorithm.  This is most useful for high contrast brightfield images.

n Maximum: Choose this option for real-time EDF using the maximum composition
mode for  sample imaging on a dark background. For example, imaging of fluor-
escent samples.

n Minimum: Choose the minimum composition mode for transparent mode illu-
mination of  brightfield images

n Difference: Illustrates the difference between the base image and the current image
(image with a grey background)

n AbsDifference: Shows the absolute difference between the base image and the cur-
rent image. Background is black, but you can also activate Pseudo-color on gray
images, so you that can see changing objects in color on a black background.

6. Click the Options… button to see the Live EDF Options dialog:
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Stereo Alignment:

n Alignment area width/height: Indicate width and height of the size of the area in
the middle of the image, which is used for stereo alignment of images in EDF. If
the images have alittle texture the area can be extended to achieve better cor-
relation

n Align by Previous: This option defines the alignment method, which is used with
Auto Align (Stereo) mode. When the option is on, the new image is aligned by
the last added to image, then the option is off, the start image is used to align all
following images.

Blending:

n Defocusing diameter defines the size of the filter that detects in-focus areas on the
image. The default value is 6.

n Plane blending sets the size of the blending area between in-focus zones from dif-
ferent planes. The default value is 4.

Output Window Position
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n Side by side:When this option is on, the workspace is split into 2 panes, where
the live preview window is on the left and the output window is on the right. 

Task

n Run in background thread:When the option is on, the Live EDF is started in a
separate thread. This option should be used with multi-core processors, so Live
EDF will run in parallel to the live preview and not slow down preview frame
rate.

Reset

n Click this button to reset the Live EDF settings to the default selections.

7. Click the Reset button to restore the defaults for all options.

A sample dual-viewed, real-time EDF composite image is shown here:
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Using Live Tiling

The Live Tiling module for Image-Pro makes it easy to acquire a large tiled image without
an automated microscope stage.

1. To use Live Tiling, go to the Capture tab on the Image-Pro ribbon. You will see the
Live Tiling group:

2. The Run button will be enabled only when a live preview or image sequence is act-
ive. Click the button tostart tiling on a live image. When the Live Tiling process is
active, the button background turns orange and the text changes to Stop.

3. Click the button again to stop Live Tiling. If the active image is a sequence the text
changes to Run and clicking the button will will tile all the image frames in the
sequence.

4. Click the drop-down arrow to display the Live Tiling options:

5. Click the Run button to start or stop the Live Tiling.

To start the tiling procedure, move the microscope to the area of the specimen where
you want to start tiling and click theRunbutton. When you click Runthe current image
becomes the starting point for the tiled image. Yellow rectangles will show you the
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outline of the original frame when you move objects under the microscope. The tiling
uses cross-correlation to find the image shift. Use objects with texture for tiling. Note
that empty fields cannot be aligned correctly automatically. When you see that the yel-
low frame follows the image correctly, you can start tiling. Note that the maximum
image shift between slices cannot exceed 25-40%.

n Motion Detection:Motion blur is a common problem with capturing images of
moving objects. This problem can be eliminated by activating the Motion detec-
tion option. Activating this option is recommended for long exposure times.
When this option is active, a new tile in auto-tiling mode will be added only
when the camera is still.

n Use EDF Adding Tiles: If the image contains out-of-focus areas, use the Use EDF
Adding Tiles option. When this option is on, every new tile is added using the
EDF algorithm.The borders of the EDF image are blended with BlendingWidth
(see Tiling Options).When the option isoff, the tiles are added with full overlap
blending. The option can be activated temporary to merge several focus planes
adding tiles using the Add button.

n Auto EDF: When the Auto EDF option is on, the new images are added to the
output constantly and clicking the Add button is not necessary. You can simply
adjust the focus, and during the adjustment the EDF image will be created. EDF
images are not added when the stage is moving.

n Show Crop ROI: Shows the outline of any ROI on the image.

n Set New Position: Use this button if, in the middle of creating a tiled output, you
want to continue from another side of the tiled image. Clicking the button will
activate the position selection mode, where you must click on the output image
where you  want to continue tiling. You will see the following message;

n Correct Background: If the microscope has uneven illumination, it can be cor-
rected using this option. Use the empty area on slide as the background, move the
slide under microscope, and click the Set backgroundImage button.
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n Background Color: This option is used for empty areas outside the tiles on an out-
put image. Clicking the Pick from Image button will activate the color picking
tool, which you can use to select a color for the image.

n The easiest way of tiling is with the Auto tiling option. In that case the
images will be added to the output automatically when the image shift exceeds
25% (whenan  internal yellow rectangle touches the image border). Move the
stage slowly, and the images will be acquired and tiled automatically.

6. Move the object by 30-35% from the original position (when the inner rectangle will
touch image border) and stop the stage. The image will be automatically captured
when the object will stay still for 2 frames. It will eliminate motion blur and improve
the quality of tiled image.

7. Repeat step 2 (move-stop) until whole area is tiled.

The tiles can be also added manually using the Add button. If the tiled position is
not correct you can use the Undo button to remove the last tile and try other location.
Note that if you use Auto tiling the Add button will be switched off.

8. To use the Add feature, click Undo and move microscope to the location when
correlation is stable. Then activate Auto tiling option again.

9. When the tiling is done, click the Stop button. It will stop the output and any blank
areas will be filled with the background color.

10. Click the Options… button to open the  Live Tiling Options dialog:
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n Tiling Undo depth: This option defines the number of undo buffers.

n MatchingThreshold: Use the matching threshold for new images. The matching
threshold is within 0...1 range, and the default value is 0.25. If the image cor-
relation is below the threshold, the tile is not automatically added, although it can
be added using the Add button.

n Color and Sound. Select the Normal color, Go color, and Error color: These
options define the colors use for the tracking box for normal, active, and error
states. You may also indicate if you want to play a sound when an error is detec-
ted.

n Blending: When the Use blending adding tiles option is on (default) new tiles are
added using gradient blending, so no edges between tiles is visible.

n Info Messages: Check these boxes to see helpful messages when clicking Undo or
Set New Position.

n Output Window Position:Side by side:When this option is on, the workspace is
split into 2 panes, where the live preview window is on the left and the output
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window is on the right. 

n Task: WhenRun in background threadison, the Live Tilingis started in a separate
thread. This option should be used with multi-core processors, so Live Tiling will
run in parallel to Live Preview and not slow down the preview frame rate.

n Reset:Click the Reset button to restore the defaults to all options. Here is an
example of a tiled image:
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Using Regions of Interest

You can define one or more Regions of Interest(ROIs) in a variety of shapes, and you can
control the positioning, size, appearance and display status of ROIs. This chapter provides
step-by-step instructions for defining and working with ROIs to isolate areas of interest in
your images.

224



Chapter 5

The Select Tab

The Select tab’s ribbon contains those functions that allow you to mark up an image with
regions of interest or annotations, and share it with another person or work group.

You can find the ROI feature on the Select tab’s ribbon:

If you are working with Image-Pro with 3D Module, this tab is called 2D Selection.
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What is an ROI?

An ROI is a Regionof Interest that is isolated from the rest of the image. Certain
Image-Pro commands can be constrained by an ROI. Once you have defined an ROI, the
command applies to only the pixels within the ROI.

Examples of commands that are constrained by an ROI are: Save As, Cut, Copy, Duplicate,
Rotate, and Resize. 

For example, in Figure 6-1 below, a square-shaped ROI has been drawn around a particular
object of interest in the image.  When the Duplicate command is applied to the image, the
ROI portion of the image is copied to a new image, as shown in Figure 6-2.

You can also apply a filter to an ROI. Figure 6-3 show an image with an ROI drawn on it,
and a Sharpen filter applied to the area defined by the ROI:

Figure 6-3

More information about applying filters appears in Chapter 5.
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Defining an ROI

Before defining an ROI, be sure the image you want to work with is opened in the Image-
Pro workspace.  To define an ROI in the active image:

1. Go to the ROI group on the Select tab’s ribbon:

2. Click on the ROI tool you want to use. Clicking this button starts the drawing of this
type of ROI. The different ROI tools and types are described below.

Selection Tool: Use this arrow to select an ROI on the image.
Click the drop-down arrow and use the Select All tool to select
more than one ROI.

Rectangle ROI:  This tool allows you to define a rectangular or
square ROI.  Click and drag the mouse from one corner of the
Region of Interest to the opposite corner.  To force a perfect
square, hold down the <Shift> key as you click and drag the
mouse. Click the drop-down arrow to see additional ROI shapes.
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Circle or Ellipse:  This tool allows you to
define a circular or elliptical ROI in the
image. To force a perfect circle, hold down
the <Shift> key as you click and drag the
mouse.

Rectangle by Numbers: This tool allows you to define a rect-
angular ROI by entering the left, right, top, and bottom locations. 

Polygon:  This tool allows you define a
polygon-shaped or freeform ROI in the
image.

To define a freeform ROI

Use this technique to create smooth edges. 
Hold the left mouse down while you draw
with the cursor to create the desired free-
form shape.  Double-click to complete the
shape.

To define a polygon-shaped ROI

Use this technique to create polygons that
are made up of straight line segments. 
Click the left mouse button at each vertex
(including the beginning point) of the
polygon.  Double-click to complete the
polygon.

Auto-Trace. Use this tool to trace the outline of an irregular object in the
image automatically. Place your cursor on the object and click two
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points. Image-Pro automatically traces the object.

Display Options

Use this button to see the Display Options panel.

Delete Selected/Delete All:

Use the buttons to remove one or more of the ROIs from your image.

Multiple ROIs: Click this button to place mutiple ROIs on your image.
This option is always on by default.

Options

Use this button to see some additional ROI options:

Invert ROI: Click this button to invert the ROI; for example, a black
ROI on a white background.

XOR Pixels: Click this button to include or exclude pixels in over-
lapping ROIs. This option is always on by default.

.Order: Use these buttons to arrange your ROIs from back to front, or
front to back.

229



Arranging ROIs

Arranging ROIs

After you have defined an ROI, you can move it, resize it, and delete it.

Moving an ROI
To move an ROI:

1. Click the Selection tool [ ] from the ROI group.

Click on the ROI you want to move. The ROI is selected.

2. Position the cursor over the selected ROI. 

If the cursor is positioned correctly, the Dragging tool [  ] appears.

3. Click and drag the ROI to the desired location.

Resizing an ROI
ROIs can be resized by moving their control points.  To resize an ROI:

1. Click the Selection tool [ ] from the ROI group.

2. Click on the ROI you want to resize.

The selected ROI is selected.

3. Position the cursor over the control point that you want to move. 

If the cursor is positioned correctly, the Resize tool [  or ] appears over the con-
trol point.

4. Click and drag the control point to the desired location.

Using XOR Pixels
Use this feature to examine pixels in overlapping ROIs on your image. To apply a filter
using XOR pixels, follow these steps:

1. Draw two or more ROIs on your image, as shown here:
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Figure 6-4

2. Go to the Adjust tab and select the Filters group. Click the drop-down arrow.

3. Choose a filter from the filters list:

4. Your filter will be applied to the area between the flags on the image.

Figure 6-5
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Rotating an ROI

You can rotate a selected ROI without
rotating the image. The Rotate tools are shown here:

1. Click the Selection tool [ ] from the ROI group.

2. Click on the ROI you want to resize.

The selected ROI is selected.

3. Position the cursor over the center point in the ROI that you want to rotate. You will
see the rotation cursor.

4. Click and drag to rotate the ROI.

Improvements to the ROI controls allow you to rotate the ROI with or without trimming
and place it a new image.  When the Trim box is checked, the rotated size of the ROI is
the same size as the original ROI bounds, which usually requires trimming the rotated
ROI. The icons displayed are:

n Rotate with trim into a new image

n Rotate without trim into a new image.

An example appears here:

The below shows a translucent preview of a -20 degree rotation with the Trim option
unchecked. The green rectangle is the ROI to be rotated.  The red rectangle shows the
rotated ROI.  The yellow rectangle shows the bounds of the new, rotated result image.
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Figure 6-6

The rotated result is shown in the following image. Note that no part of the rotated ROI
has been trimmed off, but as a consequence the new image is larger than the source ROI. 
Also note that areas outside the source ROI are shown as black in the new image.

Figure 6-7
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The next example shows a translucent preview of the same -20 degree rotation with the
Trim option checked.  The green ROI rectangle is not visible here, because the yellow rect-
angle showing the bounds of the new image lies exactly on top of it (this would not be
case if the ROI were a non-rectangle, as in the next example).  The red, cut-off rectangle
shows the rotated ROI with its trim.

Figure 6-8

The rotated result is in the following image. Note that part of the rotated ROI has been
trimmed off in order to keep the new image the same size as the bounds of the source ROI.

Figure 6-9

Deleting an ROI
To delete an ROI:
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1. Click the Selection tool [ ] from the ROI group.

2. Click on the ROI you want to delete.

3. Click the Delete [ ] button or Press the <Delete> key.

Note that you can also use the delete button in the image context menu (click the
right mouse button on the image when an ROI is selected) to delete the selected ROI.

TIP:  You can use the Delete All tool in the ROI group to instantly remove all ROIs
defined in the active image.
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Setting the Appearance of ROIs

These instructions explain how to change the appearance of an existing ROI and how to
set the default appearance attributes for the different ROI types. 

Changing the Appearance of an ROI
Sometimes you might want to change the border or fill color or size of your ROI to make
it easier to see on your image. To change the appearance of an ROI:

1. Click the Selection tool [ ] from the ROI group.

2. Click on the ROI that you want to change.

The ROI is highlighted.

3. Click the Display Options button in the ROI group.

You will see the Display Options dialog box in the panel along the right side of the
workspace.

4. Use the controls available through this dialog box to change the appearance of the
ROI.
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Drawing Properties

Some common controls available for changing the appearance of graphical annotations
are described below. 

n Border: Allows you to change the visibility, color, width, and line style of a bor-
der around your annotation.

n Fill: Allows you to choose the fill color for your annotation, including opacity
and/or transparency.

n Options: These options allow you to change the size of the annotation when the
size of the images changes, adjust the opacity/transparency of the annotation, and
layer annotations on the image. If you are working with an image sequence, you
can specify the first and last frrames where the annotation will appear.

n Color: Click on the Color button to change the color of the bounding box border
or fill, or to change the color of the text. 

n Zoom with Image: Check this box to make the annotation larger or smaller as the
image is resized.

Label Properties

Some common controls available for changing the appearance of label annotations are
described below.

n Text: Click on the Text tab to change the text of the annotation.

n Font : Allows you to change the font to be used for rendering text.

n Size : Allows you to change the font size to be used for rendering text.

n : Allows you to make the text shadowed, bold, italics, under-
lined, or shadowed.

5. When you have made the desired changes, click the ROI Display Options panel.

The changes are applied to the selected ROI.
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Setting the Default Appearance for ROIs
The default appearance attributes for ROIs are set by designating the appearance attributes
of an existing ROI as the default for future ROIs of that type.  Note that defaults exist inde-
pendently for each type of ROI you can draw: rectangle, rounded rectangle, ellipse, poly-
gon, point, and text.  To set the default appearance for an ROI type:

1. Click the Selection tool [ ] from the ROI group.

2. In the active image, click on an ROI of the type for which you want to set appearance
defaults.

For example, if you want to set the default appearance for ellipse-type ROIs, click on
an ellipse-type ROI in the active image.  If one doesn’t exist, draw one.

3. Click the Display Options button in the ROI group.

You will see the Display Options panel along the right side of the workspace.

4. Click Save as Default

The default appearance values are set.  Future ROIs of that type will appear as the
selected ROI.
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Using the Magic Wand

The Magic Wand tool allows you to select regions in an image based on the color of
pixels in the image. You can use it to select irregular regions and convert them into ROIs,
Measurements, or Annotations. The Magic Wand tool appears on the Select tab’s ribbon:

The Magic Wand group includes the following features:

l Options

New Selection. All previous selections will be replaced with a new selection. Hold
down the <Alt> key to temporarily activate this option.

Add Selections. A new selection will be added or merged with any previous selec-
tions. Hold down the <Ctrl> key to temporarily activate this option.

Subtract Selection. A new selection will be subtracted from any previous selec-
tions. Hold down the <Shift> key to temporarily activate this option.

l Magic Wand button

Interpretation (Mono, RGB, HSL or HSI). Converts the image into a different inter-
pretation before thresholding (not available for mono images).

Mono Ranges. Indicates the number of gray levels used for thresholding (combination
of gray ranges depends from type of active image and selected interpretation).

Filtering: Indicates the intensity of any filter to be applied to the selected outline.
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Smoothing. Indicates the degree of post-filtering of the outline (0 – no filtering, 9 –
high degree smoothing).

Fill Holes: Check this box to automatically fill any holes in the outline and include
the hole area in your measurements.

Outline color. Allows you to change the color of the object’s outline using the color
selector.

l Validate button

as ROI. Converts and validates the selections as ROIs.

as Measurement: Converts and validates the selections as measurements.

as Annotations: Converts and validates the selections as annotations.

To use the magic wand, follow these steps:

1. Open an image with irregular areas in the workspace:

2. Select the Magic Wand tool.
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3. Place the wand cursor inside the feature containing the area(s) that you want to trace,
and click the left mouse button once.

The magic wand will automatically trace the outline of the object(s) based on the
color similarities or difference of intensity ranges between the pixel under your cursor,
plus or minus a specified tolerance interval.

Figure 6-10

To outline a different region, place the cursor on that region and click with the left
mouse button. To outline more than one region, hold the <Ctrl> key down while
clicking on the region you want to outline.

4. To save the outline areas as irregular ROIs, click Validate as ROI.

The outline color changes, as shown here:

Figue 6-11

The Regions of Interest group becomes active, and you can now use all the ROI fea-
tures to modify or save this ROI.
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Polygon Nudge Tool

The Polygon Nudge tool allows you to adjust the size and shape of irregular ROIs and
measurements.

The nudging technique for reshaping polygons and polylines allows you to push control
points around, rather than clicking and dragging them. This technique makes it easy to con-
tour curves in curvy polyforms by 'nudging' the control points into place.

To use nudging mode:

1. Enable nudging mode by right-clicking the mouse in the image window, and clicking

on the [ ] tool in the popup context menu.

Initially the nudge tool will be a dashed circle and has no effect on the selected
object.

2. Use the mouse wheel to adjust the size of the nudge tool

The size of the nudge tool determines how many controls points it can nudge at one
time.

3. Press the mouse button and move the nudge tool into the control points you want to
nudge.

Notice that, when you press the mouse button, the circle becomes solid and shows an
arrow tracking the direction of mouse movement, and the nudge follows the direction
of the mouse movement. The nudge tool is designed to operate only at slow speeds.
So by moving quickly, you can skip the tool from one side of a polyline to the other
or from the exterior to interior of a polygon without needing to let up the mouse but-
ton and without disturbing the boundary as it is quickly crossed. This may take some
practice to master, but it is often necessary to nudge from both sides of a poly line sec-
tion to get a boundary placed correctly, so using this technique can speed things up.

Holding down the <Ctrl> key while editing a polygon or polyline temporarily leaves
nudge editing mode to allow you to insert (<Ctrl> double-click) or move (<Ctrl>
drag) a single control point.
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4. To turn nudge mode off, press the space bar.
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Using Annotations

Annotations are used to add text or drawings to your images. The annotations are in a
graphics overlay that is displayed over the image without modifying the image data itself.
This chapter provides instructions for creating text and graphical annotations, arranging
them, and saving them with your images.
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The Select Tab

The Select tab’s ribbon contains those functions that allow you to annote an image and
share it with another person or work group. The functions in this chapter can be found in
the Select ribbon’s Annotate group.

If you are working with Image-Pro with 3D Module, this tab is called 2D Selection.
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Creating an Annotation

Using the tools on the Annotate group, you can draw an array of graphical and textual
annotations.  This section provides instructions for drawing various shapes and for placing
text overlays in images. The Annotate group looks like this:

Creating a Graphical Annotation
There are a number of options for annotating your images with graphical overlays.  You
can define points, lines, rectangles, rounded rectangles, ellipses, polygons, and polylines.

To define a graphical annotation:

1. Click on the Annotate group in the Select tab’s ribbon.

The Annotate group contains these tools:

246



Chapter 6

2. In the toolbar, click on the annotation tool you want to use, and draw the annotation
in the image as described for that tool below.

Select/ Select All

Use this tool to select an annotation object. Click the drop-down arrow to see
the Select All tool to select a group of objects.

Text Box

Use this tool to add a text box annotation. Click the drop-down arrow to add
a text call-out annotation:

You can add a callout line using the callout tool.

Rectangle or Rounded Rectangle

Click the left mouse button and hold it down to drag the rectangle to your
desired size. Use the drop-down arrow to see the rounded rectangle, circle, and
polygon tools.
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Circle or Ellipse

Position the crosshair cursor anywhere in the image.  Use the drop-down arrow
to see the other tools.

Click and drag the mouse from the insertion point to the desired destination. 

Line or Polyline:  This tool allows you draw poly-
vertices lines and polygons, or freehand lines and
shapes.

Note:  Whether this tool draws a polygon or a poly-
line depends on the current setting for the Connect
Start/End option.  To change the status of this
option, simply right-click the mouse over the object
after it is drawn, and select Annotation|Object
Properties….  The Connect Start/End option
appears on the Polygon tab of the Graphic Object
Properties dialog box.

To draw freeform lines and shapes
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Use this technique to create lines and shapes that
have smooth edges.  Hold the left mouse down
while you draw with the cursor to create the
desired freeform shape.  Double-click to complete
the shape.

To draw polyvertices lines and polygons

Use this technique to create lines and shapes that
are made up of straight line segments.  Click the
left mouse button at each vertex (including the
beginning point) of the polygon.  Double-click to
complete the polygon.

Auto-Trace. Use this tool to trace the outline of an irregular object in the
image automatically. Place your cursor on the object and click two points.
Image-Pro automatically traces the object.

Point Position the crosshair cursor in the image where you want to place the
point marker.  Click the mouse to place the point. The drop-down menu for the
point tool displays a wide variety of point and arrow styles.

Delete Selected/Delete All

Use the buttons to remove one or more of the
annotations from your image.

Group/Ungroup

Use these buttons to collect your annotations into a
group or to ungroup them.

Order

Use these buttons to order your annotations front to
back or back to front
Cut, Copy, Paste

Use these tools to cut, copy, or paste annotations.

Properties
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Use this button to see the Display Options information.
Burn In

Click this button to make your annotation a permanent part of the image.

Annotation Shapes

The drop-down menu for the point tool displays a wide variety of point and arrow styles:

You can use your mouse wheel to adjust the size of your annotations.
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Creating a Text Annotation
To create a text annotation:

1. Click on Annotate ….

The Annotate group is displayed.

2. In the toolbar, click on the Text tool [ ].

3. Click and drag the mouse in the image to draw a bounding box for the text. 

When you release the mouse, the Text tab of the Display Options dialog box is dis-
played. An examples appears on the next page.
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4. Type the desired text in the Text tab’s textbox.

5. Click OK.

The specified text appears as an overlay in the image.  For instructions on changing the
font, color, or bounding box attributes of the text annotation, please refer to “Setting the
Appearance of Annotations” later in this chapter.
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Inserting a Bitmap Annotation
To insert a bitmap annotation:

1. Open the desired bitmap image in the Image-Pro workspace, that is, open the bitmap
image you want to use as an annotation.  (See “Opening an Image” in Chapter 4,
“Working with Images.”)

The image appears in the application workspace.

2. Choose Paste Bitmap from the drop-down menu in the Cut, Copy, and Paste group.

3. Right-click the mouse in the image to which you want the bitmap added as an annota-
tion.

4. Click the Paste button [ ].

The bitmap is added as an annotation to the image.  For instructions on moving the bitmap
annotation, please refer to “Moving an Annotation” later in this chapter.
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Arranging Annotations

After you have created a set of annotations, you can move them, resize them, layer them,
and delete them.

Moving an Annotation
To move an annotation:

1. Click Select [ ] from the Annotate group.

2. Click on the annotation you want to move.

The annotation is selected.

3. Position the cursor over the selected annotation. 

If the cursor is positioned correctly, the Dragging tool [ ] appears.

4. Click and drag the annotation to the desired location.

TIP:  You can also move the annotation by pressing the shift key along with the
arrow keys (up/down, right/left).  For example, press the <Shift> and <Up Arrow>
keys and notice the annotation moving upwards.

Rotating an Annotation
Annotations can be rotated by using the Select tool and the <Control> key.

1. Click Select [ ] from the Annotate group.

2. Click on the Annotation you want to rotate.

The Annotation is highlighted.

3. While the Annotation is selected, move your cursor to the center point of the Annota-
tion. The rotate cursor  (a double-ended arrow) will appear, enabling you to rotate the
Annotation either clockwise or counter-clockwise. Holding down the <Shift> key
while rotating an Annotation will move the Annotation in 15-degree increments.

You can also rotate an Annotation while creating or editing it by holding down the
<Control> key as you move the Annotation.
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Resizing/Reshaping an Annotation
Annotations can be resized and reshaped by moving their control points.  To resize or
reshape an annotation:

1. Click Select [ ] from the Annotate group.

2. Click on the Annotation you want to resize or reshape.

The Annotation is highlighted.

3. Position the cursor over the control point that you want to move. 

If the cursor is positioned correctly, the Resize tool [  or ] appears over the con-
trol point.

4. Click and drag the control point to the desired location.

Grouping Annotations
The Annotation feature allows you to group annotations in the image.  Annotations that
are grouped are fixed in positioning relative to each other and they are otherwise treated as
one object.  To group annotations:

1. Click Select [ ] in the Annotate group.

2. While holding the <Ctrl> key down on the keyboard, click on the annotations you
want to include in the group.

For example, annotations #2 and #3 have been selected below.

3. Click on the Group button [ ] on the Annotate panel.

255



 Ordering Annotations

The selected annotations are grouped.

Ordering Annotations
The Annotation feature allows you to control the order in which annotations appear.  To
change the order in which an annotation appears:

1. Click Select [  ] in the Annotate group.

2. Click on the annotation you want to relocate in the order.

For example, annotation #3 has been selected below.

3. Click the Order back to front button in the Annotate group.

The annotations are arranged in the order specified.

Deleting an Annotation
To delete an annotation:

1. Click Select [ ] from the Annotate group.

2. Click on the annotation that you want to delete.

The annotation is highlighted.
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3. Click Delete [ ] from the Annotate group, or press the <Delete> key.
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Setting the Appearance of Annotations

These instructions explain how to change the appearance of an existing annotation and
how to set the default appearance attributes for the different annotation types. 

Changing the Appearance of an Annotation
To change the appearance of an annotation:

1. Click Select [ ] from the Annotate group.

2. Click on the annotation that you want to change.

The annotation is highlighted.

3. Click the Options button in the Annotate group.

You will see the Display Options dialog box in the panel along the right side of the
workspace.
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4. Use the controls available through the Display Options dialog box to change the
appearance of the annotation.

Drawing Properties

Some common controls available for changing the appearance of graphical annotations
are described below. 
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NOTE: For complete descriptions of all available controls, refer to the “Graphic
Object Properties (Dialog Box)” topic of the Image-Pro Application Help system.

n Border: Allows you to change the visibility, color, width, and line style of a bor-
der around your annotation.

n Fill: Allows you to choose the fill color for your annotation, including opacity
and/or transparency.

n Label position: If you are including a label (different from the text box) in your
annotation, you can adjust the position of the label here.

n Callout line: Allows you to show or hide the line attached to a callout box and to
adjust the line thickness and end style.

Label Properties

Some common controls available for changing the appearance of label annotations are
described below.

n Text: Click on the Text tab to change the text of the annotation.

n : Allows you to change the font to be used for rendering text.

n : Allows you to change the font size to be used for rendering text.

n : Allows you to make the text shadowed, bold, italics, under-
lined or in a different color.

n Autosize: Allows you to have the box surrounding the text automatically resized to
fit the text.

n Fill: Controls whether the box surrounding the text appears as opaque or
transparent.  This  attribute does not apply to the text.

n Color: Click on the Color button to change the color of the bounding box border
or fill, or to change the color of the text. 

n Zoom with Image: Check this box to make the annotate larger or smaller as the
image is resized.

Additional Options

Additional display options have been added to Image-Pro:
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n Zoom with image automatically adjusts the size of your annotation as the size of
the image changes.

n Opacity adjusts the transparency of a line or shape as you move the slider.

n Angle lets you specify angle of display for you annotation.

n Layer lets you create overlay layers on your annotation. This can be very useful
when displaying a 3D or Z-stack image.

n Start Frame/End Frame lets you specify on which frames of a sequence the
annotation will appear.

5. The changes are applied to the selected annotation.

Setting the Default Appearance for Annotations
The default appearance attributes for annotations are set by designating the appearance
attributes of an existing annotation as the default for future annotations of that type.  Note
that defaults exist independently for each type of annotation you can draw: rectangle, roun-
ded rectangle, ellipse, polygon, point, and text.  To set the default appearance for an
annotation type:

1. Click Select [ ] from the Annotate group.

2. In the active image, click on an annotation of the type for which you want to set
appearance defaults.

For example, if you want to set the default appearance for ellipse-type annotations,
click on an ellipse-type annotation in the active image.  If one doesn’t exist, draw one.

3. Click the Options button in the Annotate group.
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You will see the Display Options dialog box along the right side of the workspace.

4. Click Save as Default.

The default appearance values are set.  Future annotations of that type will appear as
the selected annotation.

Saving Annotations
When annotations are originally placed on an image, they exist as graphical overlays and
are not part of the image.  If you want them to become part of the image, however, you can
save them with the image.

1. Click Save from the File menu:

2. Answer Yes when the question, “Do you want to save the changes with [image
name]” appears.

The annotations will be saved with the image.
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Note: Annotations can be saved only with TIFF format images.

Note Regarding Zooming Annotations:.  Zoom with image is a per-view overlay display
feature, but burn-in affects all views equally (since it changes the underlying image data). 
Thus, burn-in is always done at 100% zoom.  This will make those graphic objects with
"Zoom with image" off (such as labels) look larger (if the view is zoomed in) or smaller
(if the view iszoomed out) after they are burned in.
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Making Measurements

This chapter describes how to measure, count, and track features in images. 
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Overview of the Measurement Feature

Image-Pro provides tools for measuring features in images.  For example, suppose you
want to know the distance between two points in an image.  Using the Measurement
tools, you can simply draw a line between the two points and acquire an instant distance
measurement. All of these tools are found on the Measure ribbon.

Measurement operations in Image-Pro are performed in terms of image pixel positions. For
example, the length of a line feature is determined by the number of pixels along the line.

Note: If you are running Image-Pro with 3D Module, some of the tab names may appear
as 2D Count/Size or 2D Measure.
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Data Measurements

Image-Pro offers you a variety of measurement types to analyze your images. These appear
in the Measurements group on the Count/Size ribbon as well as on the Measure ribbon:

To select your measurements, follow the steps below.

1. Click the Types drop-down arrow. You will see the Measurements dialog:

2. Using the Add or Add All buttons, select the measurements you want to make.

The Available measurements list contains the measurements that can be grouped by
Measurement type (All Types, Regions, Lines, Points, Best-Fit, Angles) and Meas-
urement Category:

l All Categories

l Basic

l Housekeeping

l Luminance

l Density - Optical density related measurement

l Histogram - A histogram or pixel-counting-based measurement

l Size - Size related measurement

266



Chapter 7

l Position - Position related measurement

l Shape - Feature shape related measurement

l Reference - Measurement relating to a reference feature

l Nesting - Nesting relationship measurement

l Marker - Some marker or landmark measurement

l Holes - Measurement ignores holes

l Texture - A texture-related measurement

l Classified - A classification-related measurement

l Color - A color related measurement

l Manual Measure - Available as one of the Manual Measurements

l Polyline - The measurement is only relevant for lines with more than one segment

l User Defined - The measurement is a user-defined one

l Angle Result - The measurement results are angles (have units of Degrees).

l Uncalibrated Result - The measurement results do not use the Spatial Calibration
or Intensity Calibration (length units are Pixels, area units are Pixels squared and
intensity units are raw pixel luminance values).

Tooltips display additional information about each measurement, as in the example
shown here:

The Selected Measurements list contains the measurements that will be reported in
the data windows (Data Table, Histogram and ObjectWindow). If the checkbox in

the Filter column is active, the measurement will be used as filter and only the
objects with parameters within the defined limits will be counted. Additionally the fil-
ter limits can be set in the Histogram window, in the Measurement filter pane.

Note that the measurement filters are applied only when the Ranges button is
checked:
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Edit Ranges

Adjusting filter ranges interactively can be done using the Edit Range button:

Min and Max filter values can be adjusted by dragging the corresponding markers on
the histogram or editing their numerical values. The mask of objects in range is shown
on the active image. The number of objects in range/total objects and percentage are
shown below the histogram.

Measurement Options

The Options button shows the measurements appearance options panel.

The first section contains the Segmentation options:
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Connectivity, either 8-connected or 4-connected, defines the number of pixel neigh-
bors segmenting the objects.

CleanBorders specifies if the objects touching the selected borders will be eliminated
from the result.

Fill Holes option indicates if the holes inside objects should be included into the
object area.

Smoothing defines the degree of smoothing of used for the object outlines. The default
is zero when no smoothing is applied.

Segmentation bias automatically adjusts the calculated threshold values by the given
bias value. More about segmentation bias appears later in this chapter.

Grow defines the size increment (in pixels) of segmented objects that is applied after a
Count operation using dilation or erosion of the segmented regions. More about grow-
ing or shrinking appears later in this chapter.

Auto Threshold allows you to define the method that is used to segment objects in
Auto Bright/Dark segmentation modes. More about Auto-Threshold appears later in
this chapter.
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Load and Save buttons load and save threshold segmentation options. These
buttons can be used to save and then restore counting environment in a new session.
Record enables you to save your segmentation as a sequence or movie. Reset changes
your settings back to their default state.
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Manual Measurement Tools

This section describes how to use the measurement tools and view your measurement data.
These tools appear on the Measure ribbon:

Selection Tools

These tools allow you to select, hide, or show objects and measurements:

Clicking the Select Object button activates the selection tool. You can select measurement
objects on the image and edit them. Additionally, when one or more objects are selected, a
semi-transparent floating bar will appear on the image that allows you to perform some
operations more conveniently (delete, hide, show, create relative measurements, calibrate).

The Select All tool lets you select all the measurements at once:
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The Show button and its menu allow you to toggle hide or show the overlay and selected
features on the image display. It also allows you to unlock the counted objects.

All objects created by a Count operation are locked by default and cannot be moved or
adjusted. Clicking the Unlock objects button will unlock counted features and enable you
to move or edit some of the objects.

Direct Measurements

This panel contains a “toolbox” of measuring instruments. These tools should be sufficient
to take most measurements.

Manual Tag
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Clicking this button activates the manual tag tool

Line

Activates the line tool, where you can draw a line by clicking and
dragging. A activating any of the measurements from the drop-down
makes it the default for the main button. Clicking the drop-down
arrow displays additional line tools:

Point to point

Activates point to point tool. A line feature will be created after two
clicks.

Polyline

Activates the polygonal line tool. As you click, new points will be
added to the line. (You can stop adding points by double-click and
by pressing the Enter button; pressing the Esc button cancels the line
creation.) There is also an option to auto-trace the polyline.

Auto-trace Polyline activates the auto-trace polyline.

Pitch with line

Activates pitch with line tool. First two points define the reference
line and every next point adds a perpendicular line from the point to
the reference line. (You can stop adding points by double-click and
by hitting the <Enter> button). The drop-down menu contains the
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Show base line option, which turns the base line (first 2 points)
of the pitch group on or off.

Circleor Ellipse

Activates the Circle tool, where you can create a circle by clicking
and dragging a rectangular area with the inscribed circle. Clicking the
drop-down arrow displays the Ellipse and other circle tools.

Ellipse

Activates the Ellipse tool, where you can create an ellipse by clicking
and dragging a rectangular area with the inscribed ellipse. There are
the following options for creating circles:

Radial drawing– center and radius (only for circles) or

Box drawing - box diagonal points (for circles and ellipses).

Find circle – activates Snap to Circle mode (see Snap to Image).

Polygon

Activates the Polygon tool, where you can create an n-sided polygon
by clicking n times. Clicking the drop-down arrow displays the Rect-

angle and Auto-Trace Rectangle tools.

Angle (joined)

Activates angle tool, where you can create an angle measurements
adding 3 points to the image. The angle range is defined in the drop-
down menu :
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Edge Measurements

In most cases, manual measurements are done measuring the distances from one edge of
object to another. Locating object edges manually is tedious work and the resulting meas-
urements may have subjective factors.  The Snap to Edge feature locates image edges
within a cursor neighborhood automatically, and either moves the cursor to the calculated
position or snaps the measurement features to the calculated position. It provides greater
measurement accuracy, reduces the chance of subjective errors, and generally makes taking
measurements easier.

When you select the Snap to Edge tool on the Measurements ribbon, you will see the fol-
lowing dialog:

There are a number of methods available to making the edge measurements:

Snap to straight edge

The closest straight edge is located within the cursor area defined by
a radius. If the mouse stays still for a short interval (default is 0.4 sec),
the cursor moves to the calculated position. This method is available
with all manual measurement tools.
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Snap to any edge

The closest edge is located within the cursor area defined by a radius.
The option can be used on small objects or on objects with curved
outlines. If the mouse stays still for a short interval, the cursor moves
to the calculated position. This method is available with all manual
measurement tools.

Adjust line length

The measurement feature is snapped to the sharpest rising and falling
edges underneath the line. This tool can be used when the object is
brighter or darker than background and there are no holes or other
sharp edges in the middle of the object. The Width control defines
the width of the caliper line and Length is the matched length of the
edge detector. This method is available with the Line and Point to
Point measurement tools

Adjust line ends

The created line is snapped to the object’s edges along the line. The
line ends are also adjusted by edges. The width of the snap area is
defined by a radius. The Width control defines the width of the cal-
iper line and Length is the matched length of the edge detector. On
noisy images Width can be set to higher values to smooth the profile
averaging pixels in perpendicular to the line direction (default is 3). 
This method is available with the LineandPoint to Point meas-
urement tools.
If Adjust line length or Adjust line ends option is active a line is
drawn on image using Line or Point to Point tools will be auto-
matically snapped to the object’s edges as soon as it’s created using
the caliper functionality.

Adjust along edge

The created line is snapped to the object’s edges in the neighborhood
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of the line ends. The area length is defined by a radius. The Width
control defines the width of the caliper line and Length is the
matched length of the edge detector. The Length defines how sharp
the detected edge can be. Low values (3 to 7) are recommended for
high contrast images with uneven intensity of objects. If objects have
even illumination and they are relatively wide, Length can be
increased smoothing noise along the line. This method is available
with the Line and Point to Point measurement tools.

Find circle

Finds a circle within the radius from the click position. Click inside
the circular object and the position and radius will be calculated auto-
matically, analyzing the object edges in the neighborhood.
This method is available with the Circle measurement tool.
The template button activates the mode, which can be used to create
measurement templates. When Template mode is active the Snap
functionality is not applied immediately after creating the line fea-

tures, but only when you click the Auto Adjust button. Only
Adjust line ends, Adjust along edge and Find circle can be used in
Template mode.

Best-fit measurements

Best-fit measurements can be used to create features from a number of manually placed
points.

Best-fit Circle

The Best-fit Circle tool allows you to add points to the image and a
best-fit circle will be generated. Stop adding points by double-click-
ing or by pressing the <Enter> key.
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Best-fit Arc

This tool allows you to add points to the image and a best-fit arc will
be generated. You can stop adding points by double-clicking or press-
ing the <Enter> key. The angle of the created arc is defined by the
positions of the first and the last points.

Best-fit Line

The Best-fit Line tool allows you to add points to the image and a
best-fit line will be generated. You can stop adding points by double-
clicking or pressing the <Enter> key.
Display points for best-fit features

When the Display points for best-fit features isON the points, which
define best-fit features are shown on the image and included in the
data table. When the option is off the points are hidden.

The Points edit boxes in the drop-downs  for Line, Circle, and Arc
features are used to set the maximum number of points for best fit
lines, circles, and arcs. Lines will allow from 2 to 1000 points, while
circles and arcs will allow from 3 to 1000 points. When creating a
best-fit feature, the feature will be automatically created when the cur-
rent maximum is hit. This makes it possible to set feature creation to
accept 2-point lines and 3-point circles and arcs (without requiring
double-click on the last point) while still supporting multiple-point
fits when desired.

Relative Measurements
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The Relative Measurements group provides tools to create measurements between existing
features. You have to create one or more objects first, and then create a derived meas-
urement.

Distance between objects

Use these tools to create distance measurement between two objects.

Point group

These tools are used to create point features at the start of the

l First point creates a point feature at the start of the selected
object.

l Center point creates a point feature at the center of the selected
object.

l Last point creates a point feature at the end of the selected
object.

Distance between centers

This tool creates distance measurements between the centers of two
selected objects. Note, that if two lines (polygonal lines) are selected,
the Average gap between traces will be measured.

Minimum distance

This tool measures the least distance between two selected objects.
Note that if two lines (polygonal lines) are selected, the Minimum
gap between traces will be measured.

Maximum distance

This tool measures the greatest distance between two2 selected
objects. Note that if two lines (polygonal lines) are selected, the Max-
imum gap between traces will be measured.

Angle between lines

This tool creates an angle feature between two selected lines. When
drawing lines, the order in which the lines are selected and the dir-
ection of the lines is taken into account. The shortest distance is cal-
culated when the lines are drawn in the same direction.
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Merge Objects

Clicking the Merge button will combine all selected objects into one
by connecting all the objects by the shortest line. Note that the
Merge function is available only for making region measurements of
objects (polygon, ellipse, circle, count/size objects). The Merge but-
ton is also displayed in the on-image context bar.

Incremental Distance

Clicking this button creates a set of vertices between two selected fea-
tures (lines or regions). This feature is useful when measuring coating
(between 2 poly-lines) or a doughnut (between external and internal
regions) thickness distribution. It is also possible to create incremental
distance measurements for a single object (closed polygon). If the
object contains a hole, incremental distance will be calculated
between the object’s outline and the hole (doughnut thickness meas-
urement). If more than one hole exists, the largest hole is used.  If the
object doesn’t contain holes, the incremental distance will be cal-
culated between 2 opposite sides of the object along the given angle. 
The step size offset on both sides of the object is used to avoid zero
length lines. When auto-angle is on, the angle is calculated auto-
matically.

Additional information about the Angle between Lines measurement follows:

The angle range is determined by the option in the Angle tool dropdown and can be
0…180, -180…180 (default) or 0…360.
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It is computed as the difference between the vector angles (measured counterclockwise
from the positive, rightward, horizontal axis) of the first selected line, tail-to-head, minus
the second selected line, head-to-tail, limited to +/-180 degrees.  The measurement thus
depends both on the order in which the lines are selected and the directions in which they
are drawn (in an opposite sense).

The arc is drawn from the center of the second line in most cases, unless the center is close
to the intersection point. In that case the arc is drawn from the point with fixed offset from
the center:

The arc is always drawn from the mid-point of the second selected line to the point where
the arc intersects the first selected line or its projections. The arc is drawn in either a clock-
wise or counterclockwise direction to create an arc that covers an angle equal to the abso-
lute value of the measurement (computed as described above). The arc starts at the
midpoint of the second selected line and ends on the first selected line or its projection. 
The direction that the arc is drawn is not determined by the sine of the measurement value.
Rather, it depends on the location of the midpoint of the second selected line relative to
the trajectory of the first selected line.

Incremental Distance

Incremental Distanceautomatically measures distances between two irregular edges to
quantify changes in surface size and shape. The drop-down contains the following options:
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Step Size defines the distance between vertices in pixels.

Type selects the incremental distance measurement type that defines how vertices are cre-
ated. It can be one of the following:

l Shortest measures the shortest distance between point and line. Points along the
object line are equally distributed with the interval defined by the step size. The
shortest distance to the reference line is created from every point on the object
line.

l Equidistant measures the distance between points along the object line. Step Size
defines the number of vertices. The interval between points on the reference line is
calculated based on the number of points on the object line. Vertices connect a
point on object line with the corresponded point on the reference line.

l Directional is used when all vertices are parallel. The distance between the ver-
tices is equal to the steps Size.

When using the Directional type, the orientation of vertices is defined by an
angle (in degrees from X axis counterclockwise). When auto-angle is on, the
angle is calculated automatically based on the object and reference lines. Created
vertices skip non-overlapping line ends.

l Shortest bi-directional measures the distances between points on the line and
another line calculated as two sets of lines: from the object line to the reference
line and from the reference line to the object line. This algorithm is used in
Image-Pro to calculate distance between traces. The distances for object and ref-
erence lines are calculated in the same fashion as the shortest method.

l Distance map calculates thickness of the layer using a distance map. The source
points are placed on the skeleton line between two traces created by the distance
map. New lines perpendicular to the skeleton line and with a length cor-
responding to the thickness based on the distance map are created. The method
can be used to measure thickness of bent profiles.

When Hide Base Lines is selected, the source base lines are hidden after the incremental
distance lines are created, so that they don’t affect statistics and histogram distribution of
visible objects.

To measure incremental distances, follow these steps:

1. Go to the Measure tab and draw two polyline measurements on an image.

2. Select both polyline measurements

3. Select the Incremental Distance button in the Relative Measurements group.
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Note that all relative features are adjusted when their base features are changed. Relative
features cannot be moved manually; they will be moved by changing positions of the base
features.

Note also that the order of selection also affects derived measurements.

Morphological Operations

The selected region-based features can be automatically modified using four morphological
operations: Grow, Shrink, Open, and Close

Grow
Grows selected objects using a Dilate operation.
When the "Use Restricted Grow" option is on, the
Grow operations (with Count or Grow selected) do
not merge objects (default is on).

Shrink
Shrinks selected objects using an Erode operation.
The size increment for Grow and Shrink operations
can be adjusted in the dropdown of the Shrink but-
ton. The increment size is defined in pixels.

Open
Applies morphological Open operations to selected
regions. Use this operation to separate neighboring
features if they are connected by a narrow path. The
size of the morphological Open or Close operation
is defined in the dropdown of the Open button. The
size is in pixels.

Close
Applies morphological close operations to selected
regions. Use this operation to merge neighboring fea-
tures.

Note that all relative features are adjusted when their base features are changed. Rel-
ative features cannot be moved manually; they are moved by changing positions of
the base features.
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To make line measurements in an image:

1. Open the image that has features you want to measure.

The image appears in the Image-Pro workspace.

2. Select the Direct group on the Measure tab’s ribbon.

3. Select the measure line tool.

This tool allows you to make distance measurements directly on the image

4. Apply or define the spatial calibration that you want to use.  See “Managing Cal-
ibrations” earlier in this chapter for more information.

5. Draw a line on the image.

The measurement information will appear in a label on the image. The label will
appear near the center of the line without covering up the end symbol or much of the
line itself. The measurement values will change as you drag the line.

You can make changes to the appearance of the label using the Options button.
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6. Click the Options button. You will see the Measurements Options dialog:

The text area of this dialog allows you to change the font and size of the text that will
appear in the measurement label. The border and fill areas control the display of the
border and background of the label. The options area lets you resize the label when
you resize the image, and control the opacity/transparency of the label.

Note: Measurements and Manual Tagging can be applied to live preview images for
quick measurement previews. However, these measurements are not saved with the
captured image.

Setting the Default Appearance for Measurement Labels
The default appearance attributes for measurement labels are set by designating the appear-
ance attributes of an existing label as the default for future measurement labels.  To set the
default appearance for an annotation type:

1. Click Select from the Measurement group.

2. In the active image, click on a label of the type for which you want to set appearance
defaults.  Most labels appear at the top-left or bottom-right positions near the marker.

3. Click the Options button to display the Measurement Options panel.

4. Expand the Appearance Options section of the panel:
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5. Go to the Font panel.

6. Choose a font from the drop down list:

You will see the measurement labels change to the font you select. Use the color,
style, and size buttons to make additional changes to the measurement labels.

Shadow (S) lets you add a background shadow color to the label text.

Bold (B) displays the font in bold.
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Italic (I) displays the italic font.

Underline (U) underlines the label text.

Class Color uses the class color for the label.

A lets you select the text color.

The number in the spin box indicates the font size.

7. In the Labels panel, select the text, position, and units of measure for the measurement
labels:

The choices for Text include:

n None – no labels

n Name – measurement object name is displayed

n Measurement – the label measurement is displayed

n Name And Measurement – full name and measurement are displayed.

Units of measure and measurement abbreviations can be added to the measurement
label by checking the appropriate boxes. You can also indicate the number of decimal
points for each measurement. Position indicates the location of the measurement label.
If the Dynamic box is checked, the label information will change as the information
in the image changes. Measurement labels will also be resized automatically. When
you select a feature, its associated label will be highlighted. If the Auto Size box is
checked, the labels are scaled proportionally to object area.

Here is an example of measurements with labels:
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8. Use the Outlines panel to define the style of the each object class and shape:

9. The Cursor panel lets you customize the measurements cursor:

n Cross Bars are useful adjusting line ends on the features. They are only active in
the line editing mode.

n Crosshair helps you to center horizontal or vertical measurements.

n Tooltips show measurement data on the image when you are moving the mouse
over an object on the image.

Using the Auto-Trace feature

Activating the Auto-Trace tool for an ROI or Annotation will cause the Polyline tool
in Line Profile to behave the same as the Auto-Trace tool. When you click on the
Polyline feature and activate Auto-Trace, you will see the following dialog:
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The message at the top of the dialog indicates if auto-trace has started, or not.

Tracing speed: Use the slider to control the speed of the auto-trace.

Edge quality: Indicate the number of pixels to use for the edge trace.

Noise reduction: Use the spin buttons to indicate the degree of noise reduction in the
traced object.

Momentum: Use the spin buttons to indicate the degree of momentum in the traced
object.

Smoothing: Use the spin buttons to indicate the degree of smoothing in the traced
object.

Check the box next to the auto trace feature that you want to use.

AutoStart Tracing: If this box is checked, the second mouse click made when cre-
ating a polygon or polyline will start the auto tracing. If uncheck, start auto trace by
holding down the <Ctrl> key and clicking where you want the trace to start. The
lightning bolt cursor shows you the auto trace path.

AutoAccept Final Trace: When this box is checked, the auto trace automatically
returns to the starting point to finish tracing the object. If unchecked, you must press
the <Enter> key or double-click the mouse to place the final point and complete the
auto trace.

Trim Leading Points: Frequently, a trace will not return to its starting point but will
interest with itself some distance from the starting point. If this box is checked, the
points before the intersection point are removed if the intersection is close to the start-
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ing point. If this box is not checked, you must edit the trace manually to remove
extraneous points.

Remove Redundant Points: If this box is checked, all horizontal, vertical, and diag-
onal runs leading to the auto trace are replaced by their end vertices in the final result.
If this box is not checked, these points will be retained.

Monochrome Interpretation: When this box is checked, image color is ignored for
edge detection; only average luminance is used. If unchecked, each color channel’s
luminance gradient is considered when doing edge tracking.

Assume Clockwise: When this box is checked, the trace will begin moving clockwise
around the object. This information is used to determine which side of the trace is the
interior color. This option is useful when working with colored images. If this box is
not checked, no assumption is made about which side of the trace is the interior.

UseRangeMinimum/Range Maximum: When checked, the range for full-scale lumin-
ance swings is assumed to be the full minimum/maximum range of the entire image. If
this box is not checked, range for full-scale luminance swings is assumed to be the dis-
played range of image luminance. This option is usually left clear.

Bound Trace by ROI: When this box is checked, the trace object must stay within
the bounds of the ROI. If this box is not checked, the boundaries of the ROI are
ignored.

Disable Auto Trace: When this box is checked, auto-trace will be disable and you
cannot use it until you uncheck the box.
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Manual Tagging

Use the Manual Tag tool to select individual objects or groups of objects in an image with
your mouse.  You can create different classes of objects for analysis, and “tag” each object
with a specific marker.  To use Manual Tagging:

1. Open your image if it is not already open.

2. Select the Manual Tag tool from the Direct group.

3. Select a shape and color from the Class group.

4. Click on the points in your image to tag them with a color and label:

Information about your tagged points appears in the Data Table below your image:
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5. Save your data to a file or export it to Excel.
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Viewing Measurement Information

Viewing a Data Table

The Data Table collects all the information from the measurements taken on your image.
To view a data table:

1. Open the image if it is not already open.

2. Select the data type that you want to view.

3. Select the Data Table from the View Data group.

4. The data table will appear in a pane below your image:

The data table default names for measurements are:

Abbre-
viation

Meas-
urement
Name

Abbre-
viation

Meas-
urement
Name

Abbre-
viation

Meas-
urement
Name

AN Angle AB Angle
between
Lines

BFA Best-fit
Arc

BFC Best-fit
Circle

BFL Best-Fit
Line

C Circle CCD Center to
Center dis-

CPT Center
Point
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tance
E Ellipse FPT First Point L Line
LPT Last point MMD Minimum

distance
MXD Maximum

Distance
P Polygon PL Polygon

Line
PR Count/Size

Polygon
region

PPL Point to
Point dis-
tance

PWL Pitch with
Line

R Rectangle T Tag

You can manually rename any features in the data table.

The Data Table provides the following tools:

Load Data Table Measurements: This tool allows you to load meas-
urements saved in a previous session from a *.ipm file.
Save Data Table Measurements: This tool allows you to save your
measurements in a *.ipm file for use at another time.

Send Measurements to File: This tool allows you to save your meas-
urement data to a file or export it to an Excel spreadsheet. The pull-
down menu  lets you choose one of the following:

Send to Report: This tool allows you to save your measurement data
to Image-Pro report. The pull-down menu lets you create a new report
or choose an existing one.
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Show all Statistics: This tool allows you to hide or show the statistics
panel for the data table measurements. A sample statistics panel is
shown here:

The drop-down option Statistics per Group defines what is displayed
in the statistical pane. When this option is off, the statistics of all vis-
ible features is shown. When the option is on, the statistical values are
shown per group. This option has affect only when Grouping is active
Setup Group Statistics display the statistics by group.  It will activate
grouping by class, add Percent Area Parent to the list of measurements
and activate statistics per group
Grouping: Click this button to see options for grouping your data in
the table. You can choose one of the following:

Show All, Show Selected Measurements, Hide Selected
Measurements: These tools let you choose to display or hide some of the meas-
urement statistics.

3D Mask: Click this button to create a mask of volume objects.

Load Data Table Measurements: This tool allows you to load meas-
urements saved in a previous session from a *.ipm file.

Save Data Table Measurements: This tool allows you to save your
measurements in a *.ipm file for use at another time.
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Send Measurements to File: This tool allows you to save your meas-
urement data to a file or export it to an Excel spreadsheet. The pull-
down menu  lets you choose one of the following:

Send to Report: This tool allows you to save your measurement data
to Image-Pro report. The pull-down menu lets you create a new report
or choose an existing one.
Show all Statistics: This tool allows you to hide or show the statistics
panel for the data table measurements. A sample statistics panel is
shown here:

The drop-down option Statistics per Group defines what is displayed
in the statistical pane. When this option is off, the statistics of all vis-
ible features is shown. When the option is on, the statistical values are
shown per group. This option has affect only when Grouping is active
Setup Group Statistics display the statistics by group.  It will activate
grouping by class, add Percent Area Parent to the list of measurements
and activate statistics per group
Grouping: Click this button to see options for grouping your data in
the table. You can choose one of the following:
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Show All, Show Selected Measurements, Hide Selected Meas-
urements: These tools let you choose to display or hide some of the measurement
statistics.

Viewing a Data Histogram

Histograms measure, and illustrate in graph form, the brightness and contrast characteristics
of an image.  Histogram data can be created and viewed for data gathering and analytical
purposes or can be manipulated for image enhancement purposes. To create a data his-
togram:

1. Open the image that you want to measure if it is not already opened.

2. Select the type of measurement data to view. For example, point position X

3. Select DataHistogram from the View group.

A histogram of the data for the x position of the selected points appears in the right-
side panel of the workspace:
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More information about histograms appears in Chapter 4 of this manual.

Viewing an Object Window

The Object Window allows you to view information about a specific object in an image.
To view the object window, follow these steps:

1. Open the image that you want to measure if it is not already opened.

2. Select the type of object data to view.  For example, point location T2.

3. Select Object Window from the View Data group on the Measurements ribbon.

The Object Window containing data for point location P1R12 appears in the right-
side panel of the workspace:
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L*a*b* Color measurements and Color Correction

Color measurements and color correction tools are located on the Measure tab, in Color rib-
bon group:

The module is designed for absolute color measurements in CIE L*a*b* or XYZ color
coordinates. This module also provides easy to use tools for color correction.

The module can be used in cosmetic, textile, pharmaceutical or food industries, those that
require accurate measuring of colors or color differences.

The dropdown button contains 3 items that open dialogs with Color measurements and
Color correction tools:

Color Measures

Color measures dialog allows measurement of colors under cursor and also extracting color
channels as monochrome images.
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CIE L*a*b* color measurements can be executed using 2 methods:

1. sRGB color model

2. Color profile

sRGB (standard Red Green Blue) is an RGB color space created cooperatively by HP and
Microsoft in 1996 for use on monitors, printers and the Internet, and subsequently stand-
ardized by the IEC in 1999. It is often used as the "default" color space for images that do
not contain any color space information, especially if the images are stored as 8-bit
integers. sRGB color model assumes that RGB colors are captured with D65 illuminant.
More info can be found here.

sRGB color model can be used with images that do not have associated color profiles or
when only measurements of color differences are required after executing of color cor-
rection to sRGB space.

If image has own color profile, the second option Use color profile should be used. In that
case color profile associated with the image or the working color profile provide the cor-
rect XYZ and L*a*b* measurements.
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Image color profile can be loaded clicking the Load button and selecting ICC or CMM
color profile file from the disk.

The Reset button will remove color profile from the image and activate the working color
profile for measurements. The working color profile can be selected using the Select work-
ing color profile button. It can be reset to the default sRGB IEC61966-2.1 clicking the
Reset working color profile button.

If image has own color profile, it can be converted to the working color profile using the
Convert image to working profile button.

ICE L*a*b* measurements are also available for any Region objects using Count/Size or
manual Measure operations:

Note, that L*a*b* color measurements generated by Count/Size use the color measurement
method, color profile and Illuminant selected in the color measure dialog.

The bottom part of the dialog provides measurement values under cursor on the active
image:
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RGB group shows Red Green and Blue values under cursor and Color Space/Illuminant
defines the active color space/illuminant and corresponded measurement values.

There are following color spaces available:

l Lab – CIE Lab color space

l XYZ – intermediate color space between RGB and Lab spaces

l YIQ - the color space used by the NTSC color TV system, employed mainly in
North and Central America, and Japan. I stands for in-phase, while Q stands for
quadrature, Y component represents the luma. (https://en.wikipedia.org/wiki/YIQ )

l CMY - subtractive color model, used in color printing, cyan, magenta, yellow.
(https://en.wikipedia.org/wiki/CMYK_color_model ).

Note, that YIQ and CMY are not absolute color measurement spaces and listed in the dia-
log for completeness of color measurements on the image.

The Illuminant defines the type of light source used when the image was taken. The fol-
lowing standard illuminants are listed:

l D50 - CIE standard illuminant D50. Simulates warm daylight at sunrise or sunset
with correlated color temperature of 5003 K. Also known as horizon light. (all
color profiles use it as PCS colro space)

l D55 - CIE standard illuminant D55. Simulates mid-morning or mid-afternoon day-
light with correlated color temperature of 5500 K.

l D65 - CIE standard illuminant D65. Simulates noon daylight with correlated color
temperature of 6504 K. (used with sRGB color space)

l A - CIE standard illuminant A. Simulates typical, domestic, tungsten-filament light-
ing with correlated color temperature of 2856 K.

l C - CIE standard illuminant C. Simulates average or north sky daylight with cor-
related color temperature of 6774 K.

l E - Equal-energy radiator. Useful as a theoretical reference.

The Illuminant affects XYZ and Lab color measurements. It's preferable to use the native
Illuminant for specific color profiles, for example sRGB model used D65 illuminant, while
Color profiles use D50 as intermediate white point. Conversion to other illuminates are
done by using Bradford transform in form of chromatic adaptation.
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 L*a*b* Color measurements and Color Correction

Every channel of a color image can be extracted to a monochrome image clicking the

Extract button.

Reference colors

Color measurements can be verified using some reference color images called color check-
ers, one of them is Gretag-Macbeth Color checker.

The patch has 24 colors covering visual gamut and has known colors published on the net.

The application installs the color checker image as ColorChecker_sRGBD65.tif to the Col-
ors folder of demo images:

The RGB values of every are generated with D65 illuminant. The list of patch values can
be found in wikipedia .

Color Correction

The Color Correction tool is closely related to the CIE L*a*b* measurements. The goal of
the color correction is to adjust colors of one image to colors of the reference image with
known Lab coordinates or just to some reference color patch, so the colors can be meas-
ured or compared.
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Typically, the reference image can be a color checker (e.g. Macbeth ColorChecker) or just
an image with color patches.

User should place manual Tags as reference points on corresponded color patched of the
reference and active images and execute color correction.

There are 2 types of transforms are available:

l Polynomial

l Thin Plate Spline

With Polynomial type the images may have from 3 to 20 points for color correction. A
polynomial transform is created matching colors on the active and reference images. The
type of the polynomial depends on the number of tags:

l 3-point calibration corrects changes in color gain

l 4-point calibration corrects color shift and gain

l 7-point calibration corrects the linear color mix
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l 10-point calibration corrects the color mix using polynomial approximation of
power 2

l 20-point calibration corrects the color mix using polynomial approximation of
power 3 .

Polynomial transform is recommended to use with small number of reference points (3-7) as
high degree polynomials may produce unexpected color distortions for colors in between
references.

Thin Plate Spline transform can be used with 3 or more reference points. This method pro-
duces smoother color space transforms comparing to Polynomial with large number of
points, though reference point colors may not match exactly when Regularization is more
than zero.

It is recommended to use Thin Plate Spline transform for large number of tags as in case of
full 24-point matching of Macbeth ColorChecker.

Point Radius - radius of the measurement circle at the tag position in pixels. The average
RGB values of the circle region are used for color matching. When the value is one -
single pixel value is extracted.

Regularization – is a smoothing parameter used only with Thin Plate Spline transform
method. Increasing the value will smooth color transform, though the reference values may
not match exactly.

Typical color correction work-flow

Use image of Color Checker or image with color patches as a reference, add manual tags
on the color patches using tag tools:
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Tags can be added activating the Manual Tag tool and clicking at the color patches on
the image. Tag positions can be modified activating the Select tool, selecting and moving
or deleting them using the Delete key.

You can also add the whole grid of color tags clicking the Add ColorChecker grid but-
ton and drawing polygon clicking the centers of the corner color patches in the following
order: top-left, top-right, bottom-right, bottom-left:

then close the polygon either by double click or hitting the Enter key.

The tag pattern will be created:

The tags on corresponded color patches on the active image should also be created and
then color transform can be saved to a file or applied to the image.
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The transform can be saved to a file using the Save button. When the transform is saved, it
can be used correcting the current or other color image taken with the same conditions.

Clicking the Correct Colors button will apply transform to the active image.

The correction can be undone using the Undo button.

After the correction the RGB values of the color patches at tag positions will be trans-
formed to RGB values of the reference image and L*a*b* or XYZ measurements can be
performed properly.
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Color Validation App

Transform verification can be done using the pre-installed Color Validation app. The
screenshot below shows the results of Visualize Color Transform operation:

The app contains documentation describing the available tools, refer to the app's help file
for more info.
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Thresholding

Thresholding allows you to reduce your image to just two colors: black and white.  This is
done by specifying a range of intensities to be emphasized (set to white), and converting
all others to black (0).  Thresholding is often used to segment an image in order to extract
its important features, or to reduce an image to two intensity levels in preparation for a
watershed or thinning filtering operation.

Thresholding is performed using the Mask button on the Select tab. 

When the Mask command is selected, you will be asked to specify the range of values
you want emphasized (set to white). 

The Threshold command operates upon gray scale values, so if you are working with a
True Color or Palette image, it must be converted to Gray Scale before it can be threshol-
ded.

To use the Threshold tool, follow the steps below:

1. Open the image, if it is not already open.

2. Click the Mask button on the Select tab.

You will see the Threshold Tool panel.
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The dialog shows the histogram of the active image and the colored area shows the
range within thresholds. Using the mouse wheel will zoom in the histogram in and
out.

3. Use the following tools to set your threshold range:

The Class combo-box shows the active segmentation class. You can add new seg-

mentation classes by clicking the Add button or delete classes using the Delete

button. All classes can be reset using the Reset button. The class names that
you defined here are assigned to thresholded objects created by a Count operation in

Count/Size. Class color is defined by the color button.

The visibility of the threshold overlay can be toggled using the Show Overlay button

. The Show All Classes check box in the drop-
down defines the preview overlay context, when the control is on, all classes are
shown; when it is off, only the active class is visible. When Allow Overlap option is
off, multi-range segmentation ranges are not allowed to overlap. You can enable this
option to create overlapping ranges.
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The Mask button creates a new binary image of thresholded areas for all classes of the
active class depending on Show All Classes control.

The Log Y button switches the Y axis to a logarithmic scale.

The Reset zoom button resets the histogram.

The Set Global  button sets threshold segmentation ranges to Global. These ranges

can be applied to another image using the Apply Global  button.

The segmentation ranges can be saved to a file using the Save  button and loaded

from a file using the Load  button.

The bottom part of the dialog displays these thresholding tools:

Color Picker (eyedropper)

Use this tool to pick intensities from the image. The pixel area that is
used for threshold definition is shown in the cursor window, as in a mag-
nifying glass. The area in the magnifying glass is defined by the Size
parameter.
Start/End

The Size parameter determines the pixel used to sample the intensities.

Undo/Reset

Use the arrow to undo the most recent operation. Use the Reset button
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to reset the threshold.

Minimum/Maximum

Use these buttons to set the minimum and maximum threshold values.
Auto Threshold Min selects only bright objects, while Auto Threshold
Max selects dark objects.

Auto-Threshold
Auto-Threshold allows you to define the method that is used to segment objects in Auto
Bright/Dark segmentation modes. This feature appears when you click the Options button
in the Measurements group on the Count/Size tab’s ribbon.

You can find Auto-Threshold on the Segmentation Options ribbon, which appears on the
panel on the right side of the workspace:

The auto-threshold methods include multi-phase auto segmentation methods and a his-
togram method that should be used with Bias to segment objects above or below the back-
ground. The methods are:

l Min Variance - The ratio of between-phase to total variances minimized (method of
Otsu). This is the default method.
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l Legacy method.  A version of the Minimum Variance method with a bias towards low
values. .

l Mean - Threshold is the Mean value of histogram.  Use Bias to segment the objects
above or below background. .

l Mode - Threshold is the Mode value of histogram. .

l Median - Threshold is the Median value of histogram. .

l Minimum - Threshold is the Minimum value of histogram. Maximum - Threshold is the
Maximum value of histogram. .

l Best Fit Min - Threshold is the Minimum of best-fit range of histogram. .

l Best Fit Max -Threshold is the Maximum of best-fit range of histogram. .

The methods from Mean to Best Fit Max should be used with Bias to segment the objects
above or below background. These methods can be used with batch macros to count and
measure objects with intensities above or below threshold by fixed value.

Segmentation Bias
Segmentation Bias is defined by the Bias control:

You can use this option to adjust automatically calculated threshold values by the given
bias value. The bias is applied only to AutoBright/Dark segmentation methods. There are
3 bias methods:
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l Range Max - where bias is calculated as a percentage of the maximum range of the
given image type.

l Best Fit Range - bias is calculated as a percentage of the best-fit range. This is the
default method.

l Standard Deviation - bias is calculated as percentage of standard deviation of the
image intensity distribution.

Note that the Bias value, Bias method and Auto-Threshold methods are automatically
reflected on the Threshold overlay when adjusted (when Threshold dialog is visible and
segmentation method is set to Auto Bright or Auto-Dark).

The absolute Bias value is also reported in the tooltip over Bright or Dark segmentation
buttons:

Grow or Shrink Object
The Grow or Shrink option can be used to grow or shrink segmented objects auto-
matically. The option defines the size increment (in pixels) of segmented objects that is
applied after a Count operation using dilation or erosion of the segmented regions. If the
value is negative, the objects shrink. If the value is positive, the objects grow. To use this
tool, follow the steps below:

1. Count the objects in your image.

2. Use the blue selection arrow to select multiple objects to grow or shrink. 
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Choose the drop down arrow next to the blue selection arrow to Select All if you
want to grow or shrink all the objects.

3. Go to the Measure tab and choose the Grow or Shrink options from the Relative
Measurements group. 

The drop-down arrow next to the Shrink icon lets you specify the incremental amount
to grow or shrink the object.

4. Adjust your image.

Open or Close Object
Use the Open and Close tools to manually combine neighboring objects when using auto-
matic segmentation and counting tools. To use these tools, follow these steps:

1. Count the objects in your image.

2. Use the selection arrow to select multiple objects to merge or close.

3. Go to the Measure tab and choose the Open or Close options from the Relative Meas-
urements group.
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The Open tool will combine the two objects for your count results without changing
the actual area of the two objects. The drop-down arrow next to the Open icon lets
you specify the incremental amount to grow or shrink the object.

The Close option will use a morphological filter to close the space between the two
objects, thus changing the total area of the counted object. 
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Customizing the User Interface and Automating Pro-
cesses

This chapter provides instructions for the many ways you can customize the
Image-Pro application interface. You can use a Japanese version of the user interface.
Image-Pro allows you to set up the interface in the most efficient way for your work. You
can also use macros, apps, and batch processing to speed up various tasks.
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Using the Quick Access Toolbar

The Quick Access Toolbar appears at the top left of the Image-Pro interface. 

The Quick Access Toolbar allows you to display icons that, when clicked, execute a sys-
tem-supplied or user-defined command.  In this way, the Quick Access Toolbar provides a
shortcut to commonly used functions.

To Add a Shortcut to the Quick Access Toolbar

1. Click the drop-down button next to the Quick Access Toolbar.

The following menu appears.

2. Click on More Commands in the drop-down menu.

The Customize Quick Access dialog box appears.
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The list box on the left displays all the available commands and icons. The list box on
the right displays those commands and icons currently displayed in the Quick Access
Toolbar.

The Choose commands from...drop-down list displays different groups of available
commands, as shown here:

3. Select a group of commands to display in the list box.

4. In the list box, highlight the command you want to add to the Quick Access Toolbar.

For example, if you regularly use the Paste command in Image-Pro, you can make a
shortcut that performs a paste by adding a Paste command and icon to the Quick
Access Toolbar.
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5. Click the Add button and the command appears in the right hand list box.

6. Click on the OK button.

The shortcut is added to the Quick Access Toolbar.
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Customizing the Image Strip

The Image Strip displays thumbnails of all opened images in the application and provides
an easy way of activating and deleting images. The Image Strip controls are located in the
Workspace group on the View tab’s ribbon:

Image-Pro opens the image strip automatically when you launch the application. It
appears on the left side of the application window.

If you have several images open, the image strip will display thumbnails of all of them:
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The layout of the images can be selected from the context menu.

n Click the right mouse button on the image thumbnail to see the context menu.

n Auto Fill: all thumbnails are fitted to the strip window.
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n Single row/column: when this mode is activated the thumbnails are resized to fit the
width or height of the window. Scrollbars become visible if the number of images
exceeds the size of the window.

n Fixed Small: thumbnails are 64x64 pixels

n Fixed Medium: thumbnails are 128x128 pixels

n Fixed Large: thumbnails are 256x256 pixels

n Lock/Unlock selected windows: Select this option to lock the image windows for the
currently selected thumbnail(s).  The lock will disallow panning, zooming, or bringing
other image windows to the foreground, depending on what is selected for Lock
Options.

Lock options: Allows you to select what you want locked when the Lock/Unlock selected
windows option is activated.
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l Pan Scroll :  Synchronizes image pan and scroll positions

l Zoom:  Synchronizes magnification of images

l Active Frame: Synchronizes active frame index on all locked images

l Auto Arrange: When this option is on the locked images will be arranged on the in
the application workspace to be visible. For example if you lock 4 images, they will
be arranged in 2 rows and 2 columns. The option arranges only images to be locked. If
the workspace contains more images, other images will be placed in the last pane
below the last locked window, as shown here:

Viewing Tooltips
Tooltips show the basic image information:
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n To view an image tooltip, move your mouse cursor over the image thumbnail.

The zoom and pan controls allow you to resize the image or a portion of the image.

When the active image is zoomed and doesn’t fit in the viewer, the viewing area is shown
on the image strip thumbnail as a semitransparent orange overlay.

n Click and drag the center of the viewing area on the thumbnail to control pan
and scroll of the image.

Activating and Closing
1. Click on a thumbnail in the image strip to activate the corresponding window.

If the thumbnail represent a surface plot or 3D view (or other viewer) clicking will
also update the thumbnail.

2. To close the image, click the Close menu item from the context menu,  or click the X
button:
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To remove an image from the image strip, select that image and click the <Ctrl> or
<Shift> keys. More than one image can be removed at the same time using this method.

Using the interface customization capabilities provided by Image-Pro, you can customize
the Image-Pro toolbars by:

n Moving, docking, and undocking toolbars

n Showing/hiding toolbars

n Creating new toolbars

n Adding/deleting buttons from existing toolbars.
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Using the Multiple Document Interface (MDI)

The Switch to MDI button will toggle the workspace windows to MDI windows or back
to tabbed windows. This feature allows you to view more than one image at a time, and
move the images and panels to different locations in the application.

This feature is located in the Workspace group on the View tab’s ribbon:

Normally, when the workspace windows are set to Docking, the image appears like this:

When you switch to the MDI view, several images can be viewed at once, as shown here
(these are shown in the Tiled layout):
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The pull-down MDI menu allows you to select window display:

This version shows image windows in the Cascade layout:
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Floating Panels
One of the unique features of Image-Pro is the “floating” or “dockable” panels. The image
strip, details panel, mini-histogram panel, or other workspace areas can be moved inde-
pendently from the main image workspace. This may be particularly useful when working
with a dual-monitor system, as you may want to display the image on one monitor and the
details on the other.  An example of floating or “undocked” panels appears here:

330



Chapter 8

331



Tools and Layouts

Tools and Layouts

The View tab contains specialized tools and graphs to display information about the active
image or image set. Some of these tools allow you to see different aspects of the active
image also.

The Tools in the Workspace group allows you to load and save custom tool sets and lay-
outs for your specific situation. Click the drop-down arrow to see these features

Redock All Tools: Resets any open moveable panels that are undocked to their default
docked position.

Reset Tools Layout: Resets the application to its factory default tools layout.

Load Layout: This tool allows you to load a previously-saved tools layout. When you
click on this tool, the following dialog is displayed:
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This dialog shows all available tool layouts to be loaded. The Recent area shows a list of
the last loaded layouts. The Custom area shows a list of the custom layouts currently
stored in the Configuration Files folder. The Default area shows a list of the available pre-
defined layouts from installation directory \Resources folder.

SaveLayout: Click this tool to save the current layout of tools to a file that can be loaded
at a later time to restore the layouts to its current configuration. When you click this
option, you are prompted to give the layouts configuration file a name. Type a name for
the layout configuration file, then click Save. You can use the Load Layout tool
(described above) to restore the tools layout to its current configuration at a later time.
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Creating a Custom Tab

One useful feature of Image-Pro is the ability to create a Custom tab on the ribbon. It can
contain any of the features you use most frequently, saved in one place.

By default, the Custom tab appears on the far right of the ribbon, but you can control its
placement in the application Options. The default placement is shown here:

The first time you open it, the Custom tab’s ribbon will be empty. You can add any group
or tool to it, as described here:

1. Decide which tools or group you want to add to the Custom tab. For example, Annot-
ate:

2. Right-click the mouse button in the Annotate group. You will see the context menu:

3. Choose Add to Custom Tab.

The Annotate group now appears in the Custom tab’s ribbon:
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You can drag the groups into different positions on the ribbon. The image below
shows that the Calibration and Filter groups have changed position:

4. To remove an item from the Custom tab, click Remove from Custom tab in the con-
text menu:

Rename and Make your Custom Tab the First Tab
If you want to give the Custom tab a new name, and make it the first tab that a user sees,
use the following steps:

1. Click on the File button in the top right corner of Image-Pro:

2. Choose the Options button at the bottom of the menu.

3. From the Options dialog, click on the Display section.
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4. In the Ribbon Tabs area, select First Custom Tab to display your custom tab as the
first tab.

5. Type in a new name for your tab in the Name text box

6. Press OK at the bottom of the Options dialog to apply the changes.

Your new tab should appear first in the tab list with its new, custom name.

In the example below, we have created a new tab, named Jacob’s Analysis which is
displayed first in the ribbon.
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Hide or Show Tabs
Image-Pro allows you to hide or show the tabs to display only the tools you need. To use
this feature:

n Right click on any of the tabs to see the Show or Hide Tabs dialog.

Tabs with an active check mark will be displayed.  Those without will be hidden from
view

For some situations, you may find it most effective to hide all of the other
Image-Pro tabs and focus only on the Custom tab or a specific App.  To hide the tabs, use
the following steps:

1.  Click on the File button in the top right corner of Image-Pro.

2. Choose the Options button at the bottom of the menu.
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3. From the Options dialog, click on the Display section.

4. Under the Ribbon Tabs section, select the Hide Tabs option and make sure Show Cus-
tom Tab is checked.
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5. Now you will see that just the Custom tab is shown. If you happen to have an image
opened, you will also see the contextual Image tab, which is displayed when an image
is opened.

Showing or Hiding Groups

You can also hide or showImage-Pro tool groups to only display the tools that you need
for your image analysis work. To use this feature, follow these steps:

1. Right click on the open space in the ribbon bar. 

Tip:  Click on the far right side of the workspace.  In the example below, you would
click in the grey area to the right of the “Movie” button. 

2. You will see the Show or Hide Groups dialog.  Groups that are highlighted will be
displayed.  Toggle this feature on or off to show/hide groups.

Expanding and Collapsing

Sometimes, you may need to resize the Image-Pro workspace to make it smaller. When
you do, you will notice that the groups on the ribbon collapse and some of the tools are
hidden. In the example below, the Calibration, Intensity, and Quick Save groups on the
right side of the Capture tab’s ribbon are collapsed:
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To expand and see the group’s controls, click the drop-down arrow, as shown here:

Users are encouraged to fully expand the Image-Pro workspace when at all possible, so
that all the tools and features are available.
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Image-Pro in Japanese

Image-Pro is also available with a Japanese-language user interface. It is installed along
with the English-language version from your electronic download or product CD.

To use the Japanese version, follow these steps:

1. Go to your Start menu and select Image-Pro:

2. Choose Image-Pro 9.3 Japanese.

After a moment or two, you will see the Japanese version of the application.
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All about Apps

Apps are little applications that run inside Image-Pro.  Like mini-programs, they have their
own user interfaces and they automate complex tasks in and through Image-Pro.

When you first open Image-Pro, the Apps group of the Apps ribbon will be empty. When
an app has been loaded (as described in the next section), it appears on the Apps group, as
shown here:

Loading an App
Image-Pro allows you to load pre-recorded apps, projects, and macros that you may find
useful. To add an existing App (project or macro), follow these steps:

1. Go to the Search group on the Apps tab in Image-Pro.

2. If you want to load one of the pre-recorded apps provided by Media Cybernetics, click
the App Center button.

The browser will take you directly to the Apps portion of the website:
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You will see a list of available apps.

3. Click the name of the app you want to use.

You will see a description of the app in the browser window.

4. Scroll to the bottom of the browser window, and click the Download button.

5. You will be asked to accept the license agreement. Click I understand and accept the
user agreement.

Apps and projects are stored in the Scripts folder of Image-Pro. Apps have the exten-
sion *.ipx.

6. Click Save.

You will see the Open Project dialog.
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7. Select the app you want to load, and click Open.

Your app appears in the Apps tab:

Running Apps
Once a project is loaded, its app appears in the Apps ribbon.

It can be started by clicking the appropriate button. To run the sample app, follow these
steps.

1. Open the image you want to process in the workspace. This example shows
tumor.tif.
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2. Click the name of the app you want to run. This sample app is called
White Balance.

The contents of the app appear in the right-side panel:

3. Click Measure White Balance.

The first step in the app appears.
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4. Follow the instructions, and click OK.

5. Click Correct Image.

A new, corrected image appears in the workspace.
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Generating and Printing Reports

This chapter explains how to create and print reports in Image-Pro.

The Report tools are located on the Share tab’s ribbon:
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Creating and Printing Reports

Image-Pro allows you to create reports from images and data saved in your application.
The Reporting feature uses an interface that is similar to Microsoft Word. You can display
your data in any of several predefined layouts, and then send them to an output window,
print device, or a file. To begin creating your report, go to the Report group on the Share
tab’s ribbon:

1. To begin creating a report, click the Images button.

The red number superimposed on the Images button indicates the number of active
images. You will see the drop-down menu with all the available images on it. Instead
limiting you to just the document open in the workspace, this feature allows you to
select any document loaded in the software.

Images with a check next to them are available to include in a report. When the Use
Image StripSelection option is checked, this selection will track and match the
changes to the  images in the image strip.  The Select All option will ensure that all
entries in this list are selected. Using the Select All option or adjusting the checkmark
will disable the Use Image Strip Selection option and visa-versa.

2. Next, click the Templates drop-down arrow to select your layout .
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3. Several predefined report layouts are included with Image-Pro:

4. Choose a format.

The Image-Pro reports are loosely designed for an A4 or letter paper output size.  The
sizing of the content and the naming of the reports are based on the output page size.

Once you have selected your documents and report template , you have the following
options:

n Preview the report. In this case the resulting report is read-only and can only be
saved (in Word, PDF or HTML format) or printed. The edit controls are disabled.

n Edit the report. The resulting document is loaded and contextual ribbons can be
used to customize it further before saving or printing. The editing controls are sim-
ilar to those available in Microsoft Word.

n Edit the report template in theProject Workbench. A copy of the report template
itself is loaded for editing the report content.

5. Click Preview Report.
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The hourglass icon will appear, indicating that your report is being created.
When finished, your report will appear in the application’s workspace:

6. If you are satisfied with the appearance of the report, go to the File group on the
Report ribbon.

7. Select Save As to save your report as a PDF. Choose Quick Print or Print to print a
paper copy.

8. To edit your report, close the sample report.
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9. Click Edit Report.

You will return to the Report ribbon with the editing tools activated:

From here, you can use the Report, Insert, and Layout ribbons to adjust the content
and appearance of your report.

Report Tools

Once a report is created,  you have the option to add specific content without leaving
Image-Pro. The report tools use the familiar ribbon tabbed layout.

The Report tab’s ribbon contains controls for saving, printing, and formatting text.

The Insert ribbon allows you to add pictures, illustrations, page numbers, and hyper
links to the body of your report. You can also add and edit headers, footers, and text
boxes using these controls.

The Layout tab’s ribbon lets you adjust the page size, color, margins, and text ori-
entation.

The Contents ribbon lets you add a table of contents to your report. You can also add
captions to tables and figures using these controls.
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Reporting in the Project Workbench
An alternative to the Share tab is the Project Workbench which appears on the Automate
tab. You can use the image strip thumbnails to select images for your report. To create the
report, double-click on the image or use the Project Workbench context menu, or select
Edit Template on the Share tab.

The reporting features available in the Project Workbench are detailed below:

1. The Report Tools in the ribbon.

2. The Project Explorer, where reports can be loaded and created.
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3. The Report Designer, to lay out the various report components as in an MSWord doc-
ument. A context menu is also provided.

4. The Report Data and Report Fields, similar to the Toolbox allow selecting the report
data and dragging data items to the report designer.

5. The Properties Panel is to configure reports and their components.

These features are explained in more detail in the next section.

The Report Tools in the Project Workbench

The ribbon’s Report Tools in the project workbench are similar to those in the main
Image-Proribbon with the addition of a few ribbon tabs.

The Home tab contains the basic tools for creating and editing reports.

The Insert tab lets you add tables, symbols, dates and other specialized details to your
report:

The Layout tab controls table cells, columns and rows. You can adjust the background
color here also.

The View tab controls the aspect of the report template as well as the visibility of report
fields.
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The References tab lets you add a table of contents, table of figures, or captions to your
report.

Project Workbench

The Project Workbench now has a section called My Reports where known reports are lis-
ted (those appearing on the Share tab).

Right-click on the My Reports folder to create new reports or load existing ones.

When you double-click on one of the reports, a report designer is loaded in the workspace
area together with Apps and macros.
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Reports as App/Project Components

In addition to being listed in the My Reports section, reports can also be added to pro-
jects. When projects are packaged, embedded reports become part of the package and are
available for the App and macro code using simple commands.

The Report Data and Report Fields panels

The Report Fields panel is displayed on the left-hand side of the Project Workbench, since
it will be used most often. It reflects the actual content of existing reports.

To add data to your report, click Start Here. You will see the Select Report Data dialog:
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The Report Data panel is used to select and configure the data that will be available for
the report and displayed in the Report Fields panel. You can select the individual fields
using the Add, Remove, and Clear buttons.

The following example screenshot shows a sample report displayed at the end of the
Wound Healing App:
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Using the 3D Features

Image-Pro with 3D Module includes the advanced 3D Viewer volume rendering, 3D
Measurements, and 3D Animation features.  Volume rendering enables you to view an
image stack, or a portion of an image stack, from any angle. You can also adjust the trans-
parency and shading of the image. Animation allows you to create a moving image
sequence. The measurement tools allow you to make manual and automatic measurements
of object dimensions as 3D volumes.

In volume rendering, light emission and light absorption parameters are assigned to each
point of the volume. Each of these points is called a voxel; that is, a 3-dimensional version
of a pixel. Voxels have height, width, and depth, as well as intensity characteristics. Sim-
ulating the transmission of light through the volume makes it possible to display your data
from any view in any direction. 

The 3D Viewer window allows you to examine an image stack in a variety of different
ways: by volume, in slices, and as an animated display. In the 3D Viewer, all geometric
objects are shown in 3D space. It can be regarded as a virtual camera which can be moved
to an arbitrary position within or around the 3D scene.

Note: This chapter discusses the advanced 3D features of Image-Pro with 3D Mod-
ule that are not included in the basic Image-Pro product. The 3D features of Image-
Pro are discussed in Chapter 5, Working with Images.

Image-Pro with 3D Module requires a 64-bit computer and operating system, and
also places greater demand on your operating system. Please see the Image-Pro with
3D Module system requirements in Chapter 1, Installing Image-Pro.
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The Image-Pro with 3D Module Workspace

Once you have installed the Image-Pro with 3D Module software and opened an image
sequence or image set containing on or more Z-stacks the workspace will look something
like this:

If your image sequence does not include Z-position information, it may not load into the
3D Viewer automatically. In that case, you can use the 3D view button on the image con-
text menu or in the status bar to switch to the 3D view.

When you open an image, image set, or image sequence in Image-Pro with 3D Module, an
icon that indicates which view you have open appears next to the file name:

By default, a new volume is loaded in View mode, which allows you to click and drag
anywhere in the 3D workspace to move the camera, effectively rotating the volume in the
3D space. The X/Y/Z axes that may be displayed in the bottom-left hand corner of the
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workspace will show the current orientation of the camera with respect to the X, Y and Z
axes of the volume. Use the controls described on the following pages to manipulate and
analyze the image.

Use the <F> key to check the performance of your 3D viewer on your graphics
hardware.  It may be difficult to manipulate the 3D view with less than 3-5 FPS
(frames per second). Please refer to the system requirements in Chapter 1 for addi-
tional information.

Image-Pro with 3D Module includes three more tabs in addition to the tabs included in
Image-Pro.

When the active view is using the 3D Viewer, the 3D View context tab will be displayed,
which lets you load and save 3D rendering settings, and adjust a wide variety of 3D ren-
dering settings that affect the display of your volumes:

3D Measure contains the tools and features you will need to make volume measurements:

3D Animation contains the tools for creating advanced animations and movies of your
volume. The Animation feature allows you to create, record, and play animation files
(*.anm) in the Image-Pro with 3D Moduleworkspace

When you start Image-Pro with 3D Module, you will notice that the status bar has been
rearranged:

The icons for the 3D viewer and the Slicer views have moved to the start of the list of
views on the image context ribbon, and in the tools portion of the status bar.
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The 3D View Ribbon

The 3D View ribbon contains the following controls to view your image or sequence:

The Volume Display group lets you load, save, and refresh the settings for your 3D
Viewer:

The Reload button allows you to reload the volume with different subsampling. Clicking
the drop-down arrow displays these choices:

The X, Y, and Z indicators refer to the scaling factor use to subsample the display of the
volume. If subsampling is used with this volume, you will see a tooltip similar to this:

The Load, Save, and Reset buttons in the Volume Display group control the various ren-
dering options. Rendering options include the current visual representation of all elements.
The options can be saved/loaded using the REN file format.

The complete experiments including references to the source image and all rendering
options can be saved to Image-Pro with 3D ModuleExperiment (.s3d) files.
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These experiment files can be opened directly in the application's File Open dialog by
selecting the Image-Pro with 3D Module Experiment type.

Reload opens the following dialog:

You can also define voxel size and subsampling manually. When the Auto checkbox is
active, the volume is subsampled automatically. With typically large volumes, (larger than
128 x128 with 128 or fewer Z-planes) subsampling allows faster processing and smother
volume handling, at a cost of reduced resolution in the display. Subsampling for display
purposes does not affect the accuracy of any measurements taken.

Reload when Imagechanged indicates that the volume should be reloaded if the under-
lying image or image set is changed. For example, after filtering the image.

Load 3D settings lets you open and load saved 3D Viewer settings files from a *.ren or
*.S3D file. The *.ren file format saves only the 3D settings, which allows you to apply
those settings to another volume. The *.S3D file format saves those settings and also
saves a reference to the image or image set file to open. After saving an S3D file, you can
use it to re-open the same image file with the same settings from the File:Open dialog

Save 3D settings lets you save your current settings to a *.ren or *.SD3 file.

Clicking the Reset button sets the subsampling to 1x1x1.

Navigate Group
The Navigate group allows you to select and view the 3D volume from different positions.
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Select: Use this button to select object manipulation (and deselect View mode). The cursor
shape will change to an arrow. In this mode, you are manipulating and holding objects in
the Viewer window. Using the <Ctrl> key while clicking the mouse will allow normal
multiple selection or deselection of objects.

View: Use this button to select camera or viewer mode (and deselect object manipulation
mode). The cursor shape will change to a hand icon. In this mode, you are moving the cam-
era in 3D space, which changes the perspective of the rendering in the Viewer window.

When View mode is selected, use the mouse to control the camera position of the viewer.
In this mode, you can rotate, move (using <Shift>+drag), or zoom objects (using the mouse
wheel).

The View/Select modes can also be activated from the image context menu by clicking the
right mouse button:

The AdvancedOptions button contains the advanced options for visualization and ren-
dering. These features are discussed later in this chapter.

TIP: You can switch between Select and View modes by holding down the <V> key.

Voxel Size Group
The Voxel Size group controls the size and location of 3-dimensional pixels:
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Voxel size: This group box defines the dimensions of one voxel (a pixel in 3 dimensions).
The values displayed are the last ones used. If the image does not have a spatial cal-
ibration, and no system calibration has been set, the values are 1, 1, and 1. If the image has
a spatial calibration, the X and Y units per pixel values and the calibration units are taken
from the calibration. If the active sequence or stack includes information about the Z frame
position, the Z size is set from the distance between first and second frame in the sequence.
If Z information is absent, Z voxel size is set to the average value of X and Y sizes. These
values can be modified to achieve the desired volume aspect ratio, but doing so will affect
all 3D measurements taken on the volume. For accuracy of your measurements, we
strongly recommend that you do not modify calibrated values. Note that you can change
the subsampling in the Load dialog on the previous page without affecting 3D meas-
urements.

Decoration Group
The Decoration group contains useful features for viewing and enhancing your 3D image:

The ShowAxes button hides or shows the volume axes. This option display axes that
show the orientation of the volume (Red for the X axis, Green for the Y axis, Blue for the
Z axis). The origin of the axes is at the 0, 0, 0 location.

Show Small Axes hides or shows a pair of small axes in the bottom left corner of the
view. Show small axes is the default selection.

The Bounding box button hides or shows the bounding box. Select this button to dis-
play a bounding box that encloses the entire volume. Clicking the drop-down arrow lets
you choose between the volume frame and bounding box views:
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Show Grid superimposes a grid on top of the image.

Show Labels displays the volume labels around the outside of the image.

Font scale determines the size of the labels.

Tick Frequency controls the placement of tick marks.

The following example shows both grid and labels:

The Scale bar button hides or show the calculation markers on the view. Clicking the
drop-down arrow lets you turn the marker on or off (Toggle Marker) or display the marker
options. Calibration is discussed in greater detail in Chapter 5.
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Note that the scale bar shows the size in the central part of the volume.

View All sets the camera to view all visible objects and decorations in the scene.

Stereo View displays the Stereo Mode dialog:

From this dialog, you can turn the stereo mode on or off, and change the stereo type.

The View Style Group
The ViewStyle group contains controls for volume visualization.
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Transparency: This slider controls the degree of transparency of
the volume. Moving the slider to the left makes the entire volume progressively more trans-
parent.

Interpolation activates voxel view smoothing. The pop-out menu displays your choices:

l Linear interpolation does bilinear approximation between voxels, which is fast but
less accurate.

l When Cubic interpolation is activated, a cubic interpolation of neighboring voxels is
used. This option produces smooth volumes, but is expensive in terms of computing
resources.

l The Pre-Integrated option can be used to increase the quality of the volume view
with a smaller number of slices. It is also useful when the transfer function has a lot of
fast variations, i.e., the color changes very rapidly.

An example appears here:

Pre-Integrated Off Pre-Integrated On
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l The Voxelize options lets you visualize each non-transparent voxel by rendering
each voxel as a cube of that voxel’s volume and intensity. It can be used to look
at the volumes at the voxel level. The picture below shows the volume with the
voxelize option on:

Voxelize on

Boundary Opacity increases or decrease the opacity of object edges, where gradi-
ents are high:

Boundary opacity off Boundary opacity on (thr. =2.5,
intens.= 8.5)
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The pop-out menu lets you change the threshold or intensity:

l The Threshold parameter defines the sensitivity of boundary opacity. Gradi-
ents with a length less than the Threshold values are ignored during the light-
ing computation. This avoids doing lighting computations on noise in the
volume while still lighting important data. In the screenshot, setting a
threshold value of 2.5 removed lighting on the noise surrounding the pollen.

l The Intensity parameters define the darkness of the edges.

Note that using Boundary Opacity can significantly increase rendering time.

The Edge Coloring changes the color based on the gradient direction (normal).
Areas where the normal direction (computed from the gradient) is facing the camera will
have an unmodified color, whereas areas where the normal direction is more perpendicular
to the view direction will tend towards Edge Color.

Edge Color lets you select a color from the palette. Edges are highlighted with the color
specified in Edge Color.

In the example below, the coloring is on and the color is white:
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l Background: Use the color picker to select a background color for your volume
display.

l When the Gradient Light option is on, the color gradient is drawn as a back-
ground for a scene. The Background color appears at the top of the window and the
second color appears at the bottom of the window.

l When the Show Image option is on, an image will be displayed on the background.
The position of the image is controlled in the Style drop-down box and the image file
can be selected using the Browse... button. The following image formats are sup-
ported: BMP.

l The Light button activates directional light and volume lighting. The drop-down
menu contains additional lighting and volume appearance options:
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These options only affect volumes displayed in Blended composition.

l Camera Light turns a light coming from approximately the same location as your cam-
era on or off.

l Directional Light turns on or off a light that you can position relative to the
volume itself. Use the Edit Directional Light menu item below to edit that light’s
position and intensity.

l Edit Directional Light: Clicking this button activates the directional light editor.
Note that this option is disabled when the Directional Light is off. Choosing this
option displays the Light Direction Editor, shown here:
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Use the handle to manipulate the light direction. The Edit menu allows you to
change the color using a color editor. The options are set to the default, always on
top.

l The Show Shadows option activates shadows on volume and scene elements.
Note that when the light is off, the shadow is cast from the headlight, which fol-
lows the camera. When the directional light is on, the shadow is cast by the cam-
era light, the position of which can be controlled using the Edit Directional
Light dialog.

Shadow OFF Shadows ON

l Shadow intensity and smoothness can be controlled using the corresponding con-
trols. Intensity is given in range from 0 (no shadow) to 1 (dark shadow). Higher
values of smoothness give smoother shadows.
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l Shadow screen can be used to show dropped shadows. You can control the
places where the shadow screens are shown (Y, Y, Z). You can also control the
color and the screen offset from the edges of the volume. Offset is defined in per-
cent of the volume size in the given direction.

l Pseudo Surface is a lighting effect that looks like a virtual surface created at the
threshold level of volume opacity. It gives a better result when the volume data
contain regional boundaries with relatively sharp gradients. Threshold defines the
opacity level for the Pseudo Surface in a range from 0 to 1. The default is 0.1.

l Material groups defines material properties of pseudo surface. The color of the sur-
face is calculated from a combination of 4 color components, each component is
in range from 0 to 1:

l Ambient - the color of an object where it is in shadow. This color is what the
object reflects when illuminated by ambient light rather than direct light.

l Diffuse - represents direct light hitting a surface. The Diffuse Light contribution is
dependent on the incident angle.

l Specular - the white highlight reflection seen on smooth, shiny objects. Specular
light is dependent on the direction of the light, the surface normal and the viewer
location. Specular component makes the object look like metal or glass. The reflec-
tion property is also defined by Shininess, with values close to 1 the reflections
will be very sharp as on polished metals, with lower values the radius of reflection
increases to make it look as brushed metal.

l Emissive - the self-illumination component of the color, has neon effect.

Pseudo Surface OFF Pseudo Surface ON
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Here are the examples of the Pseudo Surface mode with different Material properties con-
figurations:

Use the <Q> key to switch between rendering modes. There are two rendering methods
that support trade-offs between rendering speed and rendering quality:

l Sorted Blended Transparency
The default rendering mode, this features fast rendering, but may not accurately render
semi-transparent surfaces.

l Delayed Sorted Pixels Blended Transparency
A more complex rendering mode for complex scenes with semi-transparent objects.
Also more demanding of graphics resources.

Composition Group
The buttons in the Composition group define the image composition method.
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Blend: Blending averages the values of the voxels in a straight line through the
volume of the object.

Max:Maximum Intensity Projection takes the value of the brightest voxel in the
same straight line as used by the Blend option

Sum: This method displays the sum of the value of the voxels in a straight line. It is
most useful for dark images.

Min: Minimum Intensity Projection takes the value of the dimmest voxel in the same
straight line as used by the Blend option.

Some examples are shown here:

Blend Sum Max

Number of slices: This slider controls the number of slices drawn
for 3D and 2D multi-texture map rendering. Zero automatically selects the number of
slices. Rendering fewer slices will generally improve performance
(with reduced image quality).

376



Geometry Group

Geometry Group
The Geometry group defines the camera parameters:

Activates the perspective view.

Activates the orthogonal view.

In Perspective projection view, the parts of the volume closest to the viewer will look big-
ger; those that are further away will appear smaller. Switch the projection type to Ortho-
gonal to retain a cubic shape without perspective.

Clicking the Projection button sets the view to the last-selected projection, from
one of the following:

Sets the camera perspective to an XY projection.

Sets the camera perspective to a ZY projection.

Sets the camera perspective to an XZ projection.

The drop-down menu also includes a new feature: Wheels. Wheels shows or hides the in-
frame control for rotation wheels at the bottom and right side of the projection view. Use
the wheels to rotate the display along a single axis.

The bottom slider in the Geometry group is the View Angle slider:
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This slider adjusts characteristics of the camera’s virtual lens, which changes the angle that
defines the field of view of the camera. Changes to the field of view can indirectly make
your scene look larger or smaller. Changes to the viewing angle can also cause lens effects
like a “fish-eye” view of your scene if you are using the Perspective setting in the Geo-
metry group. The following illustrations may help to understand how the view angle
affects the rendering:

Note that the volume appears much smaller with the larger view angle. The following illus-
tration may explain why this happens:
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Viewing Angle: 45 °  Viewing Angle: 120 °

You can see with the wider field of view, from the greater viewing angle, that the same
size box looks much smaller, even though it is the same distance from the camera. You can
adjust for the change in the size of the scene by using the Zoom control to move the cam-
era closer to the volume. In that case, you can clearly see the “fish-eye” effect of the wide
angle lens:

Volume of Interest Group
The Volume of Interest group modifies the visible portion of the data volume in the Viewer
window. It contains the following controls:

379



Chapter 10

The Show VOI Axes button turns the VOI axes on or off.

Show VOI handles shows or hides the "dragger" associated with the VOI. The drag-
ger is used to move and resize the VOI.

To use the dragger tool:

1. First make sure the 3D Viewer window has focus (click in it if necessary).

2. Then make sure the Viewer is in selection mode (cursor is an arrow shape). If neces-
sary, click the Select icon in the Navigate group to switch to selection mode.

3. Click on the Show VOI handles button  to activate the VOI adjustment handles

To Resize the VOI:

1. Move the cursor onto one of the green handles

2. Press the left mouse button and drag. The VOI cannot be larger than the data volume.
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To Move the VOI:

1. Move the cursor onto one of the sides of the dragger box. The side of the VOI that
you click on will determine the axes along which the VOI can be moved. If you find
that you cannot move the VOI in the direction that you want to move it, try clicking
on an adjacent side of the VOI cube

2. Press the left mouse button and drag. The VOI cannot move outside the data volume.

The size of the VOI (XYZ) and the volume are given in spatially calibrated units. Volume
fraction shows the ratio between total volume of the image and the VOI.

You are able to copy and paste VOI extents from one 3D view to another using the Copy

and Paste buttons. You can also crop the volume to the VOI extents using the

Crop button.

The Reset button will reset the VOI to the full size of the data volume.

The sub-volume information is shown in the Reset button’s drop-down panel which also
has controls to set the VOI parameters by numbers. You can define start and size values for
X, Y and Z axis and then click the Set by Numbers button. When the option In Calibrated
Units is selected, the values are in calibrated units, otherwise in voxels.

The position and size of a VOI can be displayed in the status bar when the ROI extents
and ROI size are selected in the Status Bar options:

Sub-Volume: Choose a shape for the VOI (Volume of Interest) from the drop-down list.
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l Cross: The VOI will be displayed as a cross-shaped volume.

l Fence:  Displays a fence-shaped VOI.

l Exclusion box: The VOI can also be an exclusion box which specifies a region of the
volume that will not be displayed. This is very useful for cutting away part of the
volume.

Examples of the VOI shapes are shown here. The gray sections indicate which parts will
be visible in the Viewer:

                       Sub -Volume     Exclusion box

                      Cross                          Fence
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The 3D Measure Ribbon

The 3D Measure ribbon contains a variety of volume measurement tools for 3D analysis.

You may already be familiar with some of them.

Navigate Group
The Navigate group lets you choose between Selection and Viewing mode.

When View mode is selected, the mouse controls the camera position of the viewer. In this
mode, you can rotate, move, or zoom objects. In Select mode, you can select objects in 3D
view (slices, measurements (volumetric and manual), draggers,) and create manual meas-
urements. Using the <Ctrl> key while clicking the mouse will deselect any object.

TIP: You can switch between Select and View modes by holding down the <V> key.

Count Group
The Count feature lets you count specified volumes within the 3D image. Clicking the
Count Button executes volume segmentation and measurements on one of the volume
channels.

If the Count control is active, the 3D objects in an isosurface are remeasured every time
the threshold levels or isosurface parameters change.
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When you click the count button, you will see the following dialog:

Add isosurface: Here you can select which channel of a color image will be used to create
the isosurface. Your choices will depend on the volume that you have open:

l For monochrome volumes from a sequence and single-channel sets, your only choice
is a Gray channel from the monochrome data.

l For color volumes, you will have Red, Green and Blue channels that correspond to the
color components of the image.

l For single and multi-channel sets with channel information, there will be one volume
channel per set channel, using whatever channel names and tinting information is
available from the set metadata.

Sub sampling: The Subsampling group in this dialog is very important to understand, as it
affects the isosurfaces that are created. You can use subsampling to smooth out the isosur-
face that is generated, which will allow it to render and animate more quickly. However,
excessive subsampling can also result in removing smaller objects that you may wish to
visualize or measure, and subsampling will always affect the volumes of the objects that
may be measured later. For maximum accuracy, you will want to use Reset to make sure
that there is no isosurface subsampling.
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Auto: Selecting the Auto checkbox activates automatic subsampling mode. In this mode,
the subsampling is calculated based on the size of the image. This provides faster loading
and rendering of volume images. By default this option is on. Advanced users can switch
this option off and set subsampling manually.

Reset: Clicking the Reset button clears all your volume settings and sets 1:1:1 sub-
sampling. The Reset button is disabled when Auto is on.

Filters: Filters can be used to smooth the surface. Choose a filter from the drop-down list.
Excessive smoothing using Filters can also affect the accuracy of any 3D measurements
that you make, so use the minimum amount of filtering needed to get a representative
isosurface.

Threshold Type: The initial threshold level can be selected automatically when Threshold
type is defined as Auto Bright or Auto Dark.

Close edges: Select this check box close the surfaces of the objects where they touch the
bounding box of the volume.

When Close edges is turned on, the surface is closed on the sides that touch edges regard-
less their intensity value. (The edges must be closed to measure volumes.)

Execute Count: Check this box to execute the object segmentation count when an isosur-
face is created.

Auto-Split: Check to this box to split objects that are touching in two.

Ridge Size:When the Ridge size option is active, only narrow junctions with diameters
below the given size are split. Note that the split is also applied after adjusting the
threshold levels of the segmentation.

Your image will look something like this:
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This example shows that the green channel was selected for the count.

Information about the isosurfaces created by the Count operation appear in the options
panel on the right of the screen:

Counting the volume created an isosurface, which is represented by the Volume Surface
Green section of the 3D View options panel. When Execute Count is turned off, only one
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isosurface will be created.  Then you can adjust the Threshold levels interactively, and
execute the count by checking the Count check box:

The thresholds can be adjusted by clicking and/or dragging the start or end of the
threshold range on the histogram. There are a number of controls here that you can use to
fine-tune the segmentation of the isosurface, which are discussed in detail in the Add
Isosurface section later in this chapter. You can also edit it in the From or To controls.

When the Count option is turned off, the color of isosurface can be adjusted in the
Advanced Color drop-down:

Note that when Count is on, the colors of individual objects are controlled by the Col-
oring parameter in the 3D Measurement options. When Coloring is set to Parent the seg-
mented objects have the color of the isosurface. When the Coloring is set to Random, then
the color of every segmented object is selected randomly, but the transparency is taken
from the isosurface.

The results of the count operation are displayed in the Count Results group:

Volume Measurements Group
The Volume Measurements group provides a variety of measurements for volume analysis.
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The measurement types can be defined in the Types drop-down list.

Available measurements are grouped by types:

l Lines, either manually created or derived line or point measurements.

l Volumes are automatically segmented volume objects

l Object class, which can be applied to both Lines and Volume measurement objects.

Clicking the Add button adds one of the available measurements to the Selected
Measurements / Filters list.

Clicking the Add All button adds all of the available measurements to the Selected
Measurements / Filters list.

Clicking the Label button uses the name of the selected measurement as a label for a
given group of objects.

Clicking the Remove button deletes a specific measurement from the list of Selected Meas-
urements/Filters.
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Clicking the Clear button deletes all the measurements from the list of Selected Meas-
urements/Filters.

Clicking the Options button displays the Orientation Options dialog. Orientation meas-
urements are described later in this chapter.

Edit Range lets you make adjustments to the measurement ranges:

Min and Max filter values can be adjusted by dragging the corresponding markers on the
histogram or editing their numerical values. The number of objects in range/total objects
and percentage are shown below the histogram.

Ranges sets the filter range that can be applied to each measurement.  If a filter range is
set, objects with parameters below the minimum or above the maximum values are
excluded from the view. The filter ranges are used only when the Ranges option is active.

The VolumeMeasurements list includes the following measurements:

Volume indicates the volume of an object in calibrated units.

Surface area indicates the surface area of object in calibrated units.

Width shows the size of a bounding box in the X direction.
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Height shows the size of a bounding box in the Y direction.

Depth displays the size of a bounding box in the Z direction.

Center X indicates the X coordinate of the center of an object.

Center Y indicates the Y coordinate of the center of an object.

Center Z indicates the Z coordinate of the center of an object.

Center of mass X indicates the X coordinate of the center of mass of the object.

Center of mass Y indicates the Y coordinate of the center of mass of the object.

Center of mass Z indicates the Z coordinate of the center of mass of the
object.

Box Volume displays the volume of an object's bounding box:
(V = W * H * D).
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Box ratio displays the ratio between the maximum and minimum sizes of the
bounding box: R = Max / Min.

Volume fraction displays the ratio of an object's volume to the box
volume. R = Vobj / Vbox

Diameter displays the equivalent diameter of an object.

Sphericity displays the sphericity of object, calculated as 6 volumes of an object
divided by the equivalent diameter and surface area of the object. For spherical objects,
this parameter equals 1; for all other shapes it is less than 1.

Density (mean) indicates the mean density of an object.

Density (min) indicates the minimum density of an object

Density (max) indicates the maximum density of an object.

IOD displays the Integrated Optical Density of an object.
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Density (st.dev.) displays the standard deviation of the optical density of an
object.

Radius (max) indicates the maximum distance between an object's centroid and sur-
face.

Radius (min) displays the minimum distance between an object's centroid and
surface

Radius Ratio displays the ratio between the minimum and maximum radii.

Class shows the class to which an object belongs. The classification can be done
using the Histogram window.

Feret (max) indicates the maximum distance between two parallel planes
enclosing an object.

Feret (min) indicates the minimum distance between two parallel planes
enclosing an object.

Feret Ratio displays the ratio between Feret (max) and Feret (min).
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Alpha angle indicates the angle between the reference vector and surface normal
(in degrees).

Gamma angle indicates the angle between the Direction vector (Dir) and the
projection of the normal (Proj) to the plane created by the direction vector (Dir) and the
vector (Perp) perpendicular to Ref-Dir plane. The angle can range from -180 to 180
degrees.

Theta angle indicates the angle between the Reference vector (Ref) and the pro-
jection of the normal (Proj2) to the plane perpendicular to the Direction vector (Dir). The
angle can range from -180 to 180 degrees.

Surface deviation is calculated as the deviation of the end-points of triangular
normal. The calculations are done as follows: all triangular normal vectors of the surface
are normalized (length set to 1) and the average distance from the mean positions of the
end-points to all other vectors is calculated. A uniform surface will have deviation of 0.
The maximum deviation of 1.336 will have a sphere.

, Angle X, Y and Z indicate the angle between longest object
line (max feret) and the X, Y and Z axes in degrees.

The longest object line vectors can be visualized using the corresponding option in the
OrientationMeasurements Options dialog.

Holes and Negative Volumes

The current version of Image-Pro with 3D Module handles holes as if they are independent
objects. Holes are identified by negativeVolume measurement. By default, holes are
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filtered out by the measurement filters when Volume limits are set from 0 to 1E9. You can
disable or adjust the filters to display the holes.

Object measurements ignore holes. It is equivalent to using the Fill Holes options in the
2D measurements. If it’s important to exclude hole volumes from the parent objects, you

can do it by manually selecting the parent object and hole(s) and clicking the Merge
button. This will merge the outlines of the parent object with those of the holes which
will result in measurements that exclude the negative volumes of holes.

3D Measurement Type Options

Orientation measurement options can be set clicking the Options button on the Measure
Types dialog:

Orientation in 3D space can be defined using at least 2 angles from perpendicular vectors.
These angles are called Alpha and Gamma. Alpha is measured relatively to the Reference
vector and Gamma relatively to Direction vector.

The Reference vector is defined by the X, Y and Z components. The default vector of 0, 0,
1 is parallel to the Z axis. The alpha angle is calculated between this vector and the sur-
face normal.

The Direction vector is defined by the X, Y and Z components. The default vector of 0, 1,
0 is parallel to the Y axis. The gamma angle is calculated between this vector and the pro-
jection of the normal to the plane of the direction vector, and the vector perpendicular to
the plane is defined by reference and direction vectors.

Maximum angle between triangle normal and reference vector defines which areas (tri-
angles) of the object surface will be taken into account when calculating surface normal.
Every surface consists of triangles; every triangle has its own normal vector. If the angle
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between triangle’s normal and the reference vector exceeds the maximum angle range, the
triangle is excluded from the surface normal calculation. The default value is 80 degrees,
which excludes triangles on the sides of the object (angles around 90 degrees) and tri-
angles on the opposite side of the object (angles greater than 90 degrees). The maximum
value for this parameter is 180.

There are two methods provided to calculate the normal vector of surface:

l Average vector, which is calculated as area weighted average normal vector of all sur-
face triangles (within angle range). This method is relatively fast in calculation, but
sensitive to deviations on the surface orientation. Small bumps and pits on the surface
can slightly affect the vector.

l Median vector, where median vector from all triangles are selected as surface normal.
Median vector is the vector that has the minimum sum of distances to all other vec-
tors. This methods provides very stable results; as small bumps and pits on the surface
do not affect the result. The vector represents the normal direction of the surface which
covers most of the object. This method is very computation intensive, and can be
much slower than the Average method for large objects (if each object contains more
than 10000 triangles).

The Show Surface Normal vectors option hides or shows the surface normals on the
image.

The Show longest object line vectors option hides or shows the longest object lines that
are used to measure Angle X,Y and Z.

An example appears here:
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The colors of the normal vectors can be changed using the Selection color.

3D Options Panel
The 3D Options panel can be opened by clicking the 3D Options button in the Volume
Measurements group:

The 3D Options panel is shown here:

Appearance options

The Appearance options control Labels and Outlines.

Volume Text sets the appearance of measurement labels displayed on the 3d volume.

Manual Text sets the appearance of the manual measurement labels.

Both text combo-boxes indicates the type of labels. The labels can be:
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l None: No labels are displayed.

l Name: The measurement name is displayed.

l Measurement: The value of the first selected measurement will be displayed as a label
(you can drag any column in the data table to the fist position to be displayed as a
label).

Font sets the label font size.

Decimal defines the number of digits after the decimal point that will be displayed in the
data table and labels.

The Outlines group contains display options for the measurement elements.

Line width defines the width of lines for the manual measurements

Arrow Size defines the size of arrow line ends.

Sphere Size defines the size of sphere line ends for point measurements. When a manual
measurements feature (point, line, polyline) is selected, the points of the polyline are
shown as spheres in the selected color with boxes around them. If the viewer is in the
selection mode, and the selection mode of the manual measurements is active, the pos-
itions of the spheres can be edited by dragging the points to new positions.

Color and Selection define colors for normal and selected state of the elements.

The Spheres and Dragging boxes are switched off when the feature is deselected.

The Volume Objects group provides options for coloring.

The Coloring control defines what color the objects will have. Two choices are available:
Parent and Random. If Parent is selected, the objects inherit the color from the parent
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isosurface/volume measurements. If Random is selected, the colors for objects are generated
randomly, so every object has different color.

Measurements Group

The Measurements group shows, hides, or deletes the various manual measurements on the
image.

The Show button shows or hides any manual measurement objects on image. The
Show All group lets you show or hide selected measurement objects.

The object can be deleted using the Deleteselected or Delete Al l buttons.

Active Tool Group
This group defines the active tool that can be used to create manual measurements:

The available tools are:
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Select measurements allows you to select measurements on the image and also edit
the positions of external objects.

Add pointmeasurement activates the point tool.

Add line measurement activates the line tool. A line is added after 2 clicks.

Add polyline measurement activates the polyline tool. The line is added after you
click the right mouse button.

Add polygon measurement activates the polygon tool. Click on several points to
create the polygon. Click the right mouse button to close the shape.

Add anglemeasurements activates angle measurements. An angle is added after 3
clicks.

Add surface line along object surface connecting 2 points creates a poly-line feature
that connects 2 points going along the surface in the plane that passes through the selected
two points and the camera position.

Add an outline of object crossed by a plane creates a closed poly-line feature that is
an outline of a plane crossing an object. To add an outline, click twice on the imaginary
line along which you want to create the outline of the object. The outline plane passes
through the selected two points and through the position of viewing camera, so the outline
is always created in the plane perpendicular to the screen plane.

Split objects activates the split mode. To split a 3D object into 2 objects, click twice
on the imaginary splitting line of the object. The splitting plane passes through the selec-
ted two points and through the position of viewing camera, so the object is always split
with a plane perpendicular to the screen plane.

The Magic Wand tool enables you to draw polygons on slices. Clicking the
drop-down arrow displays this menu:
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l Range indicates the number of gray levels used for thresholding (combination of gray
ranges depends from type of active image and selected interpretation).

l Smoothing indicates the degree of post-filtering of the outline (0 – no filtering, 9 –
high degree smoothing).

Relative Measurements Group
Various other measurements can be created based on the selected measurements

Getcenterof the object creates a point measurement of the center of selected objects.

Measure distance between centers creates a manual measurement line that connects
centers of two selected objects.

Measure perpendicular distance between point and line creates a line measurement
between a point and a line as a perpendicular line. Note that the function is active only
when 1 line and 1 or more points are selected

Measure angle between lines creates an angle measurement between two lines. Note
that the function is active only when 2 lines are selected.

Measure distance between point and surface of volume object creates a line
between the selected point and a selected 3D object. The 3D object can be selected either
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in the Volume measurements data table or on the image itself, using the Select meas-
urements/select objects mode.

Measure distance between surfaces creates a manual measurement line between the
surfaces of two selected objects. This line represents the shortest distance between two
objects.

Split polyline into lines creates a new line measurement from every segment of the
selected poly-lines/tracks. Analyzing the length of every line provides information related
to velocity of the object moving along the track.

Create a polyline including points of all selected measurements creates a poly-line
that includes all points of the selected measurements. For example, if 2 lines were selected
the new poly-line would include 4 points.

Extract points from lines/polylines creates a new point measurement for every
coordinate of the selected poly-lines/tracks. It can provide information about object
coordinates on different time points (the same information can be obtained in the Volume
measurements data table).

Merge selected objects merges selected objects into one. It can be used if seg-
mentation does not allow connecting all the pieces that belong to one object.

Undo split/merge undoes the last split or merge operation. The number of undo
levels is practically unlimited.
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Guided Segmentation

Guided Segmentation is designed to allow 3D segmentation of complex objects that can-
not be easily segmented using threshold segmentation. Guided segmentation involves
defining the object outlines on a 2D view and then generating 3D volume objects from
those outlines. To activate this feature, click the Guided Segmentation button on the 3D
Measure ribbon:

The Guided Segmentation panel appears on the right hand side of the workspace:
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The panel contains four sub-panels:

l Collections

l 2D Segmentation

l Z-propagation

l Isosurface

To use Guided Segmentation, follow these steps:

1. Open a sequence in the workspace.

2. On the 3D Measure ribbon, press Guided to open the Guided Segmentation dialog.
Note that in the Collections sub-panel, a first object collection will already have been
created. If the volume that you want to segment opens in the 3D view, Image-Pro will
switch to the Image (2D) view for the process of drawing object outlines. If you
already had the Guided Segmentation panel open when you opened your sequence,

use the Image button ( ) in the status bar or Image Context menu, or the 2D but-
ton in the Collections sub-panel to switch to the 2D image view.

3. Navigate to any frame (or Z-plane) in the volume where the first object of interest is
visible. You can start at any plane in the Z-stack.

4. Use any tool in 2D Segmentation sub-panel to create one or more object outlines for
that object. See the documentation of the 2D Segmentation sub-panel for more details
about the tools that can be used to create the object outlines.

5. Once you have defined your outlines, use the Validate button to set those outlines as
the objects' ROIs.

6. In the Z-propagation sub-panel, choose a method to copy your outlines to other
frames in the z-stack.

7. Press the forward and/or back buttons in the Z-propagation sub-panel to extend the
object ROIs through the stack.

8. Lock the object collection by checking the box next to its name in the Collections
sub-panel. You may continue to add object collections by pressing the Add button in
the Collections sub-panel. Note that adding a new collection will automatically lock
the previous collection(s).

9. Repeat steps 4-9 for each collection to be added.

10. To view the collections in 3D, use one of the selections in the Isosurface sub-panel to
turn your collections into isosurfaces in the 3D Viewer.
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More information about each of these steps appears in the following pages.

Collections Sub-Panel
The Collections sub-panel of the Guided Segmentation panel contains tools to control col-
lections. It allows you to add and define certain properties, and to visualize segmented out-
lines interactively.

Segmentation collections are defined by a set of outlines on multiple frames. Multiple out-
lines can be defined for a single collection on one frame. A collection is identified by its
name and color, which can be edited in the table shown above.

Depending on your images, you may be able to define all your object outlines in a
single collection. Image-Pro with 3D Module includes support for multiple collections to
allow you to separate outlines that would otherwise cause incorrectly segmented objects.
This can be a problem if separate objects touch or intersect anywhere in your volume.
When the outlines are analyzed to create isosurfaces, separate outlines may be merged
into a single isosurface if in any frame of the sequence, the outline for an object overlaps
multiple outlines on an adjacent frame. This is necessary to be able to connect up Y-
shaped or branching objects. However, if separate objects touch, they may both be over-
lapped by the outline in the adjacent frame, and incorrectly merged. If this occurs, then
make a new collection and put the outlines for either of the objects in the new collection.

A new collection can be added clicking the Add button. The collection can be

deleted or reset . It can also be saved or loaded from a file. You can
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use the Delete All button to remove all the existing collections and start over. Note
that when all the collections are deleted, a new, default collection R1 is automatically
added.

The Lock option applies only to the active collection. It allows you to review the seg-
mentation without applying the active propagation method when scrolling through the
image sequence. It also controls whether editing tools are available, or if the collections
are locked. All collections except the active one will always show a locked state, and the
active row can be locked or unlocked by clicking the check box. Checking the Lock
check box freezes the selected collection and prevents additional editing until the col-
lection is unlocked. Note that the 2D Segmentation and Z-propagation sub-panels will
include the name of the active collection.

Multiple collections can be displayed on the image when the Show All Collections box is
checked. When this option is off, only the active object ROI will be displayed.

Display of the collections’ labels is controlled by the Show labels check box. Note that
the size and font of the labels can be controlled from the measurement options panel.

The Frames column shows the number of frames in the sequence.

The View buttons are used to display the view(s) that you would like to have visible
while defining the object outlines and isosurfaces. The 2D button will open a new view of
your volume in the Image view if there is not already an Image view open, and it will
make that view the active workspace view. The 3D button will open a new view of your
volume in the 3D view if necessary, and it will make that view the active workspace view.
The 2D / 3D button will make sure that both views are open, and display them in a split
workspace layout with the 2D view on the left and the 3D view on the right.

Outline color allows you to change the color of the object’s outline using the color
selector. When this option is off, only the outlines for the active collection will be dis-
played.

Volume objects can also be exported as outlines from the 3D Data Table to Guided
Segmentation using the Export Outlines menu item from the context menu over the 3D
Data Table object row.

2D Segmentation Sub-panel
The 2D Segmentation sub-panel offers 3 main modes of operation that enable different
methods that you can use for defining the object outlines:
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The three modes are:

l Wand, where you will primarily use the Magic Wand tool to define the outlines by
outlining an area based on the color similarities or difference of intensity ranges
between the pixel under your cursor, plus or minus a specified tolerance interval.

l Smart, where you will use the Smart Segmentation tools to define the outlines by
defining reference areas for background versus objects.

l ROI, where you will primarily use manual tools to draw the object outlines.

These modes will be discussed in detail in upcoming sections of this chapter. In all three
modes, there are tools available to define and refine the object outlines:

The 2D Segmentation sub-panel provides the following tools for all modes:

Use the Selection Tool arrow to select an ROI on the image.

The Polygon Nudge tool allows you to adjust the size and shape of irregular ROIs
and measurements

The Polygon tool allows you define a polygon-shaped or freeform ROI in the
image.
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Use the Delete buttons to delete the selected outline(s), or all outlines. Note that
you can also use the Delete key to delete the selected outline(s).

Magic Wand Mode

You can define object outlines by selecting the Wand tab and clicking on the object to
segment.

After the first click on the image, the threshold range will be displayed in the Histogram
control. You can adjust intensity range of the Magic Wand using the From and To con-
trols or by dragging the range indicators on the histogram. You can also use additional
magic wand controls to adjust the automatic outlining: Range, Filter, Smoothing and Fill
Holes.

l Ranges. Indicates the lower and upper levels used for thresholding.

l Filter: Defines the minimum object area in square pixels.

l Smoothing: Indicates the degree of smoothing that is applied to the object outline (0
= no smoothing, 9 = maximum smoothing).

l Fill Holes: Check this box to automatically fill any holes in the outline.

When you are satisfied with the outlines and the range, click the Validate button. That
will convert the magic wand outline to an ROI and add it to the active object. Note that
the defined intensity range will be then used to create outlines on other frames with the
Auto-Range propagation method.

Smart Segmentation Mode
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Use the Smart Segmentation tab to create objects. This method can be used on noisy
objects where the Magic Wand has difficulties creating outlines.

Select the Smart tab to define the segmentation recipe parameters and draw reference
objects and background areas. When you enter Smart Segmentation mode, the Smart Seg-
mentation sub-panel will be displayed, along with a balloon message:

This message balloon will stay active while you set up the Smart Segmentation recipe in
the Smart Segmentation panel. (More information about Smart Segmentation appears in
Chapter 8 of this manual and in the in-product Help.)

When you click OK, whichever objects have been identified by the Select Object tool will
be added to the collection of outlines.

Filter defines the minimum object area in square pixels.

Smoothing is applied to the object outline (0 = no smoothing, 9 = maximum smoothing).

Note that if you want to modify the recipe going through frames, use the Modify Recipe
button.

You can also add new outlines to the frame in Smart mode by following these steps:

1. Make sure that the Auto-Smart propagation mode is selected in the Z-Propagation
sub-panel.
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2. Select the Polygon drawing tool and draw one or more ROIs in areas that should be
identified as objects. These ROIs can be very rough as they only need to overlap the
area detected by the Smart Segmentation.

3. Click the Validate button. One new object will be created for each ROI that overlaps
the smart segmentation mask.

ROI Mode

If you prefer creating object outlines manually, you can switch to the ROI tab. When you
are in ROI mode, clicking the Validate button reads the intensity range within the
region’s outlines, which can be used for other frames when you choose the Auto-Range
propagation method.

The following options will be applied when detecting regions using the Auto-Range
propagation:

l Filter defines the minimum object area in square pixels.

l Smoothing is applied to the object outline (0 = no smoothing, 9 = maximum
smoothing).

Z-Propagation
The Z-Propagation sub-panel offers you options for propagating the 2D objects from a par-
ticular frame across other frames in Z-space. The available options depend on the 2D seg-
mentation type. Options that are not available for a particular 2D segmentation type are
shown as inactive: 

409



Chapter 10

Use the arrow buttons to navigate through the image stack. The spin controls indicate how
many frames you advance each time. The following methods are used to create outlines on
new frames:

l None: Advancing to a new frame will not add any new outlines to the next frame, or
change any existing outlines. Use this method to review the outlines that you’ve
defined so far, and also when the object outlines on neighboring frames are very dif-
ferent, and you want to draw outlines on every frame manually.

l Duplicate: Changing the frame will duplicate object outlines from the previously act-
ive frame.

l Auto-Range: Detects an object on a new frame that overlaps with the outline on the
previous frame, using the same intensity threshold range. This propagation method is
available when you are using the Wand or ROI modes.

l Auto-Smart: Detects an object on new frame using global smart segmentation recipe.
It will identify any overlapping outlines. This propagation method is available when
you are using Smart mode.

You can use any tool from the 2D Segmentation sub-panel on any frame to redefine intens-
ity ranges, smart segmentation recipe or modify the outlines. Any change of method will
be repeated throughout the stack.

Use the Forward and Back button to go through the stack by one step at a
time. If you use the Auto-Range or Auto-Smart method, and are going through the stack

to create correct outlines, you can automate this process using the Detect Forward

and/or Detect Back button to go through the all frames in the stack automatically.
The detection will stop automatically when no more overlapping objects are detected. You
can also stop the auto-detection process manually pressing the <Esc> key.
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Object outlines will be automatically detected using the last segmentation recipe. If the
object detection is not satisfactory on some frames, the outlines on those frames can be
adjusted or re-drawn with the 2D Segmentation tools.

If you are using Smart segmentation, try adjusting the recipe by adding new reference or
background objects and click OK.

Note that when you draw outlines manually or edit them, the intensity range within the
object’s outlines will be used for other frames when you choose the Auto-Range propaga-
tion method. After adjusting the outline manually, click the Validate button to accept the
changes. Note that the outline is automatically validated clicking by the Forward or Back
button

Isosurface
The Isosurface sub-panel allows you to create isosurfaces on selected objects by con-
necting the 2D segmented areas across the Z-planes.  When all object outlines are created,
use the Isosurface group to add 3D objects as isosurfaces to the 3D view.

You can add only the active collection using the Add Active button (which contains the
name of the active collection, for instance Add R1 in the illustration above). Clicking the
Add All button will add isosurfaces for all of the defined collections. You can set the sub-
sampling and smoothing to use during isosurface creation (see the more detailed discussion
of these settings in the Add Isosurface section later in this chapter).
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Every object in each collection will be segmented and measured. The values appear in the
data table.

If you have an existing isosurface node and the Create new isosurface option is not
checked, the new objects will be added to that existing isosurface. If there are no existing
isosurface nodes, or the Create new isosurface option is checked, then a new isosurface
named Guided Segmentation will be created with the new objects.

The outlines can be viewed in the Slicer by view activating the Show Outlines option:
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View Group

The View group allows you to see the 3D data in different formats:

These tables contain the same features and functions as the tables and graphs described in
Chapters 4 and 8 of this manual.

The Data Table collects all the information from the measurements taken on your image.
The 3D data table shows measurement values for manual and segmented 3D objects.

Load Data Table Measurements: This tool allows you to load meas-
urements saved in a previous session from a *.ipm file.
Save Data Table Measurements: This tool allows you to save your
measurements in a *.ipm file for use at another time.

Send Measurements to File: This tool allows you to save your meas-
urement data to a file or export it to an Excel spreadsheet. The pull-
down menu  lets you choose one of the following:
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Send to Report: This tool allows you to save your measurement data
to Image-Pro report. The pull-down menu lets you create a new report
or choose an existing one.
Show all Statistics: This tool allows you to hide or show the statistics
panel for the data table measurements. A sample statistics panel is
shown here:

The drop-down option Statistics per Group defines what is displayed
in the statistical pane. When this option is off, the statistics of all vis-
ible features is shown. When the option is on, the statistical values are
shown per group. This option has affect only when Grouping is active
Setup Group Statistics display the statistics by group.  It will activate
grouping by class, add Percent Area Parent to the list of measurements
and activate statistics per group
Grouping: Click this button to see options for grouping your data in
the table. You can choose one of the following:

Show All, Show Selected Measurements, Hide Selected
Measurements: These tools let you choose to display or hide some of the meas-
urement statistics.

3D Mask: Click this button to create a mask of volume objects.
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The 3D Data Histogram illustrates, in graph form, the distribution of 3D measurements for
the selected measurement:

The Object Window allows you to view information about a specific object in an image.
The example below shows complete data for one object:
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3D Options

The 3D Options panel on the right-hand side of the workspace contains the following con-
trols:

All of the Add buttons add nodes to the 3D view that contribute to the rendering of your
volume.

Add Isosurface/Volume measurement: Isosurfaces provide a very quick, yet often suf-
ficient, method for reconstructing polygonal surface models. By correlating transparency
with the local orientation of the surface relative to the viewing direction, complex spatial
structures can be understood much more easily.

Delete: Click this button to remove the selected node.

Add Ortho Slice: Clicking this button adds individual ortho slices to the ND projection.
Ortho Slices are used to display a slice through the X, Y, or Z axis orientation in the 3D
Viewer. Voxels on the plane of the slice will appear as a different color.

Each slice can have a different color outline. This can be useful for identifying slices on
complex scenes with multiple elements (oblique, ortho slices). The visibility and the color
of the outline can be set using the Outline control.

Add Oblique Slice: Oblique slices are used to display slices of the volume which are not
precisely aligned with the X, Y, or Z axes.

Add External Object: External objects are isosurface coordinate links that can be imported
into the 3D Viewer.

Expand/Collapse all nodes: Click the plus sign to expand the channels and nodes. Click
the minus sign to collapse them.

The rest of the 3D View panel displays the rendering nodes that currently exist in your 3D
visualization:
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Color Image: All channels are loaded into an indexed color volume (The sequence is con-
verted to a palette class using a palette containing the most popular colors in the
sequence).

Channels: The channels node represents the visualization of the volume intensities. The
drop-down box will only be enabled for multi-channel volumes, and controls the way that
the channels are combined in the volume rendering. Clicking the drop-down arrow dis-
plays the following options:

l Max:  Maximum Intensity Projection takes the value of the brightest voxel in the
same straight line as used by the Blend option.

l Blend: Blending averages the values of the voxels in a straight line through the
volume of the object.

l Min:   Minimum Intensity Projection takes the value of the dimmest voxel in the
same straight line as used by the Blend option.

Each channel of your volume will have a sub-node for the channel, with a name derived
from the channel name (if the volume is a multi-channel set), the color component (of a
color image), or “Gray” for monochrome images. Each channel or color component’s ren-
dering can be adjusted with the following control panel:
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The Show button hides or shows the selected element. Every node in the 3D View
panel has this button, which lets you select which nodes are visible, and are included in
the 3D rendering.

Every channel is shown using a palette that is scaled from 0 to 255 covering the whole
dynamic range of the channel data. The All Channel Display controls will change
PaletteSpread and Opacity range on all channels.

The Blinking icon control activates the blinking mode of the channel.

The Palette can be one of the following:

l Wavelength allows you to display wavelength in nanometers.

l Color lets you select any color using the color picker.

l Palette allows you to select one of predefined palettes displaying the channel.

l Custom
Selecting Custom palette allows creating user-defined color combinations:

Palette points can be added by clicking on the histogram area. Clicking the
existing point makes this point active and allows selecting the color using
the color-picker button. Positions of palette points can be adjusted by mouse.
The Y position of the point defines opacity of the color, higher position –
higher opacity. Ctrl-Click on the existing point will delete the point. Custom
palettes can be saved to a file (pal3D format) and loaded (iqpal, pal3D) using
the Save and Load buttons.

Histogram: Activating the Histogram option allows you to set the Spread and Opaque
levels on a volume histogram. The Spread limits are controlled by the top controls and the
Opaque limits are controlled by the bottom ones.</p>

Activating the Histogram option allows you to set the Spread and Opaque levels on
a volume histogram. Spread defines the start and end positions for palette spread and the
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Opaque control defines the range of intensities that are visible. The values outside the
Opaque range are transparent. The Spread limits are controlled by the top controls and the
Opaque limits are controlled by the bottom ones.

The Histogram view is the default view for the Spread and Opacity controls, but you can
turn this view off to edit the limits directly,

The Best-Fit button ( ) can be used to set the Spread and Opacity values to a best-fit
display of the volume.

The Reset button ( ) can be used to reset the Spread and Opacity values to the min-
imum and maximum intensities.

Add Isosurface

Isosurfaces/volume measurements provide a very quick, yet often sufficient, method for
reconstructing polygonal surface models. By correlating transparency with the local
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orientation of the surface relative to the viewing direction, complex spatial structures can
be understood much more easily. If you are making volumetric measurements, you will
need to define at least one isosurface/volume measurement.

Automatic segmentation of 3D objects can be done using 2 different tools:

- Add Volume Measurements

- Add Iso-Surface

The Add Iso-Surface segmentation is based on iso-surface, which is generated using the
Marching cubes algorithm with consequent labeling of mesh triangles (we will call it Iso-
Surface segmentation). The Add Volume Measurements uses segmentation creating
objects directly based on voxel connectivity data, without generation of iso-surfaces (we
will call it Direct Volume Segmentation).

Both methods have their advantages, which will be compared here:

Advantages of Direct Volume Segmentation over Iso-Surface segmentation:

1. Lower memory usage. Since no iso-surface is generated, the memory requirements for dir-
ect segmentation is much lower than for the iso-surface segmentation, which allows seg-
menting larger volumes.

2. Faster segmentation. The segmentation is applied to a 3D volume directly, the
algorithm uses a single pass labeling, which significantly speeds up the segmentation, up
to 100 times on complex volumes.

3. Holes handling. Direct segmentation algorithm handles holes according to the Fill
Holes option, which allows user to decide if they want to include or exclude the holes
from segmented objects. Generated Hole measurements (Hole Count, Hole Volume and
Hole Volume Ratio) are available only for directly segmented objects. The iso-surface seg-
mentation handles holes differently, the holes are always included into the surface object
measurements, no Hole measurements are generated.

Drawbacks of Direct Volume Segmentation over Iso-Surface segmentation.

When Direct Volume Segmentation is used no iso-surface is generated, which leads to
some drawbacks.
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1. The segmented objects cannot be saved as 3D models to IV, WRL or STL files. If you
need to have a 3D model file, you should use iso-surtface segmentation.

2. Derived measurements that use volume objects, such as Distance between surfaces,
Point to Surface are not available for Direct Volume Segmentation.

3. Pixelated visualization. Visualization of 3D objects are done using shader rendering on
GPU, so it misses some smoothing effects of triangular mesh iso-surface rendering. You can
change material appearance of segmented objects using Pseudo Surface tools, such as
pseudo-surface material or using the Voxelize option in the Interpolation drop-down. If
object visualization is important, you should use the iso-surface segmentation.

4. Clipping planes created by ortho and oblique slices can clip iso-surface objects and
volume independently, depending on the position of the slice relatively to the iso-surface
element in the options tree, so volume can be clipped, but the surface not. With Direct
Volume Segmentation both Volume Channels and Segmented objects are clipped in the
same manner.

Multiple isosurfaces can be added clicking the Add Isosurface button in the options
panel.

Note that the same action can be performed from the 3D Measure tab by clicking the
Count button.

When you add a volume measurement, you will see this dialog:
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Here you can select which channel of the volume will be used to create the isosurface.

You can select the desired subsampling. The Auto subsampling is selected by default.

Filters can be used to smooth the surface. A filter can be selected from the following list:

l None

l LoPass 3x3x3

l LoPass 5x5x5,

l LoPass 7x7x7

l LoPass 9x9x9

l Gauss 5x5x5

l Gauss 7x7x7

l Gauss 9x9x9.

The initial threshold level can be selected automatically when the Thresholdtype is
defined as Auto Bright or Auto Dark.

Close Edges will close surface edges on the volume boundary.

Fill Holes option is on, the holes are included into the measurements of the segmented
objects.

If Clean borders is on selected the objects that touch the bounding box of the volume are
excluded from the analyzing.

The segmentation with default options has advantages on memory consumption and speed
over iso-surface segmentation, and if user wants to get even better performance measuring
the volume, there are additional options available clicking the Advanced button.
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The Activate pseudo surface options check-box makes the best visualization options for
direct segmentation surfaces active automatically. When this option is on, the volume visu-
alization is automatically switches to the Pseudo Surface mode.

The option Create Preview volume defines creation of the visualization volume for
threshold adjustment preview. You can switch this option off to save RAM, in that case
threshold preview will be generated on the original volume channel and may look slightly
different from the segmented volume as they may have different sub-sampling and filter
options.

When the Create segmentation volume is on, the segmented objects are shown in dif-
ferent colors on the volume. If user just want to have measurements and the visualization is
not important, this option can be switched off to save more RAM. Note, that all meas-
urements will still be generated properly and object volume boxes will be displayed for
selected objects. When this option is off user can show equivalent spheres instead of the
proper outline by activating the Show object equivalent spheres option, spheres display
takes less RAM then the segmentation volume and can be used to handle large volumes
when Create preview volume and Create segmentation volume options are off.

Execute Count will automatically execute the object segmentation count when an isosur-
face is created. When Execute Count is off, only the isosurface will be created, so you can
then adjust the Threshold levels interactively. Start the count by checking the Count but-
ton:

The thresholds can be adjusted by clicking and dragging at the start or end of the
threshold range on the histogram, or editing it in the From or To controls.

When Count is turned off, the color of the isosurface can be adjusted in the Color drop-
down:
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Note that when Count is on, the colors of individual objects are controlled by the Col-
oring parameter of the 3D Measurement options. When Coloring is set to
Parent the segmented objects are the same color as the isosurface. When the Coloring is
set to Random, then the color of every segmented object is selected randomly, but the
transparency is taken from the isosurface.

Clicking the Options button allows you to edit the surface parameters: subsampling and
filtering the auto-threshold:

Using Add Iso-Surface button, the iso-surface based segmentation can be created.
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The Precision control defines whether surface outlines of 3D object are created with Sub-
voxel or Voxel granularity. The default option is Sub-voxel. This option allows creating
smooth surface outlines that can be created in sub-voxel space and the position of this out-
line depends how close the threshold value is to the intensity value of the voxel.

When the Voxel option is active the surface outlines and all volumetric measurements are
build from voxel cubes. Voxels with intensity above or equal the threshold level are com-
pletely included into the object.

The following element added clicking the Ok button:

The visible volume measurement objects can be exported to an IV file by clicking the
Export button. 
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It is possible to import volume objects using the Import button. This option can be used,
for example, when you have segmented objects on one channel and want to measure
intensities within these outlines on another channel.

When the outline is imported, the channel mode changes to outline where the Count
option is always active:

To return to the interactive segmentation mode, click the Reset Outline button.

Add Colocalization

Colocalization measurements with independent threshold levels can be added using the
Add 3D Colocalization Measurements and Add 3D Colocalization Iso-Surface buttons.
Both actions will create colocalization measurements, the difference is the same as for
volume measurements and iso-surface, the first one creates colocalization using direct
volume segmentation and the second - using iso-surface segmentation.

3D Colocalization in Image-Pro with 3D Module requires a separate license. If you do
not have a license for this option, you will see the following message:

Please contact your Media Cybernetics representative for additional information.
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Clicking the button shows the dialog where you can define the colocalization pair and
also the initial auto-threshold method:

The default method is Auto-Bright.

Clicking the Ok button creates a new Colocalization measurement and opens the coloc-
alization panel with colocalization scatterplot and the table with colocalization para-
meters. The histogram window shows the intensity distribution for two channels.
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Colocalization thresholds can be adjusted for each channel independently using Channel 1
and Channel 2 numeric controls, dragging threshold levels on histogram or clicking on
scatterplot. The colocalization objects and measures are updated automatically.

It is also possible to use Free ROI tools to define colocalization areas on the scatterplot,
the colocalization objects get updated after creation or adjusting of ROIs. Note, that adjust-
ing thresholds on histogram switches colocalization mode to “Thresholds”.

3D view may include multiple colocalization pairs. The colocalization panel shows results
for the active colocalization pair. To activate the pair click the Colocalization button.
When the Count option is active, colocalization measurements can be reported for every
object. To add colocalization to the list of selected measurements, click the Add Measures
button. The measures will be added to the list and shown in the data table.

Add Ortho Slices

Ortho Slices are used to display a slice through the X, Y, or Z plane orientation in the 3D
Viewer. Voxels on the plane of the slice will appear as a different color.

You can add multiple ortho-slices by clicking the Add Ortho Slice button.
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If the Show control is on for Ortho Slice, an orthogonal slice is shown on the volume.

Orientation selects one of three ortho slices, aligned with the X, Y or Z axis.

Clipping enables the clipping plane associated with the slice. The clipping plane will clip
off rendering of the volume channels on one side or the other of the clipping plane. The
clipping side can be set to either Front or Back. The clipping plane has no effect if the
slice is not visible.

The Handles controls visibility of the "dragger" associated with the ortho slice. The drag-
ger is a 3D user interface gadget that can be used to drag the slice through the data
volume. To use the dragger make sure the viewer is in selection mode (cursor is an arrow
shape). Move the cursor onto the white cylinder, press the left mouse button, and drag to
move the slice.

You can also drag slices just by clicking and dragging the slice itself.

Slice composition is set by the dropdown and can be Opaque, Bin-
ary or Transparent. Binary means that voxels with non-zero alpha values are completely
opaque and voxels with zero-alpha values are completely transparent. In addition the drop-
down contains control to define Transparency of the slice affects the slice display in
Opaque and Binary modes. In addition the drop-down contains the Transparency % con-
trol to define the Transparency of the slice, which also affects the slice display in Opaque
and Binary modes.
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Slice Number shows the slice number where the slice is currently positioned. It can also
be used to drag the slice through the data volume. The slice is moved dynamically as the
slider moves. You may also type a slice number in the edit box.

Smooth switches on linear interpolation on the slice, thus increasing the visible resolution.

Add Oblique Slices

Oblique slices are used to display slices of the volume which are not precisely aligned
with the X, Y, or Z plane. Multiple oblique slices can be added by clicking the
Add Oblique Slice button in the panel.

The program can display an "oblique" (arbitrary orientation) slice through the data volume.

Slice position controls the slice position along the normal vector of the slice plane.

Alpha and Beta angles control orientation of the oblique slice plane, which can also be

adjusted interactively using the slice handles (see the following illustration):
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The dragger is a 3D user interface feature that can be used to drag the slice through the
data volume and change the orientation of the slice. To use the dragger make sure the
viewer is in selection mode (cursor is an arrow shape). Move the cursor onto the white cyl-
inder, press the left mouse button and drag to move the slice. Move the cursor onto one of
the white lines, press the left mouse button, and drag to rotate the slice.
You can also drag slices just by clicking and dragging the slice itself.

Clipping enables the clipping plane associated with the slice. The clipping plane has no
effect if the slice is not visible.

Slice Number shows the slice number where the slice is currently positioned. It can also
be used to drag the slice through the data volume. The slice is moved dynamically as the
slider moves. You may also type a slice number in the edit box.

Smooth switches on linear interpolation on the slice, thus increasing the visible resolution.

Slice composition is set by the dropdown and can be Opaque, Bin-
ary or Transparent. Binary means that voxels with non-zero alpha values are completely
opaque and voxels with zero-alpha values are completely transparent. In addition the drop-
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down contains control to define Transparency of the slice affects the slice display in
Opaque and Binary modes. In addition the drop-down contains the Transparency % con-
trol to define the Transparency of the slice, which also affects the slice display in Opaque
and Binary modes.

Each slice can have a different color outline.  This is useful for identifying slices on com-
plex scene with multiple elements (oblique, ortho slices). The visibility and the color of
the outline can be set using the Outline control.

Add External Objects

External objects are isosurface coordinate links that can be imported into the 3D Viewer.
Multiple external objects can be loaded from files by selecting the Add External Object
button in the panel.

The loaded external object can be edited by clicking on it in Select mode. Use the dragger
to scale, rotate and move the object.

Tip: Holding down <Ctrl>+<Shift> allows you to adjust the dimensions inde-
pendently.

Clicking the object again will hide the draggers.
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The 3D Slicer Ribbon

Image-Pro with 3D Module includes an advanced Slicer view in the available toolbars. To
use the Slicer tools, click the Slice viewer button on the Image tab. The Slice viewer
allows you to add up to 3 additional views of the volume from different orthogonal dir-
ections. A Slicer tab appears on the ribbon.

The 3D Slicer ribbon looks like this:

The View group shows the volume using three different modes (thin slices, thick slices or
projections), volume object outlines, and manual measurements

An example of the Slicer view with XY, YZ, XZ and 3D views all displayed appears on
here:

You can control the layout of the Slice Viewer using the tools in the Layout drop-down
menu in the View group:
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The layout can include one, two, or three of the volumes and projections. For example, if
you select the XZ, 3D and XYZ, 3Dviews, the workspace will look something like this:

XZ 3D Projection                                     XYZ 3D Projection

The XZ3D projection is on the left, while the XYZ 3D projection is on the right.
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In addition to the layout selections, the View ribbon group contains other controls:

l Cross turns the crosshairs on the slicer views on or off. The color of the cross can be
selected using the color-picker control.

l Outlines turns the Volume Object outlines on or off. The option can be used to see out-
lines of volume objects on 3D slices.  Note that only the outlines for Counted objects
are shown (execute Count to see the outlines). The thickness of the outlines is defined
by Line width parameter of 3D measurement options.

l Sliders turns the slider controls for each of 3D slicer views on or off (the default is
on). These controls appear on the sides of the panels in the workspace. The control can
be used to adjust a displayed slice position in the corresponding view. Note that the
slice position can also be adjusted by using the Slicer Position controls on the Slicer
ribbon, or by using the Navigate tools and clicking on any of the slicer views.

Slicer views can be zoomed using the mouse wheel or <Alt>+mousemove and translated
using the <Alt>+< Shift > + mouse move combination. The views can be reset to the ori-

ginal state (best-fit) using the Reset views button.

The drop-down menu of the Reset button contains controls that set the slice transparency.

Setting slice transparency to non-zero values allows the program to display manual meas-
urement elements behind the slice in thin slice mode.

The Slicer Position group contains three Extract buttons that allow you to extract the
XY, ZY and XZ views into a new image.

The Thickness group defines the display mode for 3D slicer views:
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l Thin: The view is displayed as a thin orthogonal slice. The slice can be semi-trans-
parent based on the Thin slice transparency option.

l Thick: The view is displayed as thick slice including multiple slices. The thickness of
the slices is defined by the corresponded numerical controls. The transparency of thick
slices is defined by the main transparency control (on 3D view tab).

l Projections: Projections of all slices are shown. The view uses current composition
and can be shown as maximum or minimum intensity projections (as well as blend and
sum).

l X, Y, Z: You can set the thickness of the slices by using the spin buttons.

Use <Ctrl>+ mouse click to add manual measurements on the slicer views. Clicking the
mouse button without the <Ctrl> key will change the slicer position.

Measurements created on a 3D view are also displayed on slicer views.

Note that all added 3D elements (slices, isosurfaces) can be rearranged by dragging and
dropping them to a new position. It can be used to define proper clipping of one element
by another, as slices can only clip isosurfaces and other slices located below the given
slice in the scene.
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The 3D Animation Ribbon

The Animation tab contains the tools for creating simple animations and movie files. The
Animation feature allows you to create, record, and play animation files (*.anm) in the
Image-Pro3D workspace.

The animation tools are described in the following pages.

Timeline Group
The Timeline feature lets you synch your animation in time and space. The timeline panel
shows the current animation with thumbnails of the key frames, and allows you to play
and edit the animation sequence.

The timeline panel will open automatically at the bottom of the page when you activate
the 3D Animation ribbon.

The individual frames in your animated image are synched to the locations along the time
line. The x-axis of the timeline represents the time of each key frame in the overall dur-
ation of the movie. The following controls are displayed in the status bar.

The X axis can be labeled as Frames or Time (s).
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Clicking on any position in the timeline will change the current position in the timeline,
and will activate the given camera position in 3D view. The current position is indicated
by a dotted line, as you can see at frame 20 of the Animation timeline in the previous fig-
ure. Note that the current position is very important when adding key frames to the anim-
ation. The timeline can be zoomed in or out using the zoom controls or the mouse wheel.
The number of key frames can be adjusted by dragging the key frame separators.

Timeline editing is done by adding or deleting key frames. Each key frame is indicated by
a blue pointer at the top of the timeline. Multiple key frames can be selected by clicking
on or before the first key frame, and then using <Shift>+<Click> on the last key frame.
Multiple key frames can be selected using <Shift> +<Click>. The selected range can be
then deleted by clicking the Delete button.

Animation Path Group
The Animation Path group lets you insert camera animations into your timeline with a
single click.

l The Spin button allows you to add a sequence of frames rotating the camera around
the screen axis (Vertical-Y, Horizontal-X, and Perpendicular to the screen – Z). The
drop-down menu contains buttons to rotate the camera around 3 axes in both dir-
ections by the given angle defined by 90,180 and 360 radio-buttons. The number of
intermediate frames for a 360-degree spin is defined by the Circular Frames option in
the Options group.

l The Fly-Around button allows you to add a series of frames by moving the camera in
an evenly spaced, circular path parallel to the Viewer window, and half-way between
the two sides of the window. The Fly Around rotations are created around the world
axis. World axes are X, Y and Z and can be visualized by activating the Axes button
on 3D View tab. Fly Around animation gives the effect of helicopter flight.

l The center options let you choose amount of rotation for both the Spin and Fly-
Around selections. To go completely around your screen or volume one full turn, use
360 degrees, or 90 degrees to go only ¼ of the way around.
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l Rocking or “see-saw” animation. This animation rocks the image around the vertical
axis back and forth by approximately 30 degrees. Clicking this button displays the fol-
lowing dialog:

The Rotation axis group defines the screen rotation axis. The Sweep angle and Num-
ber of steps controls define the amplitude of rocking and the number of intermediate
frames.

l Custom lets you design a custom animation by selecting time points and camera pos-
itions. You will see this dialog:

Clicking the Screen radio button allows you to create fast transitions by rotating the
camera around the screen axis (Vertical-Y, Horizontal-X, and Perpendicular to the
screen – Z).
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Clicking the World axis radio button let you create animation by activating the Axes
button on 3D View tab. World animation gives effect of helicopter flight.

The Sweep angle and Number of steps controls define the amplitude of the animation
sweeps and the number of intermediate frames.

You can rotate your animation around the X, Y, or Z-axis, by clicking the drop-down
menu button and displaying these items

To save an animation path, click the Save button and select path and name for the
animation file. Saved animations can be loaded using the Load button. The Copy but-
ton does not work directly with you animation timeline, but will copy the current 3D
view of the volume to the clipboard as a picture that can be inserted into a present-
ation or document.

Frames Group
The Frames group gives you tools for managing the key frames in your animation, as well
as spacing between the individual frames.
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Clicking the Add Camera Position button adds the current camera position (and
any changes to the view) as a new key frame at the current position within the animation
timeline.

Replace camera position replaces the current key frame with the current camera pos-
ition (and any changes to the view).

The Key spin box indicates the current key frame number.

The Inter spin button indicates the number of intermediate fames and camera positions in
the key frame. You can adjust or edit the number of intermediate frames by using the spin
button, or by dragging the key frame handle on the timeline.

Click the Delete button to delete the active key frame and its intermediate frames.

Click the Clear button to delete all key frames and clear the animation timeline.

Click this button to double the number of intermediate frames at all camera positions.

Click this button to halve the number of intermediate frames at all camera positions.

Playback Group
The Playback group lets you play your animation forward and backward. It also controls
the playback rate in Frames Per Second (FPS).
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The toolbar has the following buttons:

Go to first frame

Go back one frame

Play animation forward

Go forward one frame

Go to last frame

Options Group
The Animation options group contains some additional controls:

The Record Rendering Settings option allows you to use different rendering settings for
every camera position in the animation. You can change any rendering parameter, such as
transparency or palette, and turn visibility of slices, channels, and volume measurements
on or off. The changes will be applied when the corresponding camera position and fol-
lowing intermediate frames are rendered. Note that only existing rendering elements can be
used here. You will need to add all necessary elements, such as ortho and oblique slices,
isosurfaces, and volume measurements before starting to record an animation.  The vis-
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ibility and parameters of all rendering elements can be changed during recording. This
option should be on unless you are animating only simple views of the basic volume.

Connect Start and End: Check this option to have the final intermediate frames inter-
polate between the last key frame of the animation, and the first one. Note that any option
that has an on/off setting, for instance visibility of an element, cannot be interpolated. For
this reason, the final key frame of any movie that should be looped should have the same
on/off settings as the first frame.

Synch with Time:  If the loaded image set has multiple time points, use this option to syn-
chronize the time points with the camera positions.

Additional options are shown when you click the Options drop-down button.

Hide or Show Animation cameras: Click this button to turn the display of the camera pos-
itions on or off.

Circular Frames defines how many frames will be generated when you create a new cir-
cular animation path using the Spin or Fly-Around features in the Animation Path group.

The Inter control defines the default number of frames that will be added with each key
frame. The actual number for any key frame can be adjusted later, as previously discussed.

Antialiasing increases the visibility of edges on created images. When the Antialiasing
option is on, the multipass antialiasing is activated during creation of animation images.
Every image is rendered x number of passes from slightly different camera positions, aver-
aging the results.
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a. b)

Image a) was created without antialiasing. Image b) was created with 8-pass antialiasing.

l Passes: The multi-pass antialiasing is activated during the creation of animation
images. Every image is rendered according to the number of passes from slightly dif-
ferent camera positions, averaging the results.

Use fixed image size option allows you to define the size of the generated animation or
image. Enter the values forWidth and Heights (in pixels) to set the size. When this option
is off, the current window size is used. If you will be making your movie for display on an
HD monitor, you will usually want to use the Use fixed image size option, and set the
Width and Height to either 1280 and 720 (for 720p HD display), or 1920 and 1080.

Output Group
The Output group lets you create snapshots of your current view, or to render your com-
plete animation to a movie:

The Snapshot button will create a new image holding a snapshot of the view at the current
position in in the timeline. This image workspace can be saved to any file format sup-
ported by Image-Pro.

The Movie button will create a new image sequence of the complete animation. The new
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image workspace will have as many frames as is currently specified in the timeline, and
can be saved to any movie file format supported by Image-Pro.

Navigate Group
The Navigate group allows you to select and view the 3D animation from different pos-
itions.

Select Button: Use this button to select object manipulation (and deselect View mode).
The cursor shape will change to an arrow. In this mode, you are manipulating and holding
objects in the Viewer window. Using the <Ctrl> key while clicking the mouse will
deselect any object.

View Button: Use this button to select camera or viewer mode (and deselect object manip-
ulation mode). The cursor shape will change to a hand icon. In this mode, you are moving
the camera in 3D space, which changes the perspective of the rendering in the Viewer win-
dow.

Adding a New Animation

To add a new animation, follow these steps:

1. Make that the current animation is empty (click the Clear button if necessary).

2. Set the camera mode (Perspective or Orthogonal) in the viewer. Note that if you want
to create a Fly-through animation you have to select a perspective camera.

3. Using your mouse and controls for the viewer window, set the desired view of the
volume and click the Add camera position button.

Clicking the Add button adds the current camera position and also the given number
of intermediate frames between the previous and the current positions that produce
smooth transition from one position to another.

4. Move camera to the next view position and click Add again.

5. Record all camera positions you want to have in the animation.

Note that to create a circular animation you have to record at least two camera pos-
itions first and then click the Circular Animation button.
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A set of camera positions that go around the object pointing to the viewpoint of the
first camera position, and in the plane defined by the first two camera positions and
the center of view will be generated. The distance of the first camera to the focal point
defines the radius of circular animation.

If the current animation was empty, the animation will be rotated around the vertical
axis.

To create a seesaw animation, you should record the position of the first viewpoint
and then the last viewpoint. Click the Connect Start/End control.

If the current animation was empty, the animation will be rotated around the vertical
axis.

6. To play your animation, click the Play button. You can stop animation by clicking
on the image in the viewer window or clicking the Pause button. 

To create an animation sequence in the application workspace, follow these steps:

1. Resize the volume viewer window to the size you need, or check the Use Fixed Size
option and specify the size.

2. Click the Movie button. This movie can then be saved to an AVI or WMV file.

The current view can be copied to the Windows clipboard using the Clipboard button or
can be turned into a new image using the Image button.
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Appendix A
File Format Specifications

Image-Pro supports the following file formats. A brief description of each format will list
the name used by Image-Pro in the File:Open and File:Save As dialogs, the typical file
extensions that identify the file format, and any limitations such as formats that are sup-
ported for File:Open only.

AVI (*.AVI)

Image-Pro supports many of the video varieties of the MicrosoftAVI file format, which
will usually have the *.AVI file extension. The varieties that will be available in your
copy of Image-Pro depend on the AVI file compression support that has been installed by
the operating system and other multi-media components. You cannot annotate *.AVI files
in Image-Pro.

BMP (*.BMP, *.DIB, *.RLE)

Image-Pro supports all known varieties of the Microsoft BMP file format, which will
usually have the *.BMP file extension but may also have a *.DIB or *.RLE extension.
You cannot annotate *.BMP files in Image-Pro.

JPEG (*.JPG, *.JPEG, *.JP2, *.JPF)
JPEG files will have a  *.JPG or JPEG file extension. Image-Pro supports all standard
varieties of the JPEG file format, including JPEG 2000.

Flex Image Transport System (*. FTS, *.FIT, *.FITS)
Image-Pro supports all standard formats of the Flex Image Transport System.

Media Cybernetics Experiments (*.MCE)
Image-Pro allows you to read and write Media Cybernetics experiment files with the exten-
sion *.mce
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Media Cybernetics Sets (*.MCS)
Image-Pro allows you to read and write Media Cybernetics set files with the extension
*.mcs .

MPEG-4 (*.MP4, *.MOV, *.M4V)
Image-Pro allows you to read and write MPEG-4 files with the extensions *.MP4,
*.MOV, and .M4V including H.264.

Portable Internet Graphics (*.PNG)
Portable Internet Graphics are a common format for all types of graphics. The extension is
*.PNG.Image-Pro supports all types of *.PNG files.

Picture  (*.PCT, .PICT)
Image-Pro supports most types of picture files.

Sequence (*.SEQ)
Image-Pro supports multiple-image TIFF files with the .SEQ file extension. This format
allows you to save annotations without burning them into the image.

TIFF (*.TIF, *.TIFF)
Image-Pro supports all known varieties of the TIFF (the Tagged Image File

Format) file format, including most multiple-image varieties and PowerPoint TIFF files.
This format allows you to save annotations without burning them into the image.
Image-Pro can support TIFF files larger than 4GB to aid in the acquistion of large image
sequences. The ability to read calibration data from the following EM files has been
added:

l FEI

l Hitachi

l JEOL

l Zeiss

Image-Pro supports the following read-only file formats:
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Aperio (*.svs)
AutoQuant  (*.avz) (*.deb) (*.hdr) (*.xml)
BIGTIFF (*.btf)
DeltaVision (*.dv)
Gatan Digital Micrograph (*.dm3) (*.dm4)
Hamamatsu Nanozoomer
Image Cytometry Std (*.ics)
Image-Pro IQ Sets (*.iqs)
Leica (*.lei) (*.lif) (*.scn)
Micromanager (metadata.txt)
Molecular Devices Metamorph (*.nd) (*.stk)
Nikon Elements (*.nd2)
Olympus FV 1000 (*.oif) (*.oib)
OME-TIFF (.tiff)
PerkinElmer (*.tim)
Streampix (*.seq)
Windows Media Video (*.wmv)
Zeiss LSM (*.lsm)
Zeiss Widefield (*.zvi)
Zeiss CVI (*.cvi)

Flat file formats are now supported by Image-Pro. Please contact Media Cybernetics’ Cus-
tomer Support for assistance in setting up support for a specific flat file format.
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Hitachi File Formats

There are a number of different types of image acquisitions that can be done with Hitachi
TEM, SEM and table-top SEM microscopes. These include:

l Single-frame acquisitions (one or several saved to same folder, which can generally be
saved in TIFF, BMP or JPEG file formats)

l Acquisitions of Z stacks or volumes

l Acquisitions of larger areas by moving the sample stage and taking additional images
(tiling)

l Acquisition of TEM images where the stage is tilted through a range of +60 to -60
degrees.

l Acquisitions by third-party hardware/software vendors like Gatan

Image-Pro with 3D Module should be able to open and analyze these images.
Image-Pro with 3D Module will also open Hitachi mosaic (tiled) images directly in to the
Tiling View. A mosaic image is one that contains multiple frames that are laid out in a reg-
ular X/Y grid in rows and columns.
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Appendix B
Frequently Asked Questions

This section contains questions from our users, and answers from the Media Cybernetics
support team. Please feel free to submit additional questions to us, using the email address
info@mediacy.com.

mailto:info@mediacy.com
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Installation Questions

Q: What is the purpose of the Update Log in the product installation folder?

A: The Update log.log is a test file with trace information from the TrueUpdate pro-
gram. It is created every time the product runs or looks for updates. It is not needed for
ordinary daily use, but contains diagnostic information that will be helpful if there is an
installation or update problem.

Q: What are the Application and Data folders for?

A:  The Data folder usually contains sample data other than images. The Application
folder is a system folder and is not visible by default in Windows Explorer.  The Applic-
ation folder for the product can be safely deleted.

Q: What does the LastCapture.icq file in Application data folder do? What happens
if it is deleted?

A: This file saves the state of the capture settings when the application is closed. It is used
if the *None* capture settings file selection is selected. If it is deleted, the capture settings
will be set back to default and the file will be recreated when the application is shut down
again.

Q: How often does TrueUpdate look for updates?

A: Every time you start the application.

Q: If one person installs the product into “All Users” will a second Windows user have
access?

A: An “All Users” installation will install shortcuts, documents, and data to areas that are
ordinarily accessible to everyone.  However, it is always possible, by customizing Win-
dows security to produce an environment where a second user may not have access.

Q: If the current Windows user installs the product will only that person be able to use the
files?
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A: In the common case (i.e. with default Windows security) the DEFAULT locations doc-
uments and data will be restricted to the installing user.  If that user is concerned about
access to their data by others, they need to be careful where they save their images and
data.
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Application Questions

Q: What does Auto-Range in the Capture settings do, and how do you set it?

A: Auto-Range sets the black and white levels using the standard display features, so the
histogram B/W level bars, best-fit, reset, etc. are all able to set the auto-range functionality.
Dynamic auto-range uses best-fit to set the display range on every preview frame. The set-
tings for best fit apply, so you can set the low and high exclusion using the standard dis-
play controls on the ribbon. Also, reset and best-fit are now on the histogram window.

Q: In the Capture group, What does the Lock button do?

A: The Lock button locks the preview and capture controls together for that subpanel
group. The other selections are Capture and Preview that unlock the controls and allow the
user to specify them independently.

Q: If we have a 36-bit live preview and capture that image, then “save as” and choose
JPEG, what happens? Does it down-convert to a 24-bit image? If so, there is a bug that the
image has “36-bit” listed in the “info” table.

A: It down converts to 24-bits to save the file. The image, however, that is shown is the
original captured image, not the copy that’s on the disk. That’s why the info is showing
36-bit. If you open the image file that was saved, the image will be 24-bit.

Q: On different operating systems, what will the default paths for QuickSave be?

A: The default path is My Documents\Image-Pro 64-bit\9.3\Images

It is a subfolder of “My Documents” that is always writable.

Q: What are the JPEG Compression differences? What is Quality or Quality Factor? Is this
typical?

A: JPEG images are saved with Quality Factor = 95. This is the default, which produces
small images without much visual artifacts. You can also use PNG or TIF to save a com-
pressed file without losing quality (though the file size is bigger than JPEG).
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*

*.AVI 448

*.BMP 448

*.DIB 448

*.FIT 448

*.FITS 448

*.FTS 448

*.JP2 448

*.JPF 448

*.JPG 448, 455

*.MCE 448

*.MCE Sets 448

*.MCS 449

*.MCS Sets 449

*.PCT 449

*.PICT 449

*.PNG 449

*.RLE 448

*.Seq 449

*.TIF 449

2

2D Count/Size tab xvii

2D Measure tab xvii, 89

2D Segmentation Sub-panel

Guided Segmentation 405

3

3D Animation ribbon 438

3D Animation tab 92

3D Data Histogram 415

3D Data Table 414

3D Mask 295, 415

3D Measure ribbon 383

3D Measure tab 92, 361, 383

3D Measurement Type Options 394

3D options 396, 417

3D projections 435

3D space 161, 359

3D View ribbon 362

3D View tab 91, 362

3D Viewer 161, 359

3D Viewer ribbon 162

3D volumes 435

A

Activating and Closing 326

Active Data Overlay 210

Active frame 101

Active Tool Group 398
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Add angle 399

Add curve 399

Add line 399

Add outline 399

Add point 399

Add polyline 399

adding

shortcuts to the Quick Access
Toolbar 319

Adjust tab 88, 99, 190, 231

Adjusting brightness, contrast, or gamma
using the mouse 190

Advanced display tab 99

Align Views 50

Angle between lines 279

Angles

adding 399

Animation 165

Animation options group 443

Animation Path group 439

Animation tab 438

Annotate 334

Annotation group 225, 245-246, 251,
254-256, 258, 261

Annotation shapes 250

Annotations 244

creating 246

deleting 256

grouping 255

moving 254

ordering 256

resizing 255

rotating 254

setting the appearance of 258

Antialiasing 444

Aperio 450

Appearance

Annotations 261

ROIs 238

Appearance options 396

Application Options 23

Application window components 45

Applying enhancements to an image 191

Apps 342

adding 342

Running 344

Apps tab 90, 342

Arranging annotations 254

Aspect Ratio 125, 129, 133

Auto-Range 97, 455

Auto-Smart

Guided segmentation 410

Auto-threshold 313-314

best-fit minimum 314

bet-fit maximum 314
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Auto-trace tool – Buttons

mean value 314

median histogram value 314

minimum histogram value 314

minimum variance 313

mode value 314

Auto-trace tool 249

Auto Open 76

Auto Range 152

Auto Trace 288

Assume clockwise 290

Auto accept 289

Auto start 289

Disable 290

Edge quality 289

Momentum 289

Monochrome interpretation 290

Noise reduction 289

Range 290

Remove redundant points 290

ROI bound 290

Smoothing 289

Tracing speed 289

Trim leading points 289

Automate tab 90

Automatic subsampling 385, 423

Automatic Update Check 24

Automating Processes 318

AutoQuant 450

AutoThreshold 269

Available measurements list 266

Average vector 395

AVI file formats 448

B

Background correction 195

Background Correction 195

Background group 195

Background Subtraction 195

Background Tools 108

Best-fit Arc 278

Best-fit Circle 277

Best-fit Line 278

Best-fit measurements 277

Best Fit 96, 190

BIGTIFF 450

Bitmap Analysis 166

Bitmap analysis ribbon 167

Bitmap annotations 253

Blend 376, 418

Blending 217

BMP file formats 448

Boundary Opacity 369

Brightness, adjusting 190

Buttons

Create circular animation 446
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Create rocking animation 440

File 63, 65, 68, 75

Light 371

Reset 385

Select/Pick 446

View 364, 446

C

Calibrate by feature 127, 133

Calibration

Export 138

Import 138

unlock 137

Calibration locking 137

Calibration Marker 139

Calibrations

applying a calibration marker to the
image 139

creating a new calibration
definition 126

saving 136

Camera light. 372

Camera views 377

Canvas 177

Capture ribbon 115

Capture tab xvii, 59, 87, 103

Channels group 188, 191

Characteristics

Optical 122

Check for Updates 56

Circle tool 248

Circle Tool 106

Circular animation 439, 444, 446

Classes group 116

Clean Borders 269

Close object 316

Collapse group 339

Collect group

Data collector 117

Collections Sub-panel

Guided Segmentation 404

colocalization

3D measurements 417

Color

changing the color of an
annotation 258

changing the color of an ROI 236

Color Channels 188

Color Composite 182

Color group 179, 181

Color group commands 181

Color mode

Surface Plot 150

commands, making shortcuts for 319
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Compare Tab – Decoration group

Compare Tab 92

Comparing Images 193

Composition group 164, 375

Connect Start and End 444

Connectivity 269

Content

types of 60

Context-sensitive tabs 91

Context menu

Image set 54

Context Menu

Image 53

Contrast, adjusting 190

Contrast, adjusting with mouse 190

Controls

Image sequence 207

Conventions used in this guide xvii

Convert to Annotation 212

Converting Images 179

Count 424

Count feature 383

Count results group 387

Counting

iso-suface 387

isosurfaces 424

results 387

Volume objects 386

Create a polyline 401

Create circular animation 444

Create rocking animation 440

Cubic interpolation 368

Curves

adding 399

Custom animation 440

Custom tab 91

creating 334

locating 335

renaming 335

Customizing

Image Strip 322

Tabs 334

Customizing the User Interface 318

Cut, copy , paste 249

D

Data Collector 97

Data Histogram 297

Data measurements 266

filter values 268

Data Overlay group 210

Data Overlay Options 212

Data Table 293

Measurement names 293

Decoration group 365
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Defining

a new spatial calibration 126

an ROI 227

Delete 249

Line Profile feature 106

Delete ROI 229

Deleting

an annotation 256

an ROI 234

DeltaVision 450

Direct Measurements 272

Direction vector 394

Directional light 372

Display group 190

Display group. 188

Display options 250, 335, 338

Display points for best-fit features 278

Display Range 189

Display Range feature, using 189

Distance between centers 279

Distance between objects 279

Document Properties 55

Dragger tool 380

Draw Mode

Surface Plot 148

Drawing Properties 237, 259

E

Edge Coloring 370

Edge Detection Tools 110

Edge Measurements 275

Edge Settings 112

Edges group 115

Edit light 372

Edit Ranges 268

Ellipse tool 248

for defining ROI 228

EllipseTool 106

Enhancing an Image 174

Exclusion box 382

Expand group 339

Experiments 60

Export Calibration 138

Export data 292

Export volume 426

External objects 433

Extract command 181

Extract points 401

Extras tab 91

F

Fast Fourier Transform 200

Features Manager 108-109

Feedback 42

Feedback form 42
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FFT – Groups

FFT 200

FFT Window

Forward Button 201

FFTprint.tif 200

File button 61, 63, 65, 68, 75, 335

File button described 61

File format 60

File Format Specifications 448

File Formats 448

AVI 448

Bitmap 448

fts 448

JPEG 448

mce 448

mcs 449

Pictures 449

Portable Internet Graphics 449

TIFF 449

File group 117

File Options 76

Fill Holes 269

Filter strip 199

Filters 197-198, 385, 423

Floating Panels 45, 330

Font group 117

Font, changing in an annotation 258

Font, changing in an ROI 236

Forward Button 201

Frames group 441

Frames Per Second 442

Freeform ROI 228

Frequency spectrum 201

Frequently Asked Questions 452

FTS file formats 448

G

Gallery view 155

Gamma, adjusting 190

Gamma, adjusting with mouse 190

Gatan Digital Micrograph 450

Geometry

Surface Plot 153

Geometry group 164, 174-175, 377

Get center 400

Gradient 371

Graph button 116

Graphic Object Properties 236-237, 248,
259-260

Graphical annotations 246

Group/Ungroup 249

Grouping 295-296, 415

Grouping annotations 255

Groups

Expanding or collapsing 339

Hide or show 339
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Grow 269

Grow object 316

Grow or shrink objects 315

Guided Segmentation 402

Guided Segmentation panel 402

H

Hamamatsu Nanozoomer 450

Hardware Configuration Wizard 126

Help menu 29

Hide Base Lines 282

Hide group 339

Hide or Show Animation cameras 444

Hide tab 337

Hide Tab 338

Hide VOI axes 380

Hide VOI handles 380

Hide/show data 295, 297, 415

Hint windows 177

Histogram

freeform 101

Histogram button 99

Histogram display 99

Home tab xvii, 87

I

Image-Pro IQ 450

Image Analysis Forum 56

Image Compare 193

Image Context Menu 53

Image Cytometry Std 450

Image Gallery 155

Image Gallery ribbon 156

Image histogram 95-96

creating 96

Image Histogram 96

Image Information 55

Image Navigator 173

Image sequence controls 208

Image Sequences 205

Image sets 60

defined 68

Image strip 348

Image Strip 322

Image tab 90, 170, 173

images

enhancing by limiting the display
range 189

Images 348

adjusting brightness, contrast, and
gamma 190

panning 172

resetting 191

zooming 170

Import Calibration 138

Importing volumes 427
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Incremental distance – Local Zoom

Incremental distance

measurement types 282

Incremental Distance 280-281

Information

Document/Image 55

Installation instructions 9

Installation requirements 1

Intensity 373

Intensity Calibration 142

Interpolation 368

Cubic 368

Invert ROI 229

isosurface 383-384, 433

Isosurface sub-panel

Guided Segmentation 411

Isosurfaces 420

J

Japanese language 341

JPEG File Format 455

JPG file formats 448

K

Key, calibration 139

L

L*a*b* Color measurements and Color
Correction 300

Label Properties 237, 260

Latest News tab 57

Layout

Custom 52, 333

Load 51, 332

Save 52, 333

Leica 450

License

Upgrading 39

License Agreement. 9

light absorption 359

Light Button 371

Light emission 359

line measurements 283

Line profile 95, 103

Line Profile 103, 116, 118

Line Profile Options 96

Line Profile Tools 104

Line Tool 105

Lines

adding 399

Live EDF options 215-216

Live EDF, 215

Live Extended Depth of Field (EDF) 215

Live Tiling 219

Live Tiling Options 221

Load Data Table Measurements 294-295,
414

Local Zoom 171
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Index

Lock

Calibration 137

Lock button 455

Lock Setting 114

Log group 117

Logarithms 101

Look-Up Table 188

Look For Updates 24, 36

Look Up Table 100

LUT Adjustment 188

M

macros, making shortcuts for 319

Magic Wand 239

defined 240

Magic Wand tool

Guided Segmentation 407

maintenance agreement xviii

Manual edit edge tool 110

manual measurements 398

Manual Measurements

introduction to this feature 265

Tools 271

Manual Tagging 291

Marker Options 211

Marker, calibration 139

Mask 310

Material 374

Maximum distance 279

Maximum Intensity Projection 376, 418

MCE file formats 448

MCS file formats 449

Measure angle between lines 400

Measure distance between centers 400

Measure distance between point and sur-
face 400

Measure distance between surfaces 401

Measure perpendicular distance 400

Measurement Information 293

Measurement labels 285

Measurement names 293

Measurement Options 268

Measurement tools 359

Measurement types 266, 388

Measurements

3D types options 394

Angle 274

Auto-trace Polyline 273

Auto-trace Rectangle 274

Best fit 277

Circle 274

Direct 272

Edge 275

Ellipse 274

Line 273, 283
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Measurements button – OME-TIFF

Manual 271

Manual Tag 272

Orientation 394

pitch with line 273

Point to point 273

Polygon 274

Polyline 273

Rectangle 274

Relative 278

selecting 399

Measurements button 116

Measurements group 116, 398

Meaurement Options dialog 285

Median vector 395

Merge command 181

Merge objects 316

Merge Objects 280

Merge selected objects 401

Micromanager 450

Micrometer 132

Minimum distance 279

Minimum Intensity Projection 376

Molecular Devices Metamorph 450

Morphological Operations

measurements 283

Morphological operatios

Close 283

Grow 283

Open 283

Shrink 283

Mouse wheel, using to zoom 172

Mouse, to adjust brightness, contrast, or
gamma using 190

moving

an ROI 230

Moving

an annotation 254

Multiple Document Interface 48, 328

Multiple ROIs 229

N

Navigate group 363, 446

Nikon Elements 450

nudge tool 242

Nudging 242

Number of slices 376

O

Object Window 298, 416

Objects

grow or shrink 315

open or close 316

splitting 399

Oblique slices 431

Olympus FV 1000 450

OME-TIFF 450
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Open or close objects 316

Open Saved Image 76

Opening an Image 63

Opening an Image Set 67

Optical Characteristics 122

Optional tabs 91

Options

Applications 23

Display 335, 337

Image histogram 98

Line Profile 96

Live EDF 216

Live Tiling 221

segmentation 268

Options group 117

Ordering an annotation 256

Orientation Measurements 394

Ortho slices 429

Otsu algorithm 313

Outlines

adding 399

Outlines group 397

Output group 445

Overview panel 45

P

Package contents 2

Pan Tool 172

Panning images 172

Pattern matching 112

PCT file formats 449

Peaks 110

PerkinElmer 450

Pixel offset 111

Pixels per Unit 125-126

Playback group 442

PNG file formats 449

Point tool 249

Points 279

adding 399

Polygon Nudge 242

Polygon Nudge tool

Guided segmentation 406

Polygon tool 248

for defining ROIs 228

Guided Segmentation 406

Polygon Tool 106

Polyline Tool 105

Polylines

adding 399

Pre-Integrated 368

Predictive calibration 134

Print 80

Print Preview 81

Printing an Image 80
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Process tab – Reports

Process tab 88, 197, 200

Project Workbench 354

Report Tools 353

Project Workbench tabs 353

Pseudo-Color 186

Q

Quick Access Toolbar 82, 319-321

Quick Access Toolbar, using 319

Quick Calibration Method 127

Quick Print 80

Quick Save 75

Quick Save for Analysis 76

Quick Save for Publication 76

R

Ranges 389

read-only file formats 449

Recent documents 62

Recent Documents pane 121

Recent images 56

Record Rendering Settings 443

Rectangle by Coordinates tool (for defin-
ing ROIs) 227

Rectangle by Numbers tool (for defining
ROIs) 228

Rectangle tool 247

Rectangle Tool 106

Reference Calibration 126

Reference vector 394

Region of Interest 101, 226

Regions of Interest 224

Relative Measurements 278

Relative Measurements Group 400

Reload 79, 362

Reload 3D view 163, 362

Reload when image changed 362

Remove Periodic Noise 200

Report 349-350

creating and printing 348

Editing 350

File group 350

Format 349

Preview 349

Printing 350

Saving 350

Report Contents tab 351

Report data 355-356

Report fields 355-356

Report Home tab 351

Report Insert tab 351

Report Layout tab 351

Report tab 350

Report tools 347

Report Tools 351

Reports 347
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Requirements, hardware and software 3,
5

Reset button 363, 381, 385

Reset Display button 191

Resetting images 191

Resize 174

Resizing

an annotation 255

an ROI 230

Resizing an Image 174

Rising Edges 110

RMA

Return Materials Authorization 38

ROI Auto-Trace 107, 228

ROI Display Options 229, 236

ROI group 236, 238

ROI options 238

ROI Options 229

ROI Order 229

ROIs

defining 227

deleting 234

described 226

moving 230

resizing 230

rotating 232

Setting the appearance of 236

tools described 227

Rotate 175

Rotate tools 175, 177

Rotating

an annotation 254

Rotating an Image 175

Rotating an ROI 232

Rotation type 441

S

Saturation 95

Saturation Warning 119

Save 74

Save All 75

Save As 77

Save as Movie 76

Save Calibration dialog box 136

Save Data Table Measurements 294-295,
414

Save to File 75

Saving

calibrations 136

Saving an Image 74

Saving Annotations 262

Scale Bar 172

See-saw animation 440

Segmentation bias 269
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Segmentation Bias – Snap to Edge

Segmentation Bias 314

best-fit 315

range maximum 314

standard deviation 315

Segmentation objects

Defined 404

Segmentation Options 313

Segmetation options 268

Select All tool 247

Select measurements 399

Select mode 383

Select tab 88, 225, 227, 245-246, 310

Select tool 247, 254

Select Tool 105

Select/Pick Button 446

Selected Measurements list 267

Selection tool

for ROIs 227

Guided Segmentation 406

Selection Tools 271

Send Measurements to File 294, 296,
414, 427

Send Measurements to Report 294, 415

Sequence Files 449

Sequence toolbar 207-208

Set

Open from file 67

Set Builder 68

Set Order 249

Shadow screen 374

Share tab 89, 347-348, 354

Sharpen filter 197

Show Data Overlay 211

Show group 339

Show Image 371

Show Shadows 373

Show tab 337

Show VOI axes 380

Show VOI handles 380

Shrink object 316

Slicer

Layout tools 434

Slicer Position group 436

Slicer ribbon 434

Slicer tab 434

Slicer Viewer 159

Slicer Viewer ribbon 160

Smart Segmentation button 408

Smart Segmentation Mode

Guided Segmentation 407

Smoothing 269

Smoothness 373

Snap to Edge 275
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Software license

returning 38

Software version 26

spatial calibration 129

Spatial calibration 125-126, 130

Spatial Calibration 132-133, 136

Spatial Calibration group 127-128, 130

Split objects 399

Split polyline into lines 401

Statistics 295-296, 415

Image histogram 98

Status bar 84

Status bar, described 84

Step Size 282

Step Tablet Wizard 145

Stereo Alignment 217

Stereo View 367

Streampix 450

Style

Surface Plot 151

Sub-volume 381

Sub sampling 384

Sum 376

Support 30

Surface Plot 146

Synch with Time 444

System Calibration 126

System requirements 3, 5

T

Table button 116

Tabs

2D Count/Size xvii

2D Measure xvii, 89

3D Measure 92, 361, 383

3D View 91, 361-362

Adjust 88

Animation 438

Apps 90, 342

Automate 90

Capture xvii, 87

Compare 92

Context-sensitive 91

Custom 91

Extras 91

Hide or show 337

hiding 337

Home xvii, 87

Image 90, 146

Latest news 57

Optional 91

Process 88, 200

Project Workbench 353

Report Contents 351

Report Home 351
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Tabs and Ribbons – View Style group

Report Insert 351

Report Layout 351

Select 88, 225, 245, 310

Share 89, 348, 354

Slicer 434

Training resources 56

View 47, 89, 332

Tabs and Ribbons 87

Tagged Image File Format 449

Technical support xviii

Templates

predefined 349

Text annotations 251

Text tool 247, 251

Texture mode

Surface Plot 148

The Image Tab 146

Thickness group 436

Threshold 112-113, 370

Threshold Type 385

Thresholding 310

class 311

Thresholding Tools 312

Tools

Layout 434

Redock 51, 332

Reset 51, 332

thresholding 312

Tooltips 46, 177, 267, 325

Viewing 46, 325

Training Resources tab 56

Transparency 368

U

Undo split/merge 401

Update Available 24

Updates 22, 30

Software 26

Upgrade

Software 35

Upgrading your License 39

Upgrading your Product 23, 35

User Interface

Customizing 318

Users Guide 30

Using Quick Save 75

V

Validate button 407

Valleys 110

View All 367

View Angle slide 377

View Button 364, 446

View group 414, 434

View mode 383

View Style group 367
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View tab 47-48, 89, 322, 328, 332

View Tab

Layouts 51, 332

tools 51, 332

Viewing Image Document
Information 55

Viewing Intensity Measurements 94

VOI shape

sub-volume 382

Volume

exporting 426

importing 427

Volume Measurements 389, 417

Volume Measurements group 387

Volume of Interest group 379

Volumen Display group 362

Voxel 359, 365

Voxel Size group 364

Voxelize 368

Voxels Size 163

W

Wand Mode

Guided Segmentation 407

Welcome screen 56, 121

Windows Media Video 450

Windows Security Alert 21

Wire mode

Surface Plot 150

Workspace 360

X

XOR pixels 229-230

Z

Z-Propagation sub-panel

Guided Segmentation 409

Zeiss LSM 450

Zeiss Widefield 450

Zoom and Pan controls 47, 326

Zoom Button 170, 173

Zooming images 170
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